Copyrights

NetVault: Backup v8.2.2 - Administrator's Guide
Software Copyright © 2009 BakBone Software

Documentation Copyright © 2009 BakBone Software

This software product is copyrighted and all rights are reserved. The distribution and sale of this product are intended for the use of the original purchaser only per the terms of the License Agreement. All other product trademarks are the property of their respective owners.

The NetVault: Backup v8.2.2 - Administrator’s Guide documentation is copyrighted and all rights are reserved.

This document may not, in whole or part, be copied, photocopied, reproduced, translated, reduced or transferred to any electronic medium or machine-readable form without prior consent in writing from BakBone Software.

THIS PUBLICATION IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS PUBLICATION COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED INTO NEW EDITIONS OF THE PUBLICATION. BAKBONE SOFTWARE MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN THIS PUBLICATION AT ANY TIME.

BakBone Software
9540 Towne Centre Drive, Suite 100 • San Diego, California 92121 • 866.484.2663
# Table of Contents

## Preface

- About this Document ................................................................. 15
- Target Audience ........................................................................... 15
- Organization .............................................................................. 15
- Recommended Additional Reading ........................................... 17
- Technical Support ........................................................................ 17
- Documentation Updates ............................................................ 17

## Chapter 1: Introducing NetVault: Backup

- NetVault: Backup – At a Glance ............................................... 19
- Key Benefits ............................................................................. 19
- Feature Summary ....................................................................... 20

## Chapter 2: Getting Started

- Starting the Graphical User Interface ....................................... 21
- Logging on to NetVault: Backup .............................................. 22
- GUI Basics ................................................................................ 22
- Using NetVault: Backup Keyboard Shortcuts ....................... 24
- Starting and Stopping NetVault: Backup Services ................... 25

## Chapter 3: Managing Clients

- NetVault: Backup Clients – An Overview .................................. 26
- Adding a Client ......................................................................... 27
  - Locating a Client ..................................................................... 28
  - Adding NetVault: Backup Server as a Client ........................... 28
- Client Status Summary ............................................................. 29
- Administering Added Clients ..................................................... 29
  - Viewing Client Properties .................................................... 29
  - Checking Client Access ....................................................... 30
  - Establishing the Firewall Relationship ................................. 30
  - Setting Client Description .................................................. 31
Chapter 4: Managing Backup Devices

- Backup Devices – An Overview .......................................................... 35
- Virtual Tape Libraries – An Overview ..................................................... 36
- Shared Virtual Tape Libraries – An Overview ............................................. 37
- SAN Considerations ............................................................................ 37
- Adding Devices Using the Automatic Device Configuration Wizard ........ 38
  - Manually Starting the Device Configuration Wizard .................................. 39
- Adding a Library Manually ................................................................... 40
- Adding a Standalone Drive Manually ....................................................... 41
- Device Status Summary ......................................................................... 42
- Sharing Drives ....................................................................................... 43
  - Adding a Drive as Shared ....................................................................... 43
  - Adding Shared Drives to Client ............................................................... 45
- Creating and Adding a VTL ................................................................... 46
- Creating and Adding a Virtual Standalone Drive ...................................... 48
- Creating and Adding an SVTL .................................................................. 49
  - Prerequisites ....................................................................................... 49
  - Creating an SVTL ................................................................................ 52
  - Adding Library to the SVTL Controller .................................................. 54
  - Distributing SVTL Drives .................................................................... 54
  - Sharing SVTL Drives .......................................................................... 55
- Configuring Library Parameters .......................................................... 56
- Configuring Drive Parameters .............................................................. 57
  - Configuring General Parameters ......................................................... 57
  - Configuring Software Compression Parameters for Virtual Tape Drives .... 60
  - Configuring NDMP Parameters ............................................................ 61
  - Configuring Performance Parameters .................................................. 61
  - Configuring Data Collection Parameters ............................................. 62
  - Configuring Timeout for SCSI Commands ........................................... 63
- Using Mixed Media Libraries ............................................................... 63
### Chapter 6: Scheduling Jobs

- Job Schedule – An Overview ................................................................. 93
- Scheduling a Job to Run Immediately .................................................. 94
- Scheduling a Job to Run on a Specific Date ......................................... 94
- Scheduling Recurring Jobs ................................................................. 94
  - Scheduling a Job to Run Every n Hour(s) ........................................ 95
  - Scheduling a Job to Run at the Same Time Every Day ....................... 95
  - Scheduling a Job to Run Every n Day(s), Week(s) or Month(s) .......... 96
  - Scheduling a Job to Run on Specific Days of Week ......................... 97
  - Scheduling a Job to Run on Specific Days of Month ....................... 98
- Scheduling Non-recurring Jobs .......................................................... 99
  - Scheduling Non-recurring Jobs to Run on Any Day ......................... 99
  - Scheduling Non-recurring Jobs to Run on Specific Days of Week ...... 99
  - Scheduling Non-recurring Jobs to Run on Specific Days of Month .. 100
- Triggering a Job from an External Script ........................................... 101
- Scheduling Number of Retries ............................................................ 101
- Setting the Job Priority ...................................................................... 102

### Chapter 7: Using Selection Sets

- Selection Sets – An Overview ............................................................. 103
- Creating a Selection Set ..................................................................... 104
- Applying a Selection Set .................................................................... 105
- Modifying a Selection Set ................................................................. 106
- Copying a Selection Set ..................................................................... 107
Chapter 8: Working with Backup Policies

- Backup Policies – An Overview ................................................................. 109
- Defining a Backup Policy .......................................................................... 110
  - Creating Selection Sets for Policy Backups ........................................... 111
  - Defining Jobs for Policy Backups ........................................................... 111
  - Adding Clients and/or Client Groups for Policy Backups ..................... 112
  - Finalizing and Submitting the Policy ..................................................... 113
- Policy View Types ..................................................................................... 113
- Setting up Custom Notification Events for Policy Jobs .......................... 114
- Editing an Inactive Policy ......................................................................... 115
- Editing an Active Policy ........................................................................... 116
- Modifying an Individual Policy Job .......................................................... 117
- Modifying Client List for a Policy ............................................................. 117
- Acknowledging Errors/Warnings ............................................................. 117
- Deleting a Policy ....................................................................................... 118

Chapter 9: Restoring Data

- Restore – An Overview ............................................................................ 119
- Restoring Data with NetVault: Backup Plugins ........................................ 120
- Defining a Restore Job ............................................................................. 120
- Configuring Source Device for Restore .................................................. 121
- Configuring Advanced Restore Options ................................................... 122
  - Using Pre and Post Restore Scripts ......................................................... 123
  - Enabling Network Compression for a Restore ...................................... 124
  - Restoring Data from the Latest Saveset ................................................. 124
- Restoring Data to an Alternate Server ..................................................... 125
- Restoring from a Saveset with Offline Indexes ....................................... 125
- Restoring from a Saveset with Compressed Indexes ............................... 125
- Restoring Encrypted Savesets ................................................................. 126
- Changing the Saveset Sort Order ............................................................ 126
- Filtering Savesets .................................................................................... 126
- Searching for Data Items ......................................................................... 126
- Viewing Media List for a Saveset ............................................................ 127
### Chapter 10: Managing Media

- Backup Media – An Overview ................................................................. 129
- Labeling and Grouping Media ................................................................. 130
- Performing Bulk Media Labeling and/or Grouping ............................... 131
- Viewing Media Status ........................................................................... 132
- Write-protecting Media ........................................................................ 133
- Retiring Backup Savesets ...................................................................... 133
- Marking Media for Re-use .................................................................... 134
- Scanning Foreign Media ........................................................................ 135
- Tracking Off-site Location .................................................................... 135
- Marking Media as Unusable ................................................................... 135
- Deleting a Backup Index from the NVDB .............................................. 136
- Blanking a Media .................................................................................. 136
- Performing Bulk Media Blanking ........................................................... 136

### Chapter 11: Managing NetVault: Backup Jobs

- NetVault: Backup Job Management – An Overview ............................... 137
- Viewing NetVault: Backup Job Records ................................................ 138
- Customizing the Jobs Window ............................................................... 138
- Filtering Job Records ........................................................................... 139
- Starting a Job Instance Immediately ...................................................... 141
- Re-creating a Backup Job Instance ....................................................... 141
- Holding and Resuming a Job ............................................................... 141
- Aborting an Active Job .......................................................................... 141
- Viewing Media Request Details for a Job .............................................. 142
- Changing Media Request Priority for a Job .......................................... 142
- Deleting a Job Schedule ....................................................................... 143
- Deleting a Job Definition ...................................................................... 143

### Chapter 12: Managing NetVault: Backup Logs

- NetVault: Backup Logs – An Overview ................................................ 144
- Viewing NetVault: Backup Logs ........................................................... 145
- Customizing the Logs Window ............................................................. 146
Chapter 13: Setting up Event Notification 151

- Events and Notification – An Overview ................................................................. 151
- Available Notification Types ................................................................................. 152
- Event Notified By Default ...................................................................................... 152
- Setting up a Global Notification Method .............................................................. 153
- Configuring Mail Server Address for Email Notification Method ....................... 155
- Configuring Sysop Mail Address for Email Notification ......................................... 156
- Configuring a Default Printer for Notification ...................................................... 156
- Viewing Operator Messages ................................................................................... 156

Chapter 14: Implementing Access Control Mechanisms 158

- Access Control Mechanisms – An Overview ......................................................... 158
- Creating a New User Account .................................................................................. 159
- Modifying a User Profile .......................................................................................... 161
- Updating General Details for a User Account ......................................................... 161
- Assigning Client Access Rights to a User ............................................................... 162
- Assigning Permissions for NetVault: Backup Operations ........................................ 162
- Assigning Media Group Memberships to a User .................................................... 164
- Setting Media Usage Quota for a User Account ..................................................... 164
- Setting Job Quota for a User Account ..................................................................... 164
- Setting a Notification Profile for a User ................................................................. 165
- Setting User Account Password .............................................................................. 165
- Setting Global Password Expiration Policy ............................................................ 166
- Deleting a User Account .......................................................................................... 166

Chapter 15: Reporting in NetVault: Backup 167

- NetVault: Backup Reports – An Overview ............................................................... 168
- Generating a Canned Report .................................................................................... 169
NetVault: Backup Core Plugins

Chapter 18: Using the NetVault: Backup File System Plugin

- The NetVault: Backup File System Plugin – An Overview .................................................... 208
- Available Backup Methods .................................................................................................. 208
  - Backups Using Volume Shadow Copy Service (VSS) ...................................................... 209
  - System State Backups on Windows .................................................................................. 209
- Defining a Backup Strategy .................................................................................................. 209
- Available Restore Methods .................................................................................................. 212
- Configuring Global Parameters for the File System Plugin .................................................. 212
  - Accessing the Configure Window from Client Management Window ................................ 215
  - Accessing the Configure Window from NetVault: Backup Configurator ............................ 215
- Performing a Full Backup with File System Plugin .............................................................. 215
  - Selecting Data for a Backup .............................................................................................. 216
  - Selecting the Backup Method .......................................................................................... 217
  - Configuring the Backup Options ...................................................................................... 217
  - Configuring a Job as Restartable ...................................................................................... 218
  - Finalizing and Submitting a Job ....................................................................................... 218
- Performing an Incremental Backup with the File System Plugin ........................................ 219
• Performing a Differential Backup with the File System Plugin ........................................220
• Performing VSS Backups ........................................................................................................220
  - Installing Evaluation License Keys for VSS Backups .....................................................220
  - Procedure for Performing VSS Backups ..........................................................................220
• Configuring a Network Share ...............................................................................................221
• Stopping and Restarting a Job ..............................................................................................222
• Restoring Data with the File System Plugin .........................................................................222
  - Selecting Data for a Restore ..............................................................................................222
  - Configuring the Restore Options ......................................................................................223
  - Finalizing and Submitting a Job .......................................................................................224
• Renaming and/or Relocating Data During Restore ..............................................................225
• Restoring Data to an Alternate Server ..................................................................................226
• Performing System State Restore ......................................................................................226
  - Prerequisites ..................................................................................................................227
  - Procedure for Restoring System State ...............................................................................227
• Cluster Database Backup and Restore on Windows 2008 ....................................................228
• Using Inclusion and Exclusion Lists ....................................................................................229
  - Exclusion List Considerations ..........................................................................................229
  - Adding an Exclusion List .................................................................................................231
  - Removing an Exclusion List ............................................................................................232
  - Inclusion List Considerations ..........................................................................................232
  - Adding an Inclusion List .................................................................................................232
  - Removing an Inclusion List ............................................................................................233
• Additional Notes ..................................................................................................................233
  - General Notes on File System Plugin ..............................................................................233
  - Backing up Extended Attributes on NSS Volumes ...........................................................236
  - Backing up and Restoring Distributed File System (DFS) Paths .......................................237

Chapter 19: Using the NetVault: Backup Consolidate Incremental Backups Plugin 238

• The NetVault: Backup Consolidate Incremental Backups Plugin – An Overview ...238
• Performing a Backup Consolidation Job ..............................................................................239
• Restoring Consolidated Savesets ......................................................................................241
• Defining a Backup Consolidation Job in a Policy ...............................................................241

Chapter 20: Using the NetVault: Backup Data Copy Plugin 243

• The NetVault: Backup Data Copy Plugin – An Overview ..................................................243
13

• Making a Copy of the Selected Saveset ................................................................. 244
• Making a Copy of the Latest Saveset Using a Selection Set .................................... 246
• Restoring Copies of Savesets ..................................................................................... 248
• Defining a Data Copy Job in a Policy ......................................................................... 248

Chapter 21: Using the NetVault Databases Plugin 250

• The NetVault Databases Plugin – An Overview ......................................................... 250
• Configuring the NetVault Databases Plugin ................................................................. 251
  - Accessing the Configure Window from Client Management Window .......................... 252
  - Accessing the Configure Window from NetVault: Backup Configurator .................. 252
• Backing up the NetVault Databases ............................................................................ 252
• Restoring the NetVault Databases ............................................................................... 253

Chapter 22: Using the NetVault: Backup Raw Device Plugin 256

• The NetVault: Backup Raw Device Plugin – An Overview ........................................ 256
• Additional Configuration for Large Number of Disks ................................................. 256
• Backing up Raw Devices ............................................................................................. 257
• Restoring Raw Devices ............................................................................................... 258
• Relocating Data to a Different Disk ............................................................................. 259
• Restoring Data to a Different Client ............................................................................. 260

Appendix

Appendix A: NetVault: Backup Pre-defined Events 263

• Pre-defined Event Description .................................................................................... 263

Appendix B: NetVault: Backup Pre-defined Reports and Components 269

• Canned Reports ........................................................................................................... 269
• Pre-defined Report Components .................................................................271

Appendix C: NetVault: Backup User Permissions 279
• User Permission Definitions ...........................................................................279

Appendix D: NetVault: Backup Environment Variables 283
• Using Environment Variables .........................................................................283

Appendix E: NetVault: Backup Processes 285
• NetVault: Backup Processes – An Overview ..................................................285
• Process Description .........................................................................................285
PREFACE

About this Document

This guide describes how to use NetVault: Backup and provides comprehensive information on all NetVault: Backup features and functionality.

Target Audience

This guide is intended for Backup Administrators and other technical personnel who are responsible for designing and implementing a backup strategy for the organization. A good understanding of the operating systems under which the NetVault: Backup Server and Clients are running is assumed.

Organization

The Administrator's Guide is organized as follows:

- **Chapter 1: Introducing NetVault: Backup** gives an overview of NetVault: Backup and describes the features and benefits of the product.
- **Chapter 2: Getting Started** provides a brief description of the NetVault: Backup Graphical User Interface.
- **Chapter 3: Managing Clients** describes how to add and manage NetVault: Backup Clients.
- **Chapter 4: Managing Backup Devices** describes how to add and manage the backup devices.
- **Chapter 5: Backing up Data** describes how to backup data with NetVault: Backup.
- **Chapter 6: Scheduling Jobs** explains how to set up a job schedule.
- **Chapter 7: Using Selection Sets** explains how to create and use selection sets.
- **Chapter 8: Working with Backup Policies** describes how to set up and manage backup policies.
- **Chapter 9: Restoring Data** describes how to restore data with NetVault: Backup.
- **Chapter 10: Managing Media** describes how to perform the media administration tasks.
- **Chapter 11: Managing NetVault: Backup Jobs** describes how to perform job management tasks.
Chapter 12: Managing NetVault: Backup Logs describes how to view and manage the NetVault: Backup logs.

Chapter 13: Setting up Event Notification describes how to set up notification methods for NetVault: Backup events.

Chapter 14: Implementing Access Control Mechanisms describes how to implement NetVault: Backup’s access control mechanisms. This section is primarily intended for the NetVault: Backup Administrator who is responsible for managing the NetVault: Backup system.


Chapter 16: Managing NetVault: Backup Domains describes how to use NetVault: Backup to manage multiple sites.

Chapter 17: Using NetVault: Backup in a Cluster Setup provides guidelines and information that will help you set up and use NetVault: Backup in a cluster environment.

NetVault: Backup Core Plugins


Chapter 19: Using the NetVault: Backup Consolidate Incremental Backups Plugin describes how to use the NetVault: Backup Consolidate Incremental Backups Plugin to create a composite set of full and incremental backups.

Chapter 20: Using the NetVault: Backup Data Copy Plugin describes how to use the NetVault: Backup Data Copy Plugin to create copies of backup savesets.

Chapter 21: Using the NetVault Databases Plugin describes how to use the NetVault Databases Plugin.

Chapter 22: Using the NetVault: Backup Raw Device Plugin describes how to use the NetVault: Backup Raw Device Plugin to backup physical disks and partitions.

Appendix

Appendix A: NetVault: Backup Pre-defined Events provides a brief description of the pre-defined event classes and events.

Appendix B: NetVault: Backup Pre-defined Reports and Components provides a brief description of the pre-defined NetVault: Backup reports and components.

Appendix C: NetVault: Backup User Permissions provides a brief description of the user permissions required to perform NetVault: Backup operations.
Appendix D: NetVault: Backup Environment Variables provides a brief description of the NetVault: Backup environment variables that can be used in scripts.


Recommended Additional Reading

- **NetVault: Backup Installation/Upgrade Guide** – This guide provides complete details on installing the NetVault: Backup Server and Client software.

- **NetVault: Backup Getting Started Guide** – This guide is intended for a first-time user. It describes how to set up a NetVault: Backup system quickly and perform a test backup and restore.

- **NetVault: Backup Configurator Guide** – This guide explains how to configure the default settings for NetVault: Backup.

- **NetVault: Backup Command Line Interface Guide** – This guide provides detailed description of the command line utilities.

You can download these guides from the BakBone website at the following address:

http://www.bakbone.com/documentation

Technical Support

BakBone Software is dedicated to providing friendly, expert advice to NetVault customers. Our highly trained professionals are available to answer your questions, offer solutions to your problems and generally help you make the most of your NetVault purchase. Log on to our web site for more information:

http://support.bakbone.com

Documentation Updates

For the latest documentation updates, refer to the BakBone Software Knowledge Base. BakBone’s Knowledge Base article for NetVault: Backup v8.2.2 can be found at the following link:

http://kb.bakbone.com/4338
Chapter 1: INTRODUCING NETVAULT: BACKUP

This chapter gives an overview of NetVault: Backup and describes the features and benefits of the product. The information in this chapter is organized into the following topics:

- NetVault: Backup – At a Glance
- Key Benefits
- Feature Summary

1.1 NetVault: Backup – At a Glance

NetVault: Backup offers enhanced data protection and enterprise-class functionality that delivers ease of use while scaling to meet the demands of any sized environment, from a single server to complex, heterogeneous environment. The flexible, modular architecture provides proven reliability and high performance, with a unique combination of features designed to reduce deployment costs and Total Cost of Ownership (TCO) by enabling you to implement a solution designed to meet current as well as future needs. Whether you are managing a few servers or a multi-site networked storage environment, there is a NetVault: Backup package designed to fit your needs.

1.2 Key Benefits

- **Rapid Deployment**
  NetVault: Backup's automated installation and device configuration features make it easy to add, manage or re-deploy distributed data management components throughout a growing enterprise storage environment. With our modular architecture you can license only those components you need today, while easily expanding the system as your storage environment or performance requirements grow.

- **Enhanced Administrator Productivity**
  Policy based job management and enhanced reporting capabilities simplify maintenance of your data protection strategies. Many activities such as job definition and event notification can be defined and modified at a group level, making administrative tasks quicker and easier.
Chapter 1
Introducing NetVault: Backup

- **Increased Automation**
  NetVault: Backup’s event notification enhancements and policy based job management features provide increased automation, especially when deployed across heterogeneous storage networks. NetVault: Backup enables administrators to define, manage and monitor jobs from remote clients, while the flexible notification feature ensures business continuance with the ability to define event contexts and triggers, tailoring the product to meet your unique requirements.

- **Lower Total Cost of Ownership**
  By dramatically simplifying implementation and networked storage administration, NetVault: Backup ensures improved data availability while reducing the associated labor costs. The product can significantly lower TCO and provide a return on initial software investment in as little as six to nine months.

### 1.3 Feature Summary

- Extensive application data protection
- Broad platform support
- VMware protection without scripting
- Policy based job management
- Powerful reporting capabilities
- Advanced SAN/NAS support
- Comprehensive NDMP support
- Command Line Interface (CLI) options
- Full media management
- Powerful Disk-to-Disk backup options
- Dynamic device sharing
- Event notification
- Open file protection
Chapter 2: GETTING STARTED

This chapter provides a brief description of the NetVault: Backup Graphical User Interface. The information in this chapter is organized into the following topics:

- Starting the Graphical User Interface
- Logging on to NetVault: Backup
- GUI Basics
- Using NetVault: Backup Keyboard Shortcuts
- Starting and Stopping NetVault: Backup Services

2.1 Starting the Graphical User Interface

This section describes how to start the NetVault: Backup Graphical User Interface.

- **Starting the GUI on Linux/UNIX** – On Linux/UNIX platforms, perform the following steps:
  a. Log on to the system with root user privileges.
  b. Start a terminal session and issue the following command:
     ```
     nvgui
     ```
     Alternatively, add ampersand (&) if you want an open prompt:
     ```
     nvgui &
     ```
     This command can be issued from any directory. Before you start the GUI, ensure that the path variable contains all font paths.

- **Starting the GUI on Windows** – On Windows, perform the following steps:
  a. Log on to the system with Administrator privileges.
  b. Click Start on the taskbar.
  c. Point to Programs, point to NetVault, and then click NetVault.

**Note:** The NetVault: Backup Server and the Clients must be set to the same locale to display the GUI correctly.
2.2 Logging on to NetVault: Backup

By default, no login window is displayed when you start the GUI. NetVault: Backup performs an auto logon using the default user account. A login window will only appear if a password has been set for this user. If a login window is not displayed and you want to log on as a different user, click Log Off on the File menu. To log on to the NetVault: Backup system, perform the following steps:

1. In the Welcome To list, the NetVault: Backup Server for the default domain is displayed. Do not change it unless you want to log on to a different NetVault: Backup domain. To log on to a different domain, select the NetVault: Backup Server for that domain in the list.
2. In the User box, enter your user name.
3. In the Password box, enter the password for your user account.
4. Select the Use this Login from Now On check box to save the user name.
5. Click OK.

To change your password, select Change Password. In the Set User Password window, set the password. For details on changing password refer to Setting User Account Password on page 165.

2.3 GUI Basics

The NetVault: Backup window consists of the menu bar, the toolbar, the Large Buttons panel and the status bar.

The menu bar displays the menus, which contain commands to perform a task in NetVault: Backup. The main tasks are organized under the Operations and Administration menu as follows:
Figure 2-2: The NetVault: Backup Home Screen

Operations Menu – This menu contains the following commands:
- Backup
- Restore
- Status
- Media Management
- Job Management
- Reports
- Logs

Administration Menu – This menu contains the following commands:
- Client Management
- Domain Management
- Device Management
- Policy Management
- Access Control
- Global Notification

To perform a task, open the corresponding task window. For example, to administer NetVault: Backup Clients, open the Client Management window as described below:

On the Administration menu, click Client Management.
The commands on the menu bar vary depending on the active window. For example, the menu items for the Client Management window are different from the main NetVault: Backup window.

For the frequently accessed functions, NetVault: Backup provides toolbar buttons on the standard toolbar and the Large Buttons panel. You can use these buttons to open a window with a single click. For example, to open the Client Management window, click Client Management on the toolbar or Large Buttons panel.

To hide or show the toolbar and/or Large Buttons panel, perform the following steps:

1. To hide the standard toolbar, clear the check mark for Tool Bar on the View menu. To hide the Large Buttons panel, clear the check mark for Large Buttons on the View menu.
2. To display them again, select Tool Bar and/or Large Buttons on the View menu.

The status bar displays the logged-in user name and the BakBone Time setting on the NetVault: Backup Server. For details on BakBone Time, refer to the description for the Time Sync tab in the NetVault: Backup Configurator Guide.

### 2.4 Using NetVault: Backup Keyboard Shortcuts

You can also use the NetVault: Backup’s shortcut keys to open a task window from the main window. The keyboard shortcuts are listed in the following table:

<table>
<thead>
<tr>
<th>Press</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Open About window</td>
</tr>
<tr>
<td>B</td>
<td>Open Backup window</td>
</tr>
<tr>
<td>C</td>
<td>Open Client Management window</td>
</tr>
<tr>
<td>D</td>
<td>Open Device Management window</td>
</tr>
<tr>
<td>H</td>
<td>Show/hide Large Buttons panel</td>
</tr>
<tr>
<td>J</td>
<td>Open Job Management window</td>
</tr>
<tr>
<td>L</td>
<td>Open Logs window</td>
</tr>
<tr>
<td>M</td>
<td>Open Media Management window</td>
</tr>
<tr>
<td>N</td>
<td>Open Global Notification window</td>
</tr>
<tr>
<td>P</td>
<td>Open Policy Management window</td>
</tr>
<tr>
<td>R</td>
<td>Open Restore window</td>
</tr>
<tr>
<td>S</td>
<td>Open Status window</td>
</tr>
<tr>
<td>T</td>
<td>Show/hide standard toolbar</td>
</tr>
</tbody>
</table>
2.5 Starting and Stopping NetVault: Backup Services

NetVault: Backup services are automatically started when the installation completes. If the services need to be stopped or restarted, perform the following steps:

   - On Linux/UNIX platforms, issue the following command:
     \[ \text{nvconfigurator} \]
   - Alternatively, add ampersand (&) if you want an open prompt.
     \[ \text{nvconfigurator} \& \]
   - On Windows, click Start on the taskbar. Point to Programs, point to NetVault, and then click NetVault Configurator.

2. Open the Service tab
3. To stop service, click Stop Service.
4. To start service, click Start Service.
5. Click Apply to apply the settings.
Chapter 3: MANAGING CLIENTS

This chapter describes how to add and manage NetVault: Backup Clients. The information in this chapter is organized into the following topics:

- NetVault: Backup Clients – An Overview
- Adding a Client
  - Locating a Client
  - Adding NetVault: Backup Server as a Client
- Client Status Summary
- Administering Added Clients
  - Viewing Client Properties
  - Checking Client Access
  - Establishing the Firewall Relationship
  - Setting Client Description
  - Installing License Keys
  - Installing and/or Removing NetVault: Backup Plugins
  - Removing a Client from the NetVault: Backup Domain
- Working with Client Groups
  - Creating a Client Group
  - Modifying a Client Group
  - Removing a Client Group

3.1 NetVault: Backup Clients – An Overview

NetVault: Backup Clients are machines that act as backup and/or restore targets. These machines require at least the Client version of the NetVault: Backup software and TCP/IP connectivity to the NetVault: Backup Server. The Server and Clients can reside on different networks.

Clients which have locally-attached backup devices are called SmartClients. Such Clients require additional SmartClient licenses.

The Clients are added to the NetVault: Backup Server, which acts as the domain controller for the NetVault: Backup Domain. Only Member Clients can participate in the backup and restore operations within a NetVault: Backup Domain. The NetVault: Backup Server acts as a Client to itself and is a member of the NetVault: Backup Domain by default. A Client can be a member of more than one NetVault:
Backup Domain. You can also add one NetVault: Backup Server as a Client to another Server.

### 3.2 Adding a Client

Before starting this procedure, ensure that NetVault: Backup Client software version is not higher than the NetVault: Backup Server software version. To add a Client to the NetVault: Backup Server, perform the following steps:

1. Open the **Client Management** window (click **Client Management** on the toolbar or **Large Buttons** panel, or on the **Administration** menu, click **Client Management**).

2. Under **Available NetVault Machines**, you will find a list of NetVault: Backup Clients located on the network. These are machines on which you have installed either the NetVault: Backup Server or Client software. The icons on the left indicate the current status of the Client.

![Client Management Window](image)

A **Blue/Dimmed Blue** icon indicates that the Client is currently up and can be added without any additional requirements.

A **Blue/Dimmed Blue with Key** icon indicates that the Client is currently available. However, this Client is password-protected. You will require the NetVault: Backup password for the machine in order to add it.
Chapter 3
Managing Clients

3. To add a Client that is currently available, double-click the Client in the Available NetVault Machines list. Alternatively, right-click the Client and select Add as Client.

4. If you have created any Client Groups (as described in the section Creating a Client Group on page 32), then an Add Client to Groups window will be displayed. In the Select Group(s) list, select the groups to which you want to add the Client. Use the Shift+Click or Ctrl+Click methods to select the groups.

5. If no password was set for the Client during NetVault: Backup installation, the Client is added to the NetVault: Backup Server without any further action. For Clients on which a password was set during NetVault: Backup installation, a Password Required window will be displayed. Enter the NetVault: Backup password in the Enter Password box and click OK. On verification, the Client is added to the Server and listed under Clients.

3.2.1 Locating a Client
To locate a Client that is not listed under Available NetVault Machines, perform the following steps:

1. Under Find NetVault Machine at the bottom right, enter the NetVault: Backup name for the Client or its IP address.

2. Click Find.
   NetVault: Backup re-scans the network for the Client, and if found, lists it under Available NetVault Machines (in alphabetical order).
   A search can also fail for a number of reasons, including the following:
   - The DNS lookup table or the machine’s host table cannot be contacted.
   - NetVault: Backup service is not running on the machine.
   - NetVault: Backup software is removed from the machine.

3.2.2 Adding NetVault: Backup Server as a Client
You can also add a NetVault: Backup as a Member Client to another NetVault: Backup Domain. To add a NetVault: Backup Server as a Client to another NetVault: Backup Server, perform the following steps:


2. On the Security tab, select This Machine May be Added as a Client to a Server to change the default security settings.

3. To add the Server as a Member Client, refer to Adding a Client on page 27.
3.3 Client Status Summary

A Client that is added to the NetVault: Backup Server is listed under Clients in the Client Management window. The current status of these machines is indicated with one of the following icons:

- **Blue/Dimmed Blue** – This icon indicates that the Client is up and running. A dimmed icon represents a machine running NetVault: Backup 7.4.5 or an earlier version.
- **Blue/Dimmed Blue with Key** – This icon could indicate either of the following:
  - The Client is in the process of being added
  - The NetVault: Backup password has changed since the Client was added
  A dimmed icon represents a machine running NetVault: Backup 7.4.5 or an earlier version.
- **Red** – This icon indicates that the Client is currently unavailable. Either the machine is offline or NetVault: Backup services are stopped.

**Note:** A Yellow icon represents a Virtual Client which consists of a cluster of Clients. For details on Virtual Clients, refer to Using NetVault: Backup in a Cluster Setup on page 195.

You can get a consolidated view of the current status of the added clients, backup devices, and the submitted jobs from the NetVault: Backup Status interface. To access this interface click Status on the toolbar or Large Buttons panel, or on the Operations menu, click Status.

3.4 Administering Added Clients

This section describes the various Client administration procedures.

3.4.1 Viewing Client Properties

To view the Client properties, perform the following steps:

1. Under Clients, right-click the Client and select Properties.
2. The Client Properties window contains three tabs - System, Plugins and Installed Software. Click the corresponding tab to view the following information:
   - The System tab displays the machine name and description, NetVault: Backup version and build number, machine ID, network name for the machine, IP address, release information and operating system version number.
Chapter 3
Managing Clients

3. Click **OK** to close the window.

### 3.4.2 Checking Client Access

To check access between the NetVault: Backup Server and a Client, perform the following steps:

1. Under **Clients**, right-click the machine and select **Check Access**.
2. NetVault: Backup attempts to connect to the Client and displays the status message corresponding to the Client accessibility.
3. Click **OK** to close the dialog.

### 3.4.3 Establishing the Firewall Relationship

A NetVault: Backup Server and Client can reside on different networks. If a firewall exists between these two networks, you can configure the firewall relationship as **Outside Firewall** to use open ports for message transfers, broadcasts, and data transfers to the Client.

Before establishing the firewall relationship between the networks, consider the following points:

- If the Client and the Server are on the same side of the firewall, or if no firewall exists between the two networks, do not change the default configuration which is set as **Inside Firewall**.
- The firewall relationship cannot be established for Clients running NetVault: Backup v7.4.5 or a previous version. Such Clients are represented with a dimmed blue icon. The communication with such Clients is always treated as an **Outside Firewall** operation and the Server adheres to the port restrictions set via the **Firewall** tab on the NetVault: Backup Configurator. As a result, you must open more ports to enable concurrent data transfers with multiple Clients that are outside the firewall.
- This feature is not intended for use with the NAT firewalls.
- This feature is not intended for configuring the firewall settings between two Clients. Client to Client communication is always treated as an **Outside Firewall** operation and adheres to the port restrictions configured via the NetVault: Backup Configurator. For details on port configuration, refer to the section on **Firewall** tab in the *NetVault: Backup Configurator Guide*. 
To establish the firewall relationship between the Server and Client networks, perform the following steps:

1. Under **Clients**, right-click the Client and select **Outside Firewall**.
2. Once you select the **Outside Firewall** option, this command is replaced with **Inside Firewall** option, which can be used to update the firewall settings if there are any changes later.

### 3.4.4 Setting Client Description

To set the Client description, perform the following steps:

1. Under **Clients**, right-click the Client and select **Set Description**.
2. In the **Enter Client Description** box, enter a detailed description for the Client.
3. Click **OK**.

### 3.4.5 Installing License Keys

It is recommended that you install the permanent license keys for NetVault: Backup and the non-core plugins before the 45-day evaluation period expires. The permanent license keys can be requested at [http://licenses.bakbone.com](http://licenses.bakbone.com). To install the permanent license keys for the software, perform the following steps:

1. Under **Clients**, right-click the Client and select **Install License Key**.
2. Enter (or copy/paste) the license key in the **Enter Key String** box.
3. Click **OK**.

You can also install the license keys via the Configurator or CLI utility. For more information on these methods, refer to the **NetVault: Backup Configurator Guide** and **NetVault: Backup Command Line Interface Guide**.

### 3.4.6 Installing and/or Removing NetVault: Backup Plugins

For detailed instructions on installing and/or removing a plugin, refer to the relevant APM/Plugin User’s Guide.

### 3.4.7 Removing a Client from the NetVault: Backup Domain

To remove a Client from the NetVault: Backup Domain, perform the following steps:

1. Under **Clients**, right-click the Client and select **Remove**. For Clients with a red icon, select **Force Remove**.
2. In the confirmation window, click **Yes**.

The Client is removed and listed again under **Available NetVault Machines**.
3.5 | Working with Client Groups

NetVault: Backup automatically creates a Client Group called default. You can create other Client Groups and use them instead of selecting individual Clients for the operations like defining policy-based backups or granting Client access to users. This section describes the procedures for creating and managing the user-defined Client Groups.

3.5.1 | Creating a Client Group
To create a Client Group, perform the following steps:

1. Open the Client Management window (click Client Management on the toolbar or Large Buttons panel, or on the Administration menu, click Client Management).
2. Click the Client Groups tab.
3. Click Add Client Group to create a new Client Group. It is named New Client Group, by default.
4. To rename the group, perform the following steps:
   a. Right-click the group and select Rename Group.
   b. In the New Name for the Group box, enter the group name.
   c. Click OK.
5. To set a detailed description for the group, perform the following steps:
   a. Right-click the group and select Set Description.
   b. In the Group Description box, enter the details.
   c. Click OK.
6. To add the group members, perform the following steps:
   a. Right-click the group and select Add Member Clients.
   b. In the Select Clients to Add list, select the Clients. Use Shift+Click to select consecutive Clients, or Ctrl+Click to select non-consecutive Clients. Alternatively, you can select the Group Includes ALL Clients check box to add all the existing Clients to the group.
   c. Click OK.

3.5.2 | Modifying a Client Group
To modify a Client Group, perform the following steps:

1. Open the Client Management window (click Client Management on the toolbar or Large Buttons panel, or on the Administration menu, click Client Management).
2. Click the Client Groups tab and locate the Client Group.
3. To add new members, perform the following steps:
   a. Right-click the group and select **Add Member Clients**.
   b. In the **Select Clients to Add** list, select the Clients. Use Shift+Click to select consecutive Clients or Ctrl+Click to select non-consecutive Clients. Alternatively, you can select the **Group Includes ALL Clients** check box to add all the existing Clients to the group.
   c. Click **OK**.

4. To remove group members, perform the following steps:
   a. Right-click the group and select **Remove Member Clients**.
   b. In the **Remove Clients from Group** list, select the Clients. Use Shift+Click to select consecutive Clients, or Ctrl+Click to select non-consecutive Clients.
   c. Click **OK**.

5. To rename a group, perform the following steps:
   a. Right-click the group and select **Rename Group**.
   b. In the **New Name for the Group** box, enter the group name.
   c. Click **OK**.

6. To set or change the group description, perform the following steps:
   a. Right-click the group and select **Set Description**.
   b. In the **Group Description** box, enter the details.
   c. Click **OK**.

### 3.5.3 Removing a Client Group

To remove a client group that is no longer in use, perform the following steps:

1. Open the **Client Management** window (click **Client Management** on the toolbar or **Large Buttons** panel, or on the **Administration** menu, click **Client Management**).
2. Click the **Client Groups** tab and locate the Client Group.
3. Right-click the group and select **Remove Group**.
4. In the confirmation window, click **Yes**. This will remove the Client Group. However, the individual Member Clients remain part of the NetVault: Backup Domain.
Chapter 4:
MANAGING BACKUP DEVICES

This chapter describes how to add and manage the backup devices. The information in this chapter is organized into the following topics:

- Backup Devices – An Overview
- Virtual Tape Libraries – An Overview
- Shared Virtual Tape Libraries – An Overview
- SAN Considerations
- Adding Devices Using the Automatic Device Configuration Wizard
  - Manually Starting the Device Configuration Wizard
- Adding a Library Manually
- Adding a Standalone Drive Manually
- Device Status Summary
- Sharing Drives
  - Adding a Drive as Shared
  - Adding Shared Drives to Client
- Creating and Adding a VTL
- Creating and Adding a Virtual Standalone Drive
- Creating and Adding an SVTL
  - Prerequisites
    - General Prerequisites
    - Setting up Raw I/O on Linux
    - Setting up Raw I/O on RedHat Linux
    - Setting up Raw I/O on SUSE Linux
    - Setting up Raw I/O on RedHat Enterprise Linux 5
  - Creating an SVTL
  - Adding Library to the SVTL Controller
  - Distributing SVTL Drives
  - Sharing SVTL Drives
- Configuring Library Parameters
- Configuring Drive Parameters
  - Configuring General Parameters
  - Configuring Software Compression Parameters for Virtual Tape Drives
4.1 Backup Devices – An Overview

NetVault: Backup supports a wide range of backup devices, including different types of tape libraries, autoloaders, tape drives and disk arrays. You can connect these devices to the Server, or any SmartClient or NAS filer within the backup domain. The devices can be configured for single or shared use and connected via SCSI, iSCSI, IP or Fibre Channel SAN interfaces. The built-in VTL (Virtual Tape Library) and SVTL (Shared Virtual Tape Library) features allow you to...
emulate tape libraries on disk systems, which can be used for quicker disk-to-disk backups and restores. The VTLs and SVTLs can be created on the NetVault: Backup Server or any SmartClient.

To use a device for any NetVault: Backup operation, you must add the device to the set of devices controlled by the Server. A SmartClient attached device is recognized only after you add the Client to the Server. Similarly, a filer attached device is recognized only after you add the filer to the Server (using the NDMP Plugin).

On Windows, you must remove the resident drivers from the Windows Removable Storage Service before adding them to the NetVault: Backup Server. Refer to the NetVault: Backup Installation/Upgrade Guide for instructions on disabling this service. Once added, the devices can be used for any local or LAN based backups and restores.

**Note:** NetVault: Backup Server may not recognize a standalone tape device locally attached to an RHEL4 U1 Client. This happens because on RHEL4 U1, the SG driver that supports the standalone devices is not loaded automatically. You must manually load this driver and restart the NetVault: Backup services. This issue only occurs when the RHEL4 U1 Client does not have any other locally attached library or changer. For details on obtaining and loading the SG driver, refer to the relevant RHEL4 U1 documentation.

### 4.2 Virtual Tape Libraries – An Overview

Virtual Tape Libraries (VTLs) are an emulation of tape libraries on disk, which enable disk-to-disk backups. With VTLs, you have the flexibility to perform quick backups to disks, and during off-peak hours migrate or duplicate the backup to physical systems for off-site storage. The media manager does not distinguish between a virtual and a physical tape, which simplifies the process of setting up backup policies, including retention period and rotation schemes.

VTLs are represented as directories on the disk. Each VTL contains three directories named **drives**, **slots** and **media**, which in turn contain numbered sub-directories. The virtual drives reside as files within the **drives** sub-directories. These files contain links to the media files. The virtual tapes reside as media files within the **media** directory. When a virtual tape is moved between slot and drive, the media file itself stays in the **media** directory and the drives and slots files are modified to emulate the moving of the media.

A VTL can handle any number of concurrent NetVault: Backup Client backups. As with a physical library the number of drives contained in the VTL dictate how many simultaneous operations can be performed. The number of slots must be the same as or more than the number of drives configured. Different operating systems may impose limits on the maximum file size, which can affect the
maximum VTL media size. VTLs are independent of file systems (e.g., NTFS, UFS, ext3, etc.) and disk systems (e.g., IDE, SCSI, iSCSI, etc.).

4.3 Shared Virtual Tape Libraries – An Overview

SVTL extends the VTL implementation and lets you share a VTL with multiple NetVault: Backup machines for LAN-free backups. The interface can be Fibre Channel, iSCSI or SCSI. On Linux and Solaris platforms, SCSI_FCP protocol is also supported. The SVTLs are supported on the following platforms:

- Windows
- Linux (x86 and x86-64)
- Solaris SPARC and Solaris x8664

The disks can be of any size. However, operating system imposed limitations do apply. The SVTL size can be changed on the fly using CLI utilities.

4.4 SAN Considerations

When configuring tape libraries within a SAN environment, we recommend that you use persistent binding (also known as SCSI mapping/persistent reservation/persistent naming). NetVault: Backup cannot communicate with a library if its SCSI address changes as a result of changes within the SAN. Persistent binding assigns a fixed SCSI address to the device which does not change as devices are added or removed within the SAN. For the Host Bus Adapters (HBAs), you can map the Fibre Channel device address (World Wide Name(WWN) or World Wide Identifier (WWID)) or a Loop ID to the SCSI address. This ensures that changes within the SAN have no impact on NetVault: Backup.

You must also use persistent binding when the Server and the fibre devices are attached to separate switches, or when zoning is implemented. NetVault: Backup does not support multipathing to a tape library/device, so only one channel to the switch or target host must be attached. It is also recommend that you do not use the tape libraries/drives on the same switch or in the same zone that has disk devices attached. Problems might be encountered if packets from both device types co-exist in a SAN environment. It is recommended that you use separate HBAs for these devices, or at least different zones.

Apple supports multipathing in the FC Host Adapter and XserveRAID, and often this is the default setting after installation. But generally the FC sequential tape drives do not support multipath FC integrations. So connections must be logically or physically separated to ensure a consistent communication path.
4.5 Adding Devices Using the Automatic Device Configuration Wizard

The Automatic Device Configuration wizard helps you to quickly add and configure backup devices. This wizard can recognize devices manufactured by multiple vendors, although not all are supported. NetVault: Backup automatically starts scanning for new devices in the domain when you start the software services.

**Note:** To disable the auto scan feature, start the NetVault: Backup Configurator and set the **Scan for Devices at Start of Day** parameter on the **Device Scan** tab to **Neither**.

To automatically configure a backup device, perform the following steps:

1. Open the **Device Management** window (click **Device Management** on the toolbar or **Large Buttons** panel, or on the **Administration** menu, click **Device Management**).

2. The **Automatic Device Configuration** wizard starts automatically when a qualified device is found. Follow the wizard as it guides you through the configuration steps.

3. Verify the device details and click **Yes** to start the configuration procedure.

4. Configure the following parameters:

   - **Name** – This box displays the default name for the device. You can change it and assign another name for easy identification.

   - **Configure Performance Options** – Select this check box to modify the default performance settings.
■ **Scan Client for Remote/Shared Devices** – This option is used for sharing drives among multiple Clients. For details on sharing drives, refer to *Sharing Drives on page 43.* For devices controlled by a single Client, clear the check box.

5. If **Configure Performance Options** was selected in the previous step, re-configure the following parameters to improve performance:

■ **Amount of Memory to Assign to Transfer Buffers (KB)** – Enter the transfer buffer size (or the shared memory size). By default, the transfer buffer is set to 257 KB. Generally, the following rule applies for the shared memory size:

\[
\text{shared memory} = x \times \text{block size} + 1
\]

For details on configuring this parameter, refer to *Configuring Performance Parameters on page 61.*

■ **Media Block Size** – Enter the media block size. The default block size is 32 KB. For details on configuring this parameter, refer to *Configuring General Parameters on page 57.*

Click **Next** to proceed.

6. NetVault: Backup adds the device and displays a message. Click **Finish** to complete the procedure. The device is added and listed on the **Devices** tab.

### 4.5.1 Manually Starting the Device Configuration Wizard

If a qualified device is not detected automatically, perform the following steps to start the wizard manually and complete the configuration procedure:

1. Open the **Device Management** window (click **Device Management** on the toolbar or **Large Buttons** panel, or on the **Administration** menu, click **Device Management**).

2. On the **Add** menu, click **Auto-Configure Device**.

3. In the **Automatic Device Configuration** window, configure the following parameters to begin scanning:

■ **Device Type** – Select the appropriate option to search for Standalone Drives or Libraries.

■ **Clients** – Under **Select Clients**, select the Clients that are to be scanned.

■ **Force Re-scan** – To force a re-scan instead of using the cached information, select **Re-scan for Devices**.

4. To scan for devices previously ignored using the **Do Not Ask Again for This Device** option, right-click the machine to which the device is physically connected, and then select **Clear List of Ignored Devices**.

5. Click **Next** to continue.

6. NetVault: Backup begins scanning the network for available devices and starts the **Automatic Device Configuration** wizard when a qualified device
4.6 Adding a Library Manually

To add a library manually, perform the following steps:

1. Open the Device Management window (click Device Management on the toolbar or Large Buttons panel, or on the Administration menu, click Device Management).

2. On the Add menu, click Add Library. This opens the Library Selection tab in the Add Library window.

3. Under Choose Library, open the Server/Client node to which the device is connected (double-click the node, or right-click it and select Open).

4. Depending on the library type, open the Robotic Libraries or NDMP Robotic Libraries node. The attached libraries are listed under their type.

5. Double-click the library or right-click and choose Select. The library picture, type and details are displayed under Selected Library.

6. Click the Drive Selection tab.

7. Open the Server/Client node to which the device is connected.

8. Open the corresponding drive type node. The available drives are listed under this node.
9. For libraries with a single drive, double-click the drive, or right-click it and choose Select. The drive picture, type and details are displayed under Selected Drives.

10. For libraries with multiple drives, perform the following steps to assign the correct drive bay to each drive:
   a. Enter 1 in the Select for Drive Bay box.
   b. Under Choose Drives, double-click drive 1 or right-click it and choose Select. The drive picture, type and details are displayed under Selected Drives.
   c. Repeat steps a and b for the remaining drives, changing the drive number and bay for each drive.

   ![Image of NetVault: Backup interface]

   Figure 4-3: Choose the correct drive bay

   Note: While the drive number usually matches the bay number, depending on the library and drive configuration a different assignment of drives to bays might be necessary. If you experience failure during move or load/unload operations, consider adding your drives in a different order to their bays.

11. To configure the library and drive parameters, refer to Configuring Library Parameters on page 56 and Configuring Drive Parameters on page 57.

12. Click Save Details on the toolbar. The library is added and listed on the Devices tab. When the library initialization and inventory completes, the status changes to online.

### 4.7 Adding a Standalone Drive Manually

To add a standalone drive, perform the following steps:
Chapter 4
Managing Backup Devices

1. Open the **Device Management** window (click **Device Management** on the toolbar or **Large Buttons** panel, or on the **Administration** menu, click **Device Management**).

2. On the **Add** menu, click **Add Standalone Drive**. This opens the **Drive Selection** tab in the **Add Standalone Drive** window.

3. Under **Choose Drives**, open the Server/Client node to which the device is connected (double-click the node, or right-click it and select **Open**).

4. Open the **SCSI Tape** drive nodes. The available drives are listed under this node.

5. Double-click the drive or right-click it, and choose **Select**. The drive picture, type and details are displayed under **Selected Drives**.

6. To configure the drive parameters, refer to **Configuring Drive Parameters on page 57**.

7. Click **Save Details** on the toolbar. The drive is added and listed on the **Devices** tab. When the drive initialization completes, the status changes to online.

### 4.8 Device Status Summary

A device that is added to the NetVault: Backup Server is listed on the **Devices** tab in the **Device Management** window. A different icon is used to represent libraries, drives, slots and entry/exit ports. The current status of these devices is represented by one of the following status indicators:

![Figure 4-4: The device status indicators](image-url)

- **Online**: The drive is available and ready for use.
- **Offline**: The drive is not available due to a hardware or software issue.
- **Preserved**: The drive is in a reserved state, preventing it from being used.
- **Job**: The drive is currently processing a backup or restore job.
- **Error**: The drive has encountered an error and is not operational.
- **Unknown**: The status of the drive cannot be determined.

These indicators help administrators monitor the health and status of their backup devices, ensuring that operations proceed smoothly.
Green Light – This icon indicates that the device is online and available for use.

Yellow Light – This icon indicates that a backup or restore job is currently using this device.

Red Light – This icon indicates that the device is currently offline. NetVault: Backup can detect the device but it cannot be accessed for backup or restore jobs.

Red Cross – This icon indicates that the device is unavailable (e.g., the SCSI cable is disconnected, the device is removed, etc.). NetVault: Backup cannot detect the device.

You can get a consolidated view of the current status of the added clients, backup devices, and the submitted jobs from the NetVault: Backup Status interface. To access this interface click Status on the toolbar or Large Buttons panel, or on the Operations menu, click Status.

4.9 Sharing Drives

In environments that support this, you can share drives among multiple clients for better resource utilization through direct access. This requires an infrastructure where multiple machines can establish direct paths to the tape drives, e.g., in switched Fibre Channel environments. While the drives are controlled by different clients, the library arm changer remains under the control of one client. Each drive that is to be shared by more than one machine consumes a Dynamically Shared Drive (DSD) licence.

The procedure for sharing a drive can be divided into two steps:

- Adding a Drive as Shared
- Adding Shared Drives to Client

These steps are described in detail in the following sections. Before you proceed, make sure all the target Clients are added to the NetVault: Backup Server.

4.9.1 Adding a Drive as Shared

Depending on whether the device is a library or a standalone drive, refer to the relevant section.

4.9.1.a Sharing Drives of a Library

To add the drives of a library as shared, perform the following steps:

1. Open the Device Management window (click Device Management on the toolbar or Large Buttons panel, or on the Administration menu, click Device Management).
2. On the Add menu, click Add Library. This opens the Library Selection tab in the Add Library window.
3. Under **Choose Library**, open the Server/Client node to which the device is connected (double-click the node, or right-click it and select **Open**).

4. Depending on the library type, open the **Robotic Libraries** or **NDMP Robotic Libraries** node. The attached libraries are listed under their type.

5. Click the **Drive Selection** tab.

6. Open the Server/Client node to which the device is connected.

7. Open the corresponding drive type node. The available drives are listed under this node.

8. Double-click the library or right-click and choose **Select**. The library picture, type and details are displayed under **Selected Library**.

9. For libraries with a single drive, double-click the drive or right-click and select **Add Shared**. The drive picture, type and details are displayed under **Selected Drives**.

10. For libraries with multiple drives, perform the following steps to assign the correct drive bay to each drive:
    a. Enter 1 in the **Select for Drive Bay** box.
    b. Under **Choose Drives**, double-click drive 1 or right-click it and select **Add Shared**. The drive picture, type and details are displayed under **Selected Drives**.
    c. Repeat steps a and b for the remaining drives, changing the drive number and bay for each drive.

11. To configure the library and drive parameters, refer to **Configuring Library Parameters on page 56** and **Configuring Drive Parameters on page 57**.

12. Click **Save Details** on the toolbar. The library is added and listed on the **Devices** tab. When the library initialization and inventory completes, the status changes to online.

**49.1.b Sharing Standalone Drives**

To add standalone drives as shared, perform the following steps:

1. Open the **Device Management** window (click **Device Management** on the toolbar or **Large Buttons** panel, or on the **Administration** menu, click **Device Management**).

2. On the **Add** menu, click **Add Standalone Drive**. This opens the **Drive Selection** tab in the **Add Standalone Drive** window.

3. Under **Choose Library**, open the Server/Client node to which the device is connected (double-click the node, or right-click it and select **Open**).

4. Open the corresponding drive type node. The available drives are listed under this node.
5. Right-click the drive and select Add Shared. The drive picture, type and details are displayed under Selected Drives.

6. To configure the drive parameters, refer to Configuring Drive Parameters on page 57.

7. Click Save Details on the toolbar. The drive is added and listed on the Devices tab. When the drive initialization completes, the status changes to online.

4.9.2 Adding Shared Drives to Client

The shared drives can be added automatically or manually as described in the following sections.

4.9.2.a Adding Shared Drives Automatically

To add the shared devices using the Automatic Device Configuration Wizard, perform the following steps:


2. Click Yes to begin configuring the detected device and follow the wizard as it takes you through the configuration steps.

3. In the Add Library window configure the following parameters:
   - Name – This box displays the default name for the device. You can change it and assign a new name for easy identification.
   - Scan Client for Remote/Shared Devices – Select this check box to re-scan the Clients for shared drives and configure the following options:
Chapter 4
Managing Backup Devices

4.9.2.b Adding Shared Drives Manually

To add the shared drives manually to multiple Clients, perform the following steps:

1. Click the Drive Selection tab.
2. Open the Client node to which you want to add the shared drive.
3. Depending on the drive type, open the SCSI Tape drive or the NDMP Tape drive nodes. The shared drives are listed under their drive types.
4. Select the shared drive (double-click it, or right-click and choose Select). The drive picture, type and details are displayed under Selected Drives.
5. To configure the drive parameters, refer to Configuring Drive Parameters on page 57.
6. Click Save Details on the toolbar. The drive is added and listed on the Devices tab. When the drive initialization completes, the status changes to online.

4.10 Creating and Adding a VTL

Before starting this procedure, consider the following points:

- Before creating a VTL, NetVault: Backup performs a disk space check to ensure that the target disk has sufficient space to accommodate the VTL.
  If you are running a de-duping or compressing file system, it is recommended that you disable the disk space check. To disable the disk space checks, perform the following steps:
  - Start the NetVault: Backup Configurator.
  - Click the Plugin Options tab, and then click the Disk Devices Plugin tab.
  - Clear the check mark for Check Available Disk Space Before Creating Disk Libraries.
  If you are running a normal file system, it is recommend that you leave the disk space check option selected.
- NetVault: Backup calculates the minimum amount of space required on the disk as follows:
Number of Slots * Media Capacity + 20 MB additional space

The 20 MB additional space is considered for the other applications running on the system, and to create the directory structure for the VTL. Note that the amount of space required to create the VTL directory structure varies for different types of file systems. To re-configure the margin, refer to the description for the **Disk Devices Plugin** tab in the *NetVault: Backup Configurator Guide*.

- If the target disk does not have sufficient space, NetVault: Backup terminates the device emulation process with an error.

To create a VTL, perform the following steps:

1. Open the **Device Management** window (click **Device Management** on the toolbar or **Large Buttons** panel, or on the **Administration** menu, click **Device Management**).

2. On the **Add** menu, click **Add Library**. This opens the **Library Selection** tab in the **Add Library** window.

3. Under **Choose Library**, right-click the target machine and select **Create Virtual Library**.

4. In the **Add New Virtual Library**, enter the VTL specifications as described below:

   - **Library Location** – Enter the path for the VTL. This should be an existing path. NetVault: Backup will not create any non-existing directories. For example, enter `C:\VirtualLibraries` to create a VTL in the `VirtualLibraries` folder on C drive.

   - **Library Name** – Enter a unique name for the VTL. NetVault: Backup assigns the name **NewLibrary** by default.

   ![Add new virtual library](image)

   - **Barcode Prefix** – For each VTL, NetVault: Backup generates a barcode prefix that is used for identification and assigned to the media used by the
Chapter 4
Managing Backup Devices

VTL. You can change the barcode prefix; however, ensure that a unique code is given to each VTL.

- **Number of Drives** – Enter the number of drives for the VTL.
- **Number of Slots** – Enter the total number of slots that will hold the media.
- **Media Capacity (MB)** – Enter the size of the virtual tape (in MB). The maximum size for a media can be 800 GB (i.e., 819,200 MB). Each slot will contain a media of the given size.

5. Select **OK** to initiate the creation of VTL. Depending on the number of slots and media size, this process may take a few minutes to complete. A message is displayed when the process completes. Click **OK** to close the dialog.

6. The VTL is added to the NetVault: Backup Server in the same manner as a physical library. To add the VTL, refer to *Adding Devices Using the Automatic Device Configuration Wizard* on page 38 or *Adding a Library Manually* on page 40.

### 4.11 Creating and Adding a Virtual Standalone Drive

To create a virtual standalone drive, perform the following steps:

1. Open the **Device Management** window (click **Device Management** on the toolbar or **Large Buttons** panel, or on the **Administration** menu, click **Device Management**).
2. On the **Add** menu, click **Add Standalone Drive**. This opens the **Drive Selection** tab in the **Add Standalone Drive** window.
3. Under **Choose Drives**, right-click the target machine and select **Create Virtual Drive**.
4. In the **Add New Virtual Drive** window, enter the drive specifications as described below:
   - **Drive Location** – Enter the path for the drive. This should be an existing path. NetVault: Backup will not create any non-existing directories.
   - **Drive Name** – Enter a unique name for the standalone drive. NetVault: Backup assigns the name **NewDrive** by default.
   - **Barcode Prefix** – For each standalone drive, NetVault: Backup generates a barcode prefix that is used for identification and assigned to the media used by the drive. You can change the barcode prefix; however, ensure that a unique code is given to each drive.
   - **Media Capacity (MB)** – Specify the media size in MB. Ensure that sufficient space is available on the disk to create the virtual media.
5. Select **OK** to initiate the creation of the standalone drive. Depending on the number media size, this process may take a few minutes to complete. A
message is displayed when the process completes. Click OK to close the dialog.

6. The virtual standalone drive is added to the NetVault: Backup Server in the same manner as a physical drive. For details on adding the drive, refer to Adding Devices Using the Automatic Device Configuration Wizard on page 38 or Adding a Standalone Drive Manually on page 41.

4.12 Creating and Adding an SVTL

The procedure for creating and adding an SVTL can be divided into the following steps:

- Prerequisites
- Creating an SVTL
- Adding Library to the SVTL Controller
- Distributing SVTL Drives and/or Sharing SVTL Drives

**Note:** Whether you share or distribute the SVTL drives, only one Client controls the virtual arm changer.

These steps are described in the following sections.

4.12.1 Prerequisites

Before creating an SVTL, refer to the following notes and complete the required tasks. The information in this section is organized into the following topics:

- General Prerequisites
- Setting up Raw I/O on Linux
- Setting up Raw I/O on RedHat Linux
- Setting up Raw I/O on SUSE Linux
- Setting up Raw I/O on RedHat Enterprise Linux 5

4.12.1.a General Prerequisites

- Connect the disk array to all the NetVault: Backup Clients that will share the SVTL. The interface can be Fibre Channel, iSCSI or SCSI. On Linux and Solaris platforms, SCSI_FCP protocol is also supported.
- Only an unformatted disk that contains no mounted partitions/volumes can be used as an SVTL. A partition on a hard disk cannot serve as an SVTL.
- The disk must allow multiple interfaces.
- On Windows any non-ejectable disk can serve as an SVTL

NetVault: Backup does not support Multipath, Powerpath or software RAID technologies.
On Windows 2008 and Vista a new disk drive that is added must be first placed Online within the Disk Management administrative utility. When prompted to initialize the disk, select No. If you do not perform these steps, NetVault: Backup will not be able to create an SVTL on the disk.

Linux has a pool of raw device nodes that must be bound to a block device before raw I/O can be performed on it. There is a raw device controller that acts as the central repository of raw to block device binding information. Binding is performed using a utility named raw, which is normally supplied by the Linux distributor.

If using a disk or RAID volume on a SAN, edit the file /kernel/drv/sd.conf on Solaris Clients hosting the SVTL or sharing the drives. Enter the values for SCSI ID and LUNs to scan the appropriate disks and volumes in the following format:

name="sd" class="scsi" target=6 lun=5;

If a Solaris Client is hosting an SVTL, partition the disk as one slice of tag backup.

Determine the Client that will control the virtual arm changer.

4.12.1.b Setting up Raw I/O on Linux

To set up raw I/O on Linux, you require the following:

- The device or file names of the containers to create table spaces; the space associated with each device or file name that is to be allocated to the table space.
- One or more free IDE or SCSI disk partitions
- A raw device controller named /dev/rawctl or /dev/raw. If this is not present, issue the following command to create a symbolic link:

```
# ln -s /dev/your_raw_dev_ctrl /dev/rawctl
```

To set up raw I/O, perform the following steps:

1. At the prompt issue the following command:

```
ls /dev/rawctl
```

or

```
ls /dev/raw/raw1
```

It displays information from the devices.txt file that usually resides in the /usr/src/linux/Documentation/devices.txt directory

2. Logged in as root, issue the following command to create the device:

```
mknod /dev/rawctl c 162 0
```

3. Set the permissions to the following:

```
crw-rw-`
If you also require /dev/raw/raw1 and /dev/raw/raw2, follow the same procedure using the proper numbers listed in devices.txt and set the same permissions.

4.12.1.c Setting up Raw I/O on RedHat Linux

The following example shows how to set up raw I/O on RedHat Linux. The raw partition used is /dev/sda5.

1. Calculate the number of 4096-byte pages in this partition, as shown in the following example:

   ```
   # fdisk /dev/sda
   Disk /dev/sda: 255 heads, 63 sectors, 1106 cylinders
   Units = cylinders of 16065 * 512 bytes
   num_pages = floor( ((1106-524+1)*16065*512)/4096 )
   num_pages = 11170736
   ```

2. Bind an unused raw device node to this partition. This must be done each time the machine is rebooted. You must be logged in as root to issue this command:

   ```
   # raw /dev/raw/raw1 /dev/sda5
   ```

3. For persistent binding, open the file /etc/sysconfig/rawdevices and append the following line:

   ```
   dev/raw/raw1 /dev/sda5
   ```

   Reboot or issue the following command:

   ```
   # /etc/rc.d/init.d/rawdevices start
   ```

4. Set appropriate read permissions on the raw device controller and the disk partition. Set appropriate read and write permissions on the raw device.

4.12.1.d Setting up Raw I/O on SUSE Linux

On SUSE Linux, the raw disk partitions are administered in the /etc/raw file. This is a plain text file containing comments and examples for possible configurations. Once created, bind the raw devices. You do this by starting them with the script /etc/init.d/raw. Use the chkconfig(8) utility to guarantee that the raw device binding occurs during any restart.

4.12.1.e Setting up Raw I/O on RedHat Enterprise Linux 5

The raw devices interface has been deprecated in Red Hat Enterprise Linux 5; the raw device mapping is now performed via udev rules. To do this correctly, add the appropriate entries to the file /etc/udev/rules.d/60-raw.rules in the following formats:
For Device Names:

```
ACTION=="add", KERNEL=="<device name>", RUN+="/bin/raw /dev/raw/rawX %N"
```

For Major/Minor Numbers:

```
ACTION=="add", ENV{MAJOR}=="A", ENV{MINOR}=="B", RUN+="/bin/raw /dev/raw/rawX %M %m"
```

Replace <device name> with the name of the device you need to bind (e.g., /dev/sda1). A and B are the major / minor numbers of the device you need to bind, and X is the raw device number that you want the system to use.

If you have a large, pre-existing /etc/sysconfig/rawdevices file, convert it with the following script:

```
#!/bin/sh

grep -v "^ *#" /etc/sysconfig/rawdevices | grep -v "^$" | while read dev major minor; do if [-z "$minor"]; then echo "ACTION=="add"", KERNEL==\"${major##/dev/}\", RUN+=\"/bin/raw $dev%N\"" else echo "ACTION=="add"", ENV{MAJOR}==\"$major\", ENV{MINOR}==\"$minor\", RUN+=\"/bin/raw $dev%M%m\"" fi done
```

### 4.12.2 Creating an SVTL

To create an SVTL, perform the following steps:

1. Open the **Device Management** window (click **Device Management** on the toolbar or **Large Buttons** panel, or on the **Administration** menu, click **Device Management**).
2. On the **Add** menu, click **Add Library**. This opens the **Library Selection** tab in the **Add Library** window.
3. Under **Choose Library**, right-click the target machine and select **Create SVTL**.
4. In the **Create New Shared Virtual Tape Library**, enter the SVTL specifications as described below:
- **Library Device** – Select the target drive in the list. Depending on the operating system, the available disks are listed as follows:
  - **Windows** – PhysicalDrive1, PhysicalDrive2, etc.
  - **Linux** – /dev/raw/raw1, /dev/raw/raw2, etc.
  - **Solaris** – /dev/rdsk/c0t0d0s0, /dev/rdsk/c1t1d0s0, etc.
- **Device Description** – This parameter indicates the disk type.
- **Device Size** – This parameter indicates the disk size.
- **Device Block Size** – This parameter indicates the block size.
- **Previously Formatted as SVTL?** – This parameter indicates whether the selected disk was previously formatted as an SVTL.

**Figure 4-7:** Enter the SVTL specifications

- **Barcode Prefix** – For each SVTL, NetVault: Backup generates a barcode prefix that is used for identification and assigned to the media used by the SVTL. You can change the barcode prefix; however, ensure that a unique code is given to each SVTL.
- **Number of Drives** – Enter the number of drives for the SVTL. The number of drives can be more than the number of Clients currently connected to the disk. The additional drives can be used in future to connect more Clients.
- **Number of Media Items** – Enter the total number of slots that will hold the media.
- **Media Capacity (MB)** – Specify the media size in MB. When creating an SVTL, NetVault: Backup stores some information about the SVTL on the disk, which consumes a few megabytes of space. Take this into consideration when you configure the media capacity.
5. To determine the required disk size for an SVTL with the given specifications, click **Calculate Size Required**. If the required disk size is larger than the actual disk size, reduce the number of Media Items and Media Capacity.

6. Select **OK** to initiate the creation of SVTL.

7. When the process completes, a **Final Confirmation** window is displayed. Enter the following details to format the SVTL:
   - **Password** – Enter the NetVault: Backup password for the machine.
   - **Confirmation Phrase** – Enter the text `FORMAT SVTL`.
   - Click **Format**.

8. A message is displayed when formatting completes. Click **OK** to close the dialog.

### 4.12.3 Adding Library to the SVTL Controller

To add the SVTL to the NetVault: Backup Client that will control the virtual arm changer, perform the following steps:

1. Open the **Device Management** window (click **Device Management** on the toolbar or **Large Buttons** panel, or on the **Administration** menu, click **Device Management**).

2. On the **Add** menu, click **Add Library**. This opens the **Library Selection** tab in the **Add Library** window.

3. Under **Choose Library**, open the SVTL Controller node (double-click the node, or right-click it and select **Open**). In the device tree, the attached libraries will be listed under the machine node.

4. Open the **SVTL Robotic Libraries** node. The SVTL is displayed.

5. Double-click the SVTL or right-click and choose **Select**.

6. Perform the procedures described in the sections **Distributing SVTL Drives** on page 54 or **Sharing SVTL Drives** on page 55 to distribute or share the SVTL drives.

### 4.12.4 Distributing SVTL Drives

NetVault: Backup allows you to add an SVTL drive to a Client for exclusive use. To distribute the SVTL drives among multiple Clients, perform the following steps:

1. Click the **Drive Selection** tab.

2. Open the Client to which you want to add the drive.

3. Open the **SVTL Channel** node. All the available SVTL drives are listed under this node.

4. Enter 1 in the **Select for Drive Bay** box.
5. Under **Choose Drives**, double-click drive 1 or right-click it and choose **Select**. The drive picture, type and details are displayed under **Selected Drives**.

6. Repeat steps 2–5 for the remaining shared drives that are to be added, changing the Client, drive number and bay for each drive.

7. To configure the drive parameters, refer to [Configuring Drive Parameters on page 57](#).

### 4.12.5 Sharing SVTL Drives

The SVTL drives can be distributed or shared among multiple Clients. Only one client controls/uses the drive at a given point of time. To share the SVTL drives, perform the following steps:

1. Click the **Drive Selection** tab.

2. Open the SVTL Controller node.

3. Open the **SVTL Channel** node. All the available SVTL drives are listed under this node.

4. Perform the following steps to share the drives:
   a. Enter 1 in the **Select for Drive Bay** box.
   b. Under **Choose Drives**, double-click drive 1 or right-click it and select **Add Shared**. The drive picture, type and details are displayed under **Selected Drives**.
   c. Repeat steps a and b for the remaining drives that are to be shared, changing the drive number and bay for each drive.

5. To add the shared drives to the Clients, perform the following steps:
   a. On the **Drive Selection** tab, open the Client to which you want to add the drive.
   b. Open the **SVTL Channel** node. All the shared SVTL drives are listed under this node.
   c. Enter 1 in the **Select for Drive Bay** box.
   d. Under **Choose Drives**, double-click drive 1 or right-click it and select **Add Shared**. The drive picture, type and details are displayed under **Selected Drives**.
   e. Repeat steps a and b for the remaining shared drives that are to be added, changing the drive number and bay for each drive.

6. Perform step 5 for each Client to which you want to add the shared drives.

7. To configure the drive parameters, refer to the section **Configuring Drive Parameters on page 57**.
4.13 Configuring Library Parameters

To set or change the library settings, perform the following steps:

1. For a new library, click the Configure tab in the Add Library window.
   For an existing library, right-click the target library on the Devices tab and select Modify. In the Modify Library window, click the Configure tab.
2. Double-click the target library. This opens the Configure Device window.

**Note:** Depending on the type of library you are using, the configuration settings may vary. This section outlines only the generic parameters that apply to most libraries. Contact BakBone Technical Support for any help to configure specific parameters not covered in this section.

3. Click the Configuration tab.
   It is recommended that you do not change the default settings for the following parameters, unless otherwise advised by a BakBone Technical Support Representative:
   - **Need Command to Open Entry/Exit Port**
   - **Do Not Issue Unload Commands to Drives**
   - **Must Unload Drive(s) to Open Door**
   - **Do Not Overlap Commands to Arm and Drive**
   - **Entry/Exit Port Locks Arm**

   Configure the remaining parameters as described below:
   - **Return Inactive Media to Slot Delay** – Enter the timeout value for media inactivity. The media is returned back to the slot if no activity occurs during the specified interval. If the parameter is set to zero, then media is retained in the drive indefinitely.
   - **Mark Unknown Media Blank** – When NetVault: Backup is not able to read a tape's header, it marks the media as Unknown. Select the Mark Unknown Media Blank check box to mark such media as Blank instead of Unknown. However, you must still run the Blank command to actually delete the data and use the media for backups.

4. To configure the drive cleaning parameters, refer to Configuring Cleaning Support on page 72. For mixed media settings refer to Adding and Configuring a Mixed Media Library on page 64.

5. Click **OK** to save the settings.
4.14 Configuring Drive Parameters

To configure or modify the drive settings, perform the following steps:

1. For a new drive, click the Configure tab in the Add Library/Standalone Drive window and double-click the target drive. For an existing drive, right-click the drive in the Devices tab and select Configure.

   This opens the Configure Device window.

   Note: Depending on the drive type the configuration settings may vary. This section outlines only the generic parameters that apply to most drives. Contact BakBone Technical Support for any help with setting specific parameters not covered in this section.

2. Click the corresponding tab and configure the parameters as described in the following sections:
   - Configuring General Parameters
   - Configuring NDMP Parameters
   - Configuring Performance Parameters
   - Configuring Data Collection Parameters
   - Configuring Timeout for SCSI Commands

3. To configure the drive cleaning parameters, refer to Configuring Cleaning Support on page 72.

4. Click OK to save the settings.

4.14.1 Configuring General Parameters

This section describes how to configure the parameters on the Configuration tab. It is recommended that you do not change the default settings, unless otherwise advised by a BakBone Technical Support Representative.

- **Device Serial Number** – The device serial number is displayed in this box and it cannot be changed.

- **Amount of Media Reserved at End of Tape (MB)** – Enter the remaining space in the media at which the end of media warnings are issued.

- **Cleaning Tapes Supported** – This parameter informs whether the library has automatic cleaning tape support or not. Generally, the default value is correct, unless certain library models have a different setting.

- **Time (in seconds) to Wait for Tape to Go Ready** – Enter the timeout value for media availability. This includes the time for the drive to load and spool media, and transit from busy and becoming busy states to read a SCSI command. NetVault: Backup raises a Media Request if all these do not occur in the specified interval.
Time (in seconds) to Wait to Stop Reporting No Media Present – Enter the time NetVault: Backup waits for a drive to stop indicating no media present message and start showing media loaded.

Time (in seconds) to Wait for Cleaning Tape to Start Reporting Cleaning Drive – Enter the time NetVault: Backup waits for the cleaning drive to load and spool cleaning tapes and send the cleaning initiation message.

Time Between Polling Empty Drives – Enter the interval at which NetVault: Backup polls the standalone drives for media change.

Media Block Size – Enter the block size for the data that is read and written to the media. The default media block size is 32 KB and can be increased in increments of 1 KB, although many devices will only accept a value in multiples of 4 KB or 32 KB. The maximum media block size is limited by several factors, including the operating system, SCSI adapter, the make, model and type of drives.

Large media blocks enable reading and writing of larger blocks of data, thereby reducing the overall number of times a backup needs to read data and write it to media. However, this does not always imply an overall faster backup.

On Linux/UNIX platforms, you can increase the media block size for optimum performance.

To use block sizes larger than 64 KB on Windows, you might have to change the registry setting called MaximumSGList. Before changing this setting, ensure that you are only using tape devices on your SCSI bus. If there are...
other devices present, this registry change might prevent them from working. If you want to apply these changes only to a specific channel on the HBA, consult the hardware vendor. To change the registry setting, perform the following steps:

a. Open the Registry Editor (on the Taskbar, click Start and select Run; in the Open box, enter regedit).

b. Open the \[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\<HBA Vendor>\Parameters node where <HBA Name> is specific to your SCSI card (e.g. QL2200 for a Qlogic 2200 card).

c. Create a Device key, if it is not present.

d. Under Device key add DWORD (if not present). Set the DWORD to MaximumSGList.

e. Calculate the hexadecimal value as described below:

32-Bit Systems:

\[ \text{MaximumSGList} = \left( \frac{\text{Maximum Block Size}}{4 \text{ KB}} \right) + 1 \]

For example, for 256 KB block size, the value will be 256 KB / 4 KB = 64. Adding 1 gives a value of 65 (decimal) or 0x41 (hexadecimal). You can configure any block size between 64 KB and 1 MB. The maximum value is 255 or 0xFF, for a 1 MB block size.

64-Bit systems:

On 64-Bit systems, the OS page size is 8 KB by default. Therefore, the maximum transfer size is 2 MB.

\[ \text{MaximumSGList} = \left( \frac{\text{Maximum Block Size}}{8 \text{ KB}} \right) + 1 \]

do Reboot the system to apply the changes.

- **Time (in seconds) to Wait for Plugin to Connect** – Enter the timeout value for the plugin to connect to NetVault: Backup. The job is aborted if connection is not established within the specified interval.

- **Support Short Reads** – Select this check box to support short reads.

- **Compression** – Select this check box to use the tape's built-in compression functionality. Not all drives support this function and the amount of compression will vary depending on the type of data and the drive compression algorithm. Consult the hardware documentation to determine the compression rates for your drive. On some tapes, compression can be configured in the hardware, which will override this setting.
4.14.2 Configuring Software Compression Parameters for Virtual Tape Drives

The software compression parameters can only be configured for the virtual tape drives. To configure the software compression settings, click Software Compression and set the values as described below:

- **Perform Software Data Compression** – Select this check box to enable compression. The data will be compressed when it is transferred to this device during backup.

- **Compression Decision Switch** – The value set for this parameter determines the minimum level of compression which must be achieved when data is compressed during a backup. For example, if you set the value to 80%, NetVault: Backup will attempt to compress the data during backup and perform one of the following:

  - If the end result of the compression produces data less than 80% of the original data size, the data will be written to virtual media compressed.
  - If the end result of the compression produces data more than 80% of the original data size, NetVault: Backup will not compress the data and complete a normal backup with the actual file size.

If you enter 80%, then a file size of a 100 MB must be <= 80 MB after compression. If not, NetVault: Backup will backup the file uncompressed. The extent that data can be compressed is dependant on the data contents. Encrypted data will typically not compress. With some files, compression may actually result in a file that is larger than the original uncompressed file.

- **Number of Data Blocks per Compression Unit** – Enter the number of data blocks per compression unit. The default block size in 32 Kb which can be
changed via the Configuration tab. For details, refer to Configuring General Parameters on page 57.

When an NVDB backup is restored, the remaining space on virtual tapes that contain compressed save sets is not reported correctly. As a work-around, you can perform either of the following:

- Clear the Software Compression check box and re-launch the job to scan the media again.
- Manually scan the target media. If the media is not displayed, perform the following steps:
  a. Click the Media Request tab.
  b. Right-click the corresponding entry in this window and select Hold.
  c. On the Devices tab, right-click the VTL and select Scan. The media will be returned to the drive.
  d. On the Media Request tab, right-click the entry and select Off Hold.

4.14.3 Configuring NDMP Parameters

It is recommended that you do not change the default settings for any of the NDMP configuration parameters unless otherwise advised by a BakBone Technical Support Representative.

4.14.4 Configuring Performance Parameters

To configure the performance settings, click the Performance tab and set the values as described below. Any changes to performance settings only apply to a blank media. If you are re-using media, then blank it first for these changes to take effect.

- Amount of Memory to Assign For Transfer Buffers (KB) – The transfer buffer or the shared memory is allocated in blocks of 32 KB. The default size for this buffer is 257 KB and can be increased for faster performance. The formula to calculate a valid buffer size is given below:
  \[(<\text{Total number of buffers}> \times 32) + 1 \text{ byte}\]

On Linux/UNIX, you require sufficient RAM and large Shared Memory segment. Before increasing the transfer buffer size, check the following parameters on these platforms:

- Maximum size of a shared memory segment (SHMMAX)
- Minimum size of shared memory segment (SHMMIN)
- Maximum number of shared memory identifiers in the system (SHMMNI)
- Maximum number of shared memory segments a user process can attach (SHMSEG)
- Maximum number of semaphore identifiers in the system (SEMMNI)
Chapter 4
Managing Backup Devices

- Maximum number of semaphores in a set (SEMMSL)
- Maximum number of semaphores in the system (SEMMNS)
- Maximum number of operations per semop call (SEMOPM)
- Semaphore maximum value (SEMMX)

The total allowed shared memory is determined by the formula SHMMAX * SHMSEG. These values are often limited by the `ulimit` setting, and the command `ulimit -a` can be used to view these system settings.

On Windows, you require at least 2 GB RAM and large virtual memory. You might also have to change the maximum SGlist parameter on the SCSI card.

Some examples of the optimal values that can be specified for some of the drives are given below:

<table>
<thead>
<tr>
<th>Drive Type</th>
<th>Optimal Transfer Buffer Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Modern Tape Drives e.g., LTO (1, 2 or 3), SDLT or SAIT</td>
<td>65537 (64 MB + 1 KB)</td>
</tr>
<tr>
<td>Medium Tape Drives e.g., DLT8000, DLT7000 and AIT-3</td>
<td>32769 (32 MB + 1 KB)</td>
</tr>
<tr>
<td>Older Professional Tape Drives e.g., DLT2000, DLT4000, AIT-2, etc.</td>
<td>16385 (16 MB + 1 KB)</td>
</tr>
<tr>
<td>Older Low Capacity Low-end Drives e.g., EXB-8505, AIT-1, DAT, etc.</td>
<td>8193 (8 MB + 1 KB)</td>
</tr>
</tbody>
</table>

- **Number of Media Blocks to Write/Read at a Time** – It is recommended that you do not change the values for these two parameters. If you change the value, record them as it will be necessary to re-apply them if the drive is re-installed. Restores require the same values that were set at the time of backup and will fail if the settings do not match.

- **Lock Transfer Buffer in Memory** – This option locks the allocated transfer buffer position in memory, increasing the potential performance and preventing another process from using it when NetVault: Backup is running. It is recommended that you leave this selected unless otherwise advised by a BakBone Technical Support Representative.

### 4.14.5 Configuring Data Collection Parameters

The drive performance statistics are collected for complete data transfer that occurs between the Client and device during a job execution. No statistics are collected for individual read and write actions on the device by NetVault: Backup, although excessive soft read and write errors are recorded for the drive (log pages). To collect drive performance statistics, click the **Statistics** tab and configure the following parameters:
Gather Statistics on Device Performance – Select this check box to log the statistics for drive performance. You can view this information from the Device Logs tab. While the information facilitates troubleshooting, it also increases the NVDB size.

Gather Statistics on Data Channel Performance – Select this check box to log the statistics for the Data Channel. You can view this information from the Device Logs tab. While the information facilitates troubleshooting, it also increases the NVDB size.

Record Drive Performance – Select this check box to record the drive performance details with each job that uses the given drive. You can view these logs from the Logs window.

Length of Time (in seconds) Between Sampling Drive Transfer Rates – Enter the interval at which NetVault: Backup collects the Drive Transfer Rate statistics.

4.14.6 Configuring Timeout for SCSI Commands

On the SCSI Configuration tab, the default timeout value for the different types of SCSI commands is set to zero, which correspond to the following intervals:

- Fast SCSI Commands – 300 seconds
- Slow SCSI Commands – 900 seconds
- Very Slow SCSI Commands – 3 hours

An error is logged if a command execution does not complete within the specified interval. It is recommended that you do not change the default timeout for any of the SCSI commands unless otherwise advised by a BakBone Technical Support Representative.

4.15 Using Mixed Media Libraries

This section provides detailed information on adding and configuring mixed media libraries.

4.15.1 Organizing Media in a Mixed Media Library

Before adding a mixed media library, you must organize the media within so that like-types are grouped together in ranges of slots in the library. For example, for two media types, group each type together and then place each group in a consistent range of slots. Note the slot locations for each type. This information will be required when configuring the library.
4.15.2 Adding and Configuring a Mixed Media Library

To add a mixed media library, perform the following steps:

1. Open the Device Management window (click Device Management on the toolbar or Large Buttons panel, or on the Administration menu, click Device Management).

2. On the Add menu, click Add Library. This opens the Library Selection tab in the Add Library window.

3. Under Choose Library, open the Server/Client node to which the device is connected (double-click the node, or right-click it and select Open).

4. Depending on the library type, open the Robotic Libraries or NDMP Robotic Libraries node. The attached libraries are listed under their type.

5. Double-click the library or right-click and choose Select. The library picture, type and details are displayed under Selected Library.

6. Click the Drive Selection tab.

7. Open the Server/Client node to which the device is connected.

8. Open the corresponding drive type node. The available drives are listed under this node.

9. Perform the following steps to assign the correct drive bay to each drive:
   a. Enter 1 in the Select for Drive Bay box.
   b. Under Choose Drives, double-click drive 1 or right-click it and choose Select. The drive picture, type and details are displayed under Selected Drives.
   c. Repeat steps a and b for the remaining drives, changing the drive number and bay for each drive.

Note: While the drive number usually matches the bay number, depending on the library and drive configuration a different assignment of drives to bays might be necessary. If you experience failure during move or load/unload operations, consider adding your drives in a different order to their bays.

10. Click the Configure tab, and double-click the target library in the device list.

11. In the Configure Device window, click the Mixed Media tab. Configure the following parameters:
**Slot Types** – The **Slot Types** list specifies the slot range(s) for each media type. The slot range(s) for each media type would be determined by how the media was organized in the library during initial setup (for details, refer to *Administering Added Devices on page 67*). To create this list, assign a unique **Slot Type Identifier** for each media type and specify the corresponding slot range for it. The format for creating this list is given below:

\[ <\text{SlotTypeIdentifier}>=<\text{SlotRange}> \]

More than one slot range can be configured for a media type. However, each slot range or individual slot must be configured as a separate list item. Comma-separated values are not supported. Use the same **Slot Type Identifier** for configuring the additional slots or slot ranges. When assigning a **Slot Type Identifier**, ensure that it allows you to easily identify the media type contained in the slot. No spaces are allowed in the values. Some examples are given below:

- SDLTMedia=1-10
- STKRMedia=11-30
- LTO1Media=31-60
- LTO1Media=101

**Drive Types** – The **Drive Types** list specifies the types of drives that are available on the library. To create this list, assign a unique **Drive Type Identifier** for each media type and specify the corresponding drive number for it. The format for creating this list is given below:

\[ <\text{DriveTypeIdentifier}>=<\text{DriveNumber}> \]

![Figure 4-10: The Mixed Media tab](image)
For multiple drives of the same type, configure each individual drive as a separate list item. Comma-separated values are not supported. Use the same Drive Type Identifier for configuring multiple drives of the same type. When assigning a Drive Type Identifier, ensure that it allows you to easily identify the drive type. No spaces are allowed in the values. Some examples are given below:

SDLT=1
STKR=2
STKR=3
LTO1=4

Drive Types/Media Type Compatibilities – This list specifies the supported media type for each drive type. The format for creating this list is given below:

<DriveTypeIdentifier>=<SlotTypeIdentifier>

Some examples using the above Drive Type and Slot Type Identifiers are given below:

SDLT=SDLTMedia
STKR=STKRMedia
LTO1=LTO1Media

This configuration ensures that media is only obtained from the corresponding slots when a particular type of drive is accessed.

12. Click Save Details on the toolbar. The library is added and listed on the Devices tab. When the library initialization and inventory completes, the status changes to online.

4.15.3 Adding Media to a Library with an Entry/Exit Port

To add media to a library that has an entry/exit port, perform the following steps:

1. Open the Device Management window.
2. On the Devices tab right-click the target library, and select Open Entry/Exit Port.
3. Insert the media in the EE port.
4. On the Devices tab right-click the target library, and select Close Entry/Exit Port.
5. A Close Entry/Exit Port window will appear. In the Media Type list, select the correct media type for the new media and click OK.
   NetVault: Backup will automatically import the media and place it in a pre-configured slot of the same type.
6. Repeat steps 2–5 for each additional media.
Note: Ensure that the media type for the new media is assigned correctly. An incorrect media type association would result in future job failures. In addition, the library may be physically damaged as the arm changer attempts to place a wrong media into a drive.

4.15.4 Adding Media to a Library without an Entry/Exit Port

To add media to a library that has an entry/exit port, perform the following steps:

1. Open the Device Management window.
2. On the Devices tab right-click the target library, and select Open Door.
3. Place the media in an empty slot corresponding to the slot range assigned for the media type.
4. Repeat step 3 for each additional media.
5. On the Devices tab right-click the target library, and select Open Door.

Note: Ensure that the media is inserted into a slot that corresponds to the slot range configured for the given media type. Inserting the media into an incorrect slot would result in future job failures. In addition, the library may be physically damaged as the arm changer attempts to place a wrong media into a drive.

4.16 Administering Added Devices

This section describes the various device management procedures.

4.16.1 Viewing Device Status

To view the current status of a device, perform the following steps:

1. On the Devices tab right-click the target library, drive or slot, and select Status.
2. In the status window, the following details are displayed.
   - Library Details – The library information contains the device name, controlling machine name and library status.
   - Drive Details – The drive information contains the drive name, controlling machine name, the physical and logical position of the drive in the library, cleaning status and other read/write statistics.
   - Slot Details – The slot information contains slot position in the library and media barcode
3. Click the corresponding tab to view these details. When finished click OK.
4.16.2 Modifying Library Configuration
To modify the library configuration, perform the following steps:
1. On the Devices tab right-click the library, and select Modify.
2. This opens the Modify Library window which is similar to the Add Library window. To change the settings, refer to Adding a Library Manually on page 40.
3. To save the new settings, click Save Details on the toolbar, or on File menu click Save.

4.16.3 Toggling Devices View
NetVault: Backup provides two ways to view the added devices:
- **Physical View** – This is the default view. It displays the actual structure of the library, including all drives, slots and entry/exit ports. Media is shown at its current location in the library.
- **Logical View** – This view is centered around the actual media in a library. The device tree contains two folders – Drives and Media. The libraries and drives are grouped as Drives and the Media are grouped according to the Group Label.

To change the view type, perform the following steps:
1. On the Devices tab right-click the target library, and select Change View.
2. The view changes from Physical to Logical or vice versa and a message is displayed.
3. Click OK to close the dialog.

4.16.4 Removing a Library
To remove a library, perform the following steps:
1. On the Devices tab right-click the library, and select Remove.
2. In the confirmation window, click OK.
3. The library is removed and all the data related to it is deleted from the NVDB.

*Note:* Removing a library does not remove the media information from the NVDB. You can still use the media on any other library that supports the given media type. No scanning of media is required as long as the Controlling Server remains the same. On a different NetVault: Backup domain, you must scan the media.

4.16.5 Removing a VTL
When you remove a VTL, the used media information is still stored in the NVDB. To remove a VTL completely, perform the following steps:
1. On the Devices tab right-click the VTL, and select Bulk Blank. This removes all the job indexes associated with the data stored on the VTL.
2. Right-click the VTL and select Remove.
4. Open .../NetVault/config/diskdevices.cfg file in a text editor (where ... represents the NetVault: Backup installation directory)
5. Under the [libraries] and [drives] sections, delete all entries for the deleted VTL.
6. Save and close the file.
7. Then, go to the VTL location on the hard disk, and delete the directory that represents the removed VTL.

4.16.6 Opening and/or Closing Library Door
To open or close the library door, perform the following steps:

1. On the Devices tab right-click the library, and select Open Door. The library goes offline when you open the door.
2. To bring it back online, right-click, and select Door Closed.

4.16.7 Opening and/or Closing Entry/Exit Ports
To open or close the entry/exit ports, perform the following steps:

1. On the Devices tab right-click the library, and select Open Entry/Exit.
2. To close the port after placing the media, select Entry/Exit Closed. If you have placed a cleaning media in the port, select Entry/Exit Closed with Cleaning Media. NetVault: Backup moves the media to a cleaning slot in the library.

4.16.8 Checking Offline Drives
To run a self-test on an offline drive in which media is loaded, perform the following steps:

1. On the Devices tab right-click the drive, and select Check.
2. NetVault: Backup runs a self-test and if media is found, brings the drive online.

4.16.9 Taking Drives Offline in NetVault: Backup
To take a drive offline, perform the following steps:

1. On the Devices tab right-click the drive, and select Offline. This marks the drive as offline and it is not available for use with NetVault: Backup. For shared drives, you can either mark an individual drive or all paths as offline.
This process does not physically take the drives offline.

2. To bring it back online, right-click and select **Online**.

**Note:** For standalone physical drives, when media is in the device, you cannot bring the drive online. You must either restart the NetVault: Backup service, or remove the media before bringing the drive online.

### 4.16.10 Loading and/or Unloading Media

To load and unload media, perform the following steps:

1. On the **Devices** tab right-click the slot, and select **Load**.
2. This loads the media on to an available drive.
3. To unload a media, right-click the drive and select **Unload**. In a library the media is moved to an available slot, while in a standalone drive the media is ejected.

### 4.16.11 Exporting Media to Entry/Exit Port

To export a media to an entry/exit port, perform the following steps:

1. On the **Devices** tab right-click the slot, and select **Export**.
2. This moves the media in the slot to an entry/exit port.

### 4.16.12 Restarting a Library

If an ACSLS or an NDMP library encounters a network problem, use this procedure to re-start the library. It stops and restarts the changer and drive processes. This has the effect of restarting the network/socket connections as the existing ones are closed and new ones are created.

1. On the **Devices** tab right-click the library, and select **Restart**
2. This restarts the network/socket connections by removing and adding the library again.

### 4.17 Importing NetApp VTL's Shadow Tape

NetVault: Backup extends support to NetApp VTL's shadow tape feature which allows you to quickly import a tape from the shadow tape pool whenever possible instead of obtaining the physical tape.

To use shadow tapes, configure the **Enable Shadow Tapes** on the filer and on the library containing the virtual tape. For more information on enabling shadow tapes, consult the relevant NetApp VTL documentation. Use the tape barcode as the label for the virtual tape media. NetVault: Backup requires this method of labelling media to be fully functional. (This can be configured via the NetVault Configurator by selecting the **Use Barcodes as Labels** check box on the **Media Manager** tab.)
With shadow tapes enabled, whenever a virtual tape is exported to a physical tape, the virtual tape is moved to the shadow tape pool. The shadow tape pool is invisible to the backup application and is not listed as part of a virtual library. But it is available for quick access if the physical tape is later imported, and is available for reading if the physical tape is stored offsite or otherwise unavailable.

The NetApp VTL manages the space used by shadow tapes, and can delete a shadow tape if more space is required for new backup data. The administrator can set a preferred retention time for shadow tapes; if space is required, but the retention period has not expired, the NetApp VTL sends a notification before deleting the shadow tape.

To import a virtual tape, perform the following steps:

1. On the Devices tab right-click the library containing the virtual tape, and select Import Media. NetVault: Backup displays the list of media available in the shadow tape pool in the Select Shadow Tape Media Barcode for Import window.
2. Select the barcode for the required media from the Media Barcode list or alternatively enter the barcode.
3. Click OK. The requested tape is imported into the medium changer from the shadow tape pool, if present, or from the physical library. If both the shadow tape and the physical tape are present, then the shadow tape is converted to a (read only) virtual tape and imported to the EE port. If only the physical tape is available, a virtual tape is created from the physical tape and the virtual tape is imported to the EE port.

Note the following:

- The media requests for shadow tapes can only be used for Restore or Duplication tasks because the shadow tape is converted to a virtual tape with the read-only attribute set.
- All shadow media must be exported from a library before NetVault: Backup is shutdown and restarted; otherwise the media loses its shadow media attribute and is only recognized as read-only. This happens because the NetVault Database does not hold a permanent record of the shadow tape media. The database holds only the details of the actual media. The shadow tape attribute is associated with the media when it is imported as shadow tape into the library. For the same reason, shadow tape media should be exported before the library door is opened.
- Error messages are displayed if you try to import media when no media is available in the shadow tape pool, or when the shadow tapes feature is not supported on the device.
4.18 Working with Cleaning Tapes

It is necessary to configure cleaning support before loading the actual cleaning tapes into the library. Otherwise, the drives will try to read the cleaning media and go offline. This section describes how to configure cleaning support. Additionally, it describes the procedures for setting up automatic cleaning routine, configuring cleaning media life, and others.

4.18.1 Configuring Cleaning Support

This section describes how to configure libraries to use cleaning media. Before starting this procedure remove any cleaning tapes from the library.

1. On the Devices tab right-click the target library, and select Modify. This opens the Modify Library window.
2. Click the Configure tab.
3. Double-click the library, or right-click the library and select Configure.
4. Click the Cleaning tab.
5. For libraries that support automatic cleaning, the Automatic Cleaning Supported check box is selected by default.

![Figure 4-11: Configuring the parameters for cleaning tapes](image)

6. Then, configure one of the following parameters:
   - **Barcode Prefix(es) of Cleaning Media** – Enter the barcode prefixes for the cleaning media. For multiple cleaning tapes, use comma-separator.
   - **Cleaning Slots** – Enter slots in which the cleaning media will reside. For multiple slots, use comma-separator

7. Click OK.

If the library requires Generic Cleaning, perform the following steps:

1. Double-click the drive in the Modify Library window (or, right-click it and select Configure).
2. Click the Generic Cleaning tab.
3. Select the Use Generic Cleaning check box.
4. Change the **Length of Cleaning Cycle**, if required.
5. Select **Issue a Load Command to Start Cleaning Cycle** if the drive requires a load command to initiate a cleaning cycle.
6. Click **OK**.
7. To save the settings, click **Save Details** on the toolbar, or on **File** menu click **Save**.
8. To configure the re-use settings for cleaning media, refer to *Configuring Re-use Settings for Cleaning Media on page 73.*
9. To set an automatic cleaning routine, refer to *Setting Automatic Cleaning Routine on page 73.* Repeat this procedure for each drive in the library.

### 4.18.2 Configuring Re-use Settings for Cleaning Media

You can set the number of times a cleaning media can be re-used by setting the Life property for the media. Perform the following steps to configure the media life for the cleaning media.

1. On the **Devices** tab right-click the target cleaning drive, and select **Life**.
2. Enter the media life in the **Lives** box.
3. Click **OK** to save the property.

### 4.18.3 Viewing Drive Cleaning Status

To check the status of cleaning drives/slots, perform the following steps:

1. On the **Devices** tab right-click the target drive, and select **Status**.
2. Click the **Cleaning** tab in the **Status** window. This tab displays the following details - Last cleaning date, Time elapsed since, Times cleaned, Data transferred since, Time in use since, and Soft errors reported since.
3. Click **OK** to close the window.

### 4.18.4 Setting Automatic Cleaning Routine

To establish an automatic cleaning routine, perform the following steps:

1. On the **Devices** tab, right-click the target drive and select **Clean Properties**.
2. In the **Cleaning Interval** window, select one or more options and configure the routine:
   - **Days** – Select this check box and enter the number of days between two cleaning cycles.
   - **Data Transferred (GB)** – Select this check box and enter amount of data read/written (in GB) after which the drive is cleaned.
   - **Hours of Use** – Select this check box and enter the number of hours between two cleaning cycles.
Soft Read/Write Errors (*100) – Select this check box and set the cleaning routine based on the number of errors encountered (in hundreds).

3. Click OK to set the cleaning routine.

4.18.5 Cleaning Drives Manually

Apart from the cleaning routine set to occur automatically, if you want to run it manually, perform the following steps. This can be done only for drives that support automatic drive cleaning.

1. On the Devices tab right-click the target cleaning drive, and select Clean.
2. In the confirmation window click Yes. NetVault: Backup starts the cleaning routine and on completion displays a message.
3. Click OK to close the dialog.
Chapter 5:

BACKING UP DATA

This chapter describes how to backup data with NetVault: Backup. The information in this chapter is organized into the following topics:

- Backup – An Overview
- Designing a Backup and Recovery Strategy
- Backing up Data with NetVault: Backup Plugins
- Defining a Backup Job
- Backup Device and Media Options
  - Selecting Target Device
  - Configuring Backup Media Options
- Advanced Backup Options
  - Configuring Retention Policy for a Backup
  - Using Pre and Post Backup Scripts
  - Setting up Custom Notification Events for a Job
  - Verifying a Backup
  - Enabling Network Compression for a Backup
- Viewing and/or Modifying a Backup Job
- Duplicating a Backup
- Archiving Data
- Encrypting a Backup
  - Limitations of the Encryption Plugin
  - Installing the Encryption Plugin
  - Configuring the Encryption Plugin
  - Disabling the Encryption Feature
- Managing Backup Indexes
  - Deleting Online Indexes
  - Compressing Online Indexes
5.1 Backup – An Overview

A backup is a copy of data that can be used to restore and recover data after a failure. NetVault: Backup provides a number of plugins which interface with the native APIs to backup the application-specific data. The backup methods and options provided by these plugins vary depending on the application type. In general, NetVault: Backup offers the following features:

- Application-specific backup methods and capabilities
- Policy-based backups
- Job scheduling features
- Backups utilizing selection sets
- Local LAN-free backups
- Data duplication and/or migration
- Backup encryption
- Backup compression

5.2 Designing a Backup and Recovery Strategy

The primary objective of backing up data is to recover from the damages caused by a failure and resume normal operations quickly. This requires a well-designed backup and restore strategy that maximizes data protection and minimizes data loss, while considering your business requirements and balancing your needs with costs, resources and other factors.

The key to formulating an efficient strategy is to envision the possible failure modes, like media failure, data corruption, user error or complete loss of a data centre, match the plugin features that can be used to recover from these scenarios and then include the necessary backup methods in your plan.

Typically, your backup plan should include the backup methods you will use, the frequency of backups, the retention period for backups and the media rotation policies, and how you will store the backup media. Answering the following questions will help you choose the suitable methods and define the schedule.

- What is the amount of data to be backed up?
- Does it comprise mainly of large files or smaller ones?
- What is the frequency of updates and changes?
- Which time during the day and/or week can be considered off-peak period for full backups?
- Are some files updated more frequently than others?
- Are the changes confined to a small or large number of files?
Are there situations that demand ad-hoc backups independent of the regular backup schedule?

- How much space is available for storing backups and what are the future expansion plans?

### 5.3 Backing up Data with NetVault: Backup Plugins

Backups are performed from the **Backup** window. You can use the GUI running on the NetVault: Backup Server or any Client to define and submit the backup jobs.

A backup job definition generally consists of the following components:

- Selection list
- Plugin specific backup options
- Job schedule
- Source device options which specify where the source media is located (Data Copy Plugin and Consolidate Incremental Backups Plugin)
- Target device and media options
- Advanced backup options

Each component contains a set of attributes which can be configured using the following methods:

- For each new job, you can set the attributes manually and save them in the job definition. This method is better suited for ad-hoc jobs that are seldom performed, or jobs that mainly use the default options.
- Alternatively, you can use selection sets to store the job attributes and use them to define the subsequent jobs without performing the manual steps. This method is recommended for regular jobs. With selection sets, you can easily change any one component and automatically apply them to all jobs using that set. For example, you can change the target device for all jobs by changing the device configuration in the Target set. For details on selection sets, refer to *Using Selection Sets* on page 103.

Each job has a Job ID and a title. The Job ID is a sequential number which is auto-generated. The job title is user-defined and allows you to easily identify the job when monitoring its progress, viewing the job logs or selecting the saveset to restore data.

The backup data is stored in a **Saveset** on the media. For each saveset, NetVault: Backup generates an index that is written to the NetVault Database and the backup media. The index contains the header information which is required for restoring data. The maximum index size for a saveset can be 4 GB.
5.4 Defining a Backup Job

To define a backup job, perform the following steps:

1. Open the Backup window (click Backup on the toolbar or Large Buttons panel, or on the Operations menu, click Backup).
2. On the Selections tab, open the target Client node.
   
   To open any node on the Selections tab, you can do either of the following:
   - Double-click the node
   - Right-click the node and select Open
3. Select the plugin you want to use.
4. Select the data you want to backup. The selection tree varies for different plugins. Refer to the relevant APM/Plugin User's Guide for more information on selecting data for a backup.
5. Click the Backup Options tab and configure the backup method (e.g., full, incremental), and other run-time parameters. These options are plugin-specific. Refer to the relevant APM/Plugin User's Guide for more information on specific backup options.
6. Click the Schedule tab and configure the scheduling options. You can define a daily, weekly, monthly or any other custom schedule. For details on defining a job schedule, refer to Scheduling Jobs on page 93. You can omit this step if you want to run the job immediately, which is the default schedule for all NetVault: Backup jobs.
7. Click the Target tab and configure the backup device and media options. For details on these options, refer to Backup Device and Media Options on page 79. You can omit this step if you want NetVault: Backup to automatically handle the device and media selection for the job.
8. Click the Advanced Options tab and configure the advanced backup options, such as backup retention period, custom events, and others. For details on these options, refer to Advanced Backup Options on page 81. You can omit this step if you do not want to set any advanced options for the job.
9. Enter a title for the job in the Job Title box at the top right corner of the Backup window.
10. Choose one of the following methods to save and/or schedule the job.

   a. Save the Definition without Scheduling the Job – To save the job definition without scheduling it, click Save on the toolbar. Alternatively, on the File menu, click Save.

      A saved job does not appear on the Status tab of the Jobs window and does not run unless you submit it (or use the Triggered scheduling option). You can load a saved job again in the Backup window, or open it
for editing from the Jobs tab of the Jobs window. For details on editing a job definition, refer to Viewing and/or Modifying a Backup Job on page 86.

b. **Schedule the Job** – To submit the job for scheduling click **Submit** on the toolbar. Alternatively, on the Accept menu, click **Submit Backup**.

5.5 **Backup Device and Media Options**

This section describes how to set up the target device and media options for a backup job. The information in this section is organized into the following topics:

- Selecting Target Device
- Configuring Backup Media Options

![Figure 5-1: The Target tab containing the device and media options](image-url)
5.5.1 Selecting Target Device

By default, NetVault: Backup uses any available device to perform backups. To override this setting, perform the following steps:

1. In the Backup window, click the Target tab.
2. To select the target device configure the following options under Device Options:
   - **Local Drives Only** – Select this check box to use only locally attached devices.
   - **Any Device** – Leave this option selected if you want NetVault: Backup to handle the device selection.
   - **Specify Device** – Select this option to use particular device(s). In the box below, all the devices added to the NetVault: Backup Server are listed. Since NetVault: Backup is configured to automatically select a backup device, all the devices in the list are selected by default. To exclude devices, perform the following:
     - To exclude a particular library, clear the check box for it. All the drives associated with the device are automatically removed when you remove the library.
     - To exclude a particular drive, clear the check box for it.

5.5.2 Configuring Backup Media Options

To configure the backup media options, perform the following steps:

1. In the Backup window, click the Target tab.
2. To select the target media, configure the following options under Media Options:
   - **Any Not in a Group** – Select this option to use media that are not associated with any group. This is the default media setting for a backup job.
   - **Any** – Select this option to use any media regardless of its group.
   - **MID** – Select this option to use a particular media. Then, select the media label in the list next to the option.
   - **Group Label** – Select this option to use media associated with a particular media group. Then, select the group label in the list next to the option.
3. To re-use media, select one of the following media re-use options:
   - **Any** – Select this option to target any media marked as re-usable.
   - **With Same Group Label as Target Media** – Select this option to target media associated with the group selected in the previous step.
4. To label a blank media, select **Automatically Label Blank Media** under **Media Options**. The media label is generated by combining the NetVault: Backup Server Name and Date. You can also configure NetVault: Backup to generate labels using the media barcodes. To assign the media barcodes as labels, refer to the *NetVault: Backup Configurator Guide*.

5. If you want to use only those media which have at least <n> MB of free space available before backup, select **Specify Minimum Space Required on Media Before Backup** under **General Options**. In the M Bytes list, enter or select the minimum free space required on the media.

6. To write-protect the media after backup, select **Protect Media from Further Writes After Backup** under **General Options**. To do this anytime later, refer to *Write-protecting Media* on page 133.

7. To store the saveset at the start for a tape, select **Ensure this Backup is the First on the Media** under **General Options**. The data can be restored quickly if the saveset is located at the start of a physical tape. The saveset is only written to new or blank media if you select this check box.

8. To set a timeout interval for the availability of a suitable backup media, select the **Media Request Timeout** check box under **General Options**. In the boxes next to this option, enter the timeout interval. The job is aborted if the backup tapes are not available within the specified interval. If you set this parameter to zero, the job will wait indefinitely for the media.

### 5.6 Advanced Backup Options

This sections describes how to configure the advanced options for a backup job. The information in this section is organized into the following topics:

- Configuring Retention Policy for a Backup
- Using Pre and Post Backup Scripts
- Setting up Custom Notification Events for a Job
- Verifying a Backup
- Enabling Network Compression for a Backup
5.6.1 Configuring Retention Policy for a Backup

The retention policy for a backup defines how long the information about the saveset is kept in the NVDB. The retention policy can be time-based or generation-based.

- **Time-based Backup Retention** – In a time-based retention policy, you specify the number of days, months or years you want to retain a backup. The time-based retention policy can be set for all backup types - full, incremental and differential.

- **Generation-based Backup Retention** – In a generation-based retention policy, you specify the number of full backups for the same set of data you want to retain. This method can only be used for full backup type.
When the retention period elapses, NetVault: Backup retires the saveset and deletes information about the saveset from the NVDB. The information about the savesets for incremental/differential backups is automatically discarded when the base full backup retires.

To configure the retention period for a saveset, perform the following steps:

1. In the Backup window, click the Advanced Options tab.
2. To set generation-based retention period, perform the following:
   a. Under Backup Life, select Discard After (x Full Backups).
   b. In the box, enter the retention period in number of days, weeks or years.
   Do not use this method for incremental and differential backup types.
3. To set time-based retention period, perform the following:
   a. Under Backup Life, select Discard After (x Days/Weeks/Years).
   b. In the box, enter the retention period in number of days, weeks or years.
   c. Select Days, Weeks or Years option next to the box.

Note: To set or change the retention period for an existing saveset, refer to Retiring Backup Savesets on page 133.

5.6.2 Using Pre and Post Backup Scripts

NetVault: Backup allows you to run your own scripts at the start and/or completion of a backup job. These scripts can be used to perform tasks, such as dismounting or shutting down a database before starting the job, or mounting/starting the database after the job completes. Consider the following points when using pre and post backup scripts:

- The script must be an executable file, for example, .bat on Windows, or .sh on Linux/UNIX.
- The scripts can contain run-time parameters. Use the NetVault: Backup environment variable NV_USER_ARG to access the values for these parameters in the script.
- You can also use other NetVault: Backup environment variables in the script. For a list of available environment variables, refer to NetVault: Backup Environment Variables on page 283.
- After creating the script, copy it to the ...
etvault\scripts folder on the target Client. You can also create sub-folders to organize the scripts.
- By default, NetVault: Backup provides the following two scripts that can be run as post backup scripts:
  - psmail – This script emails the job completion status to the addresses passed as user parameter.
Chapter 5
Backing up Data

84

- **psmail_logs** – This script emails the job completion status and the job logs to the addresses passed as user parameter.

- If a pre script fails, the backup job fails.
- If the pre script completes successfully while the backup job fails, the post script is still executed; the job status is reported as **Backup Failed**.
- If the pre script and the backup complete successfully while the post script fails, a script error is logged; the job status is reported as completed with warnings.

To run pre and post scripts for a backup job, perform the following steps:

1. In the **Backup** window, click the **Advanced Options** tab.
2. Under **Pre and Post Scripts**, select the following options:
   a. To run a script before the job starts, select **Use Pre Script**.
   b. To run a script after the job completes, select **Use Post Script**.
3. Enter the script file name in the box next to the selected check box. If the script resides in the ...
etvault\scripts folder, just enter the file name. Whereas, if it resides in a sub-folder within the ...
etvault\scripts folder, enter the relative path (e.g., if the script file myscript.bat resides in the folder ...
etvault\scripts\tst, enter \tst\myscript.bat in the box).
4. To pass run-time parameters, enter the value in the **User Parameter** box. The value must be valid and conform to its usage in the script. NetVault: Backup does not perform any validity checks on the user parameter.

5.6.3 Setting up Custom Notification Events for a Job

An event is an action or a condition that indicates an error, a problem or change in the component status. NetVault: Backup provides a set of pre-defined events for which you can set up a notification method to alert you when they occur and/or take a remedial action. For details on event types and notification methods, refer to **Setting up Event Notification** on page 151. In addition to the default events, NetVault: Backup supports the following custom events for a backup job:

- Backup completes successfully
- Backup completes with warnings
- Backup fails

The custom events defined for a job are added to the **Jobs – User Defined** event category in the **Global Notification** window, and can be raised for any backup job within the domain.

To set up a custom notification event for a backup job, perform the following steps:

1. In the **Backup** window, click the **Advanced Options** tab.
2. Under **Events**, select the following option(s):
5.6.4 Verifying a Backup

Backup verification essentially involves verifying the stream length written to the media and ascertaining no blocks were dropped. While the actual backup runs as phase 1, the backup verification runs as phase 2 of the backup job. By default, the verification phase runs on the NetVault: Backup Server. To run the verification phase locally or to configure another default Client, refer to the NetVault: Backup Configurator Guide. An error is logged if any dropped blocks are detected and the verification fails. You must run the job again if the backup verification fails. To run the verification phase for a backup job, perform the following steps:

1. In the Backup window, click the Advanced Options tab.
2. Under Verification, select the Verify After Backup check box.

5.6.5 Enabling Network Compression for a Backup

While transferring data over the network, you can compress the data to reduce the bandwidth usage. The data is first compressed on the target Client before it is transferred over the network. On the Client to which the target device is attached, the data is de-compressed before it is written to the media. To enable network compression for a backup job, perform the following steps:

1. In the Backup window, click the Advanced Options tab.
2. Under Compression, select the Network Compression check box.
5.7 Viewing and/or Modifying a Backup Job

You can use the following procedure to modify an existing job or create a new job from an existing job definition:

1. Use one of the following methods to load a backup job definition:
   a. **Load the Job Definition from the Backup Window** – This method can be used for both saved and scheduled jobs.
      1. Open the **Backup** window.
      2. Click **Load** on toolbar. Alternatively, on the **File** menu, click **Load**.
      3. In the **Load Backup Job** window, select the job and then click **OK**. This loads the job definition in the **Backup** window.
   b. **Load the Job Definition from the Jobs Tab of the Jobs Window** – This method can be used for both saved and scheduled jobs.
      1. Open the **Jobs** window (click **Job Management** on the toolbar or **Large Buttons** panel, or click **Job Management** on the **Operations** menu).
      2. Click the **Jobs** tab.
      3. Right-click the job and select **Edit/View Job**. This loads the job definition in the **Backup** window.
   c. **Load the Job Definition from the Status Tab of the Jobs Window** – This method can only be used for the scheduled jobs.
      1. Open the **Jobs** window (click **Job Management** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Job Management**).
      2. On the **Status** tab, right-click the job and select **Edit/View Job**. This loads the job definition in the **Backup** window.

2. Click the tab that contains the settings you want to change.
3. Select the **Modify** check box at the bottom.
4. Re-configure the options, as required. For information on any setting, refer to the relevant section in this guide or the APM/Plugin User’s Guide. To modify or customize a selection set, refer to *Using Selection Sets on page 103*. 
5. Choose one of the following methods to save and/or schedule the job.
   a. **Save the Definition without Scheduling the Job** – To save the job definition without scheduling it, click **Save** on the toolbar. Alternatively, on the **File** menu, click **Save**.
   b. **Schedule the Job** – To submit the job for scheduling click **Submit** on the toolbar. Alternatively, on the **Accept** menu, click **Submit Backup**.
5.8 Duplicating a Backup

A backup job can also include a duplication/migration phase, making it easier to perform disk-staging or copying data to off-site locations after the original job completes. When restoring a backup set that is duplicated, NetVault: Backup automatically selects the copy that is most convenient for the task.

To run a backup duplication/migration phase for a backup job, perform the following steps:

1. In the Backup window, click the Advanced Options tab.
2. Under Duplication, select the Duplicate check box.
3. By default, the duplication job always runs on the NetVault: Backup Server. If you want to run the job on a particular Client, select the Client in the Run Duplication On list. This feature can be used to perform local backups on SmartClients. To configure a Client globally for all duplication jobs, refer to the NetVault: Backup Configurator Guide.
4. In the Using Schedule Set list, select the set that defines the scheduling options for the duplication job. Select Immediate if you want to run the instance immediately after the original job completes. You cannot use the Repeating or Triggered schedule types for duplication phase. If a schedule set is not available, click Manage. Configure the scheduling options in the NetVault Schedule Management window and click Save As to create the schedule set. For details on schedule sets, refer to Using Selection Sets on page 103.
5. In the Using Target Set list, select the set that defines the target device and media options for the duplication job. The original saveset and the copy cannot be stored in the same media. If a target set is not available, click Manage. Select the scheduling options in the NetVault Schedule Management window and click Save As to create the schedule set. For details on target sets, refer to Using Selection Sets on page 103.
6. To migrate data, select the Migrate check box. After migrating the data, NetVault: Backup deletes the index for the original backup.
7. Select the Allow Streams to Share Media check box to convert multiple data streams into a sequential data stream and write it to the same media. This reduces the number of media items required for the copy.
8. Configure the retention period for the duplicate saveset as described below:
   - To use the original saveset’s retention period, select Use Originals Life.
   - To set a different retention period for the duplicate, select Discard After. In the box provided, enter the retention period in number of days, weeks or years. Select Days, Weeks or Years option next to the box. You can only set a time-based retention policy for the duplicate saveset.
9. Complete the job definition, and save or submit the job.

5.9 Archiving Data

Archiving is similar to backing up data, however, archives are standalone backups. Archives cannot be used as base for incremental or differential backups. You must select the full backup method with this option; data archived using incremental or differential methods cannot be restored. Only time-base retention period can be set for archives. You can choose the archive option when performing ad-hoc backups outside the regular backup schedule.

To archive data, perform the following steps:

1. Open the Backup window. Select the data and configure other options. For details, refer to Defining a Backup Job on page 78.
2. Click the Advanced Options tab and under Backup Life, select Archive.
3. Complete the job definition and save or submit the job.

5.10 Encrypting a Backup

For securing your data backups and protecting them from unauthorized access, NetVault: Backup provides an optional Encryption Plugin module. This plugin must be obtained separately and installed on the NetVault: Backup machines on which you want to perform encrypted backups and restores. A key is installed on the target Client, which is used to encrypt the data before it is transferred to the backup media. This section describes how to install and configure the Encryption Plugin. Once enabled, all backups targeting the Client will be encrypted.

5.10.1 Limitations of the Encryption Plugin

Before installing the Encryption Plugin on a Client, refer to the following notes to determine its suitability to your environment.

- The Encryption Plugin is not compatible with the following plugins:
  - Consolidate Incremental Backups Plugin
  - NetVault: Backup APM for Informix
- The backups performed using the NDMP and the SnapMirror To Tape plugins cannot be encrypted.
- The Encryption Plugin is not compatible with the Netware Thin Client Plugin. If encryption is enabled, the saveset header will report the backup as encrypted and ask for the key during restore. However, the saveset is not actually cipher-text, just clear-text.
- The VaultDR Server Plugin ignores the encryption settings as the Client is taken offline for backup.
The VaultDR Online Plugin cannot recover encrypted backups. If you are using this plugin, do not enable the encryption feature.

The VaultDR Plugin will create an unencrypted saveset even if you are using bitlocker technology to protect data. To protect VaultDR backups, you can choose a hard disk that supports its own encryption method and use a VTL created on the hard disk for VaultDR backups.

The Encryption Plugin cannot be used in the following clustered environments:
- Clustered File System
- SQL Server Failover Clusters
- Exchange Server Single Copy Cluster (SCC) or Failover Clusters
- Exchange Server Cluster Continuous Replication (CCR) environment

5.10.2 Installing the Encryption Plugin

To install the Encryption Plugin, perform the following steps:

1. Open the Client Management window on NetVault: Backup Server (click Client Management on the toolbar or Large Buttons panel, or on the Administration menu, click Client Management).
2. Locate the target Client under Clients. Right-click it, and then select Install Software.
3. In the browse window, navigate to the location of the .npk installation file for the Encryption Plugin (on the installation CD or the directory to which the file was downloaded from BakBone Software’s web site).
   Depending on the operating system, the filepath for this software may vary on the installation CD. Select the file named cst-x-x-x-x.npk (where x-x-x-x represents the platform and version number) and click Open.
4. This initiates the software installation.

To continue using the APM after the 45-day evaluation period expires, you must install the permanent license key. For installing the permanent license key, refer to Installing License Keys on page 31.

5.10.3 Configuring the Encryption Plugin

To configure the Encryption Plugin on a NetVault: Backup Client, perform the following steps:

1. Start the NetVault: Backup Configurator on the Client.
2. Click the Encryption tab.
3. Select the **Use Secure Encryption on this Client** check box on this tab.
4. In the **Encryption Key String New Password** box (on Windows)/**New String** box (on UNIX/Linux), enter the password/string that will serve as the Encryption Key for the Client.
5. Re-enter the password/string in the **Confirm Password** box (on Windows)/**Confirm String** box (on UNIX/Linux).
6. In the **Available Encryption Algorithms** list, select **CAST128**. If you select the blank option, the backups will not be encrypted.
7. Click **OK** to apply the settings.

**Important:** To restore encrypted backups, the key (password/string) used for backups must be available on the Client. If you lose or change the encryption key, the backup savesets will become unusable.

### 5.10.4 Disabling the Encryption Feature

To disable the encryption feature, perform the following steps:

2. Click the **Encryption** tab.
3. Clear the **Use Secure Encryption on this Client** check box on this tab.

### 5.11 Managing Backup Indexes

NetVault: Backup writes the backup index to both the media and the NVDB. The backup indexes stored in the NVDB allow you to quickly scan through the contents of a saveset without loading the media. However, these indexes increase the disk space consumed by the NVDB. To reduce the space used by the backup indexes, you can use the following NetVault: Backup features:

- Deleting Online Indexes
- Compressing Online Indexes

The following sections describe how to use these features.
5.11.1 Deleting Online Indexes

When defining a job, you can set an expiry date for the online indexes and delete them after a certain period. The data can still be restored by loading the indexes on the backup media.

**Note:** Deleting a backup index is not the same as setting the retention period for a saveset. When the retention period expires for a saveset, NetVault: Backup discards all information about it from the NVDB. Though you can scan the media containing an expired saveset, NVDB will load this index as a new backup index. Whereas, when you delete the online indexes, NetVault: Backup still retains some information about the saveset which allows it to quickly reload the saveset index from the backup media.

To set an expiry date for a backup index, perform the following steps:

1. When defining a backup job, click the **Advanced Options** tab.
2. Under **Backup Life**, select **Offline Index After**.
3. In the box provided, enter the number of days, weeks or years you want to retain the index in NVDB.
4. Select **Days**, **Weeks** or **Years** option, next to the box.

The savesets for which the online indexes have been deleted are represented by cross mark icons. To browse or restore a saveset with offline indexes, you must manually load the index. For details on loading a backup index from the backup media, refer to *Restoring from a Saveset with Offline Indexes* on page 125.

5.11.2 Compressing Online Indexes

The backup indexes can be compressed to reduce the space consumption. This can be done automatically or manually. For more information on automatically compressing the indexes, refer to the *NetVault: Backup Configurator Guide*.

To manually compress the backup indexes, perform the following steps:

1. Open the **Restore** window (click **Restore** on the toolbar or **Large Buttons** panel, or click **Restore** on the **Operations** menu).
2. On the **Selections** tab, open the Client that was the backup target.
3. Locate the plugin used to backup the data and perform one of the following steps:
   a. **Compress all Savesets Generated with the Plugin** – To compress all savesets generated with the plugin, right-click the plugin node and select **Compress**.
   b. **Compress Individual Saveset Generated with the Plugin** – To compress particular saveset(s) generated with the plugin, open the plugin
node (double-click this node, or right-click and select **Open**). Then, right-click the target saveset node and select **Compress**.

The savesets for which the indexes have been compressed are represented by an orange light icon. NetVault: Backup automatically uncompresses the index to a temporary location when you try to browse or restore such savesets. The temporary directory is deleted when the operation completes.
Chapter 6:

SCHEDULING JOBS

This chapter explains how to set up a job schedule. The information in this chapter is organized into the following topics:

- Job Schedule – An Overview
- Scheduling a Job to Run Immediately
- Scheduling a Job to Run on a Specific Date
- Scheduling Recurring Jobs
  - Scheduling a Job to Run Every n Hour(s)
  - Scheduling a Job to Run at the Same Time Every Day
  - Scheduling a Job to Run Every n Day(s), Week(s) or Month(s)
  - Scheduling a Job to Run on Specific Days of Week
  - Scheduling a Job to Run on Specific Days of Month
- Scheduling Non-recurring Jobs
  - Scheduling Non-recurring Jobs to Run on Any Day
  - Scheduling Non-recurring Jobs to Run on Specific Days of Week
  - Scheduling Non-recurring Jobs to Run on Specific Days of Month
- Triggering a Job from an External Script
- Scheduling Number of Retries
- Setting the Job Priority

6.1 Job Schedule – An Overview

A job schedule defines when and at what intervals a job runs. The job scheduling options are present on the Schedule tab of the Backup, Restore and Reporting Job Editor windows. You can use these options to accomplish the following:

- Run a job immediately
- Run a job on a specific date
- Establish a routine for recurring jobs
- Establish a routine for non-recurring jobs
- Trigger a Job from an External Script

The job schedules are stored in the Scheduler database. NetVault: Backup utilizes a Schedule Manager to manage the job schedules and queues. You can change the schedule manager properties via the NetVault: Backup Configurator. For more
6.2 Scheduling a Job to Run Immediately

To run a job immediately, select the Immediate option on the Schedule tab. This option is selected by default for any new job. If you do not set up a schedule or do not change the default settings, a job is queued to run when you submit it.

**Note:** You can also use the Run Now feature to run an existing job immediately. For details on the Run Now feature, refer to Starting a Job Instance Immediately on page 141.

6.3 Scheduling a Job to Run on a Specific Date

To schedule a job to run on a particular date, perform the following steps:

1. On the Schedule tab, select the Once schedule type.
2. In the Run At box under Scheduling Options, enter the start time for the job.
3. Under Method, select Specified Date.
4. In the box provided under Options, enter the date on which you want to run the job.

An instance of the job is scheduled to run immediately after the schedule becomes effective.

6.4 Scheduling Recurring Jobs

You can define a recurring schedule to run the regular jobs automatically at the specified intervals. NetVault: Backup allows you to define the following recurrence intervals:

- Every \(<n>\) hour(s)
- Same time every day
- Every \(<n>\) day(s), week(s) or month(s)
- Same day every week
- Specific days every week
- Specific days on specific weeks
- Same day every month
- Specific days every month

When you submit the job, the first instance of the job is scheduled, and when it starts at the set date and time, the next instance is scheduled. The scheduled job
instances are listed on the Status tab of the Jobs window. Such instances are highlighted in blue.

6.4.1 Scheduling a Job to Run Every n Hour(s)

To run a job every n hour(s), perform the following steps:

1. On the Schedule tab, select the Repeating schedule type.

2. In the Run At box under Scheduling Options, enter the start time for the job.

3. In the From box next to Run At, enter the start date for the schedule.

4. Under Method, select Every.

5. In the Every box under Options, enter the interval.

   For example, to run the job every 4 hours, enter 4 in the box.

6. Select the frequency as Hour(s).

The first instance of the job is scheduled to run at the set date and time. It runs immediately if the scheduled start time has passed. The subsequent instances are defined to run every n hour(s) when the current job starts.

Note: When you edit a job that is scheduled to run every n hour(s), re-configure the start time according to the current time. If you do not update the schedule, an instance of the job will run immediately when you submit it.

6.4.2 Scheduling a Job to Run at the Same Time Every Day

To set up a daily schedule for a job, perform the following steps:

1. On the Schedule tab, select the Repeating schedule type.

2. In the Run At box under Scheduling Options, enter the start time for the job.

3. In the From box next to Run At, enter the start date for the schedule.

4. Under Method, select Every Day.
The first instance of the job is scheduled to run at the set date and time. The subsequent instances are defined to run every day when the current job starts.

### 6.4.3 Scheduling a Job to Run Every n Day(s), Week(s) or Month(s)

To run a job at the same time every n day(s), week(s) or month(s), perform the following steps:

1. On the **Schedule** tab, select the **Repeating** schedule type.
2. In the **Run At** box under **Scheduling Options**, enter the start time for the job.
3. In the **From** box next to **Run At**, enter the start date for the schedule.
4. Under **Method**, select **Every**.
5. In the **Every** box under **Options**, enter the interval.
6. Select the frequency as **Day(s)**, **Week(s)** or **Month(s)**.

For example,

- To run a job on alternate days, enter 2 in step 5 and select **Day(s)** in step 6.
- To run a job every week, enter 1 in step 5 and select **Week(s)** in step 6.
- To run a job once in three months, enter 3 in step 5 and select **Month(s)** in step 6.

The first instance of the job is scheduled to run at the set date and time. The subsequent instances are defined to run every n days, weeks or months when the current job starts.

**Note:** When you edit a job that is scheduled to run every n day(s), week(s) or month(s), re-configure the start date according to the current date. If you do not update the schedule, an instance of the job will run immediately when you submit it.
6.4.4 Scheduling a Job to Run on Specific Days of Week

You can use this procedure to define the following types of schedules:

- Run a job on every Wednesday
- Run a job on every Wednesday and Friday
- Run a job on second and fourth Wednesday
- Run a job on second and fourth Wednesday and Friday

To establish a recurrence pattern based on the days of week, perform the following steps:

1. On the **Schedule** tab select the **Repeating** schedule type.
2. In the **Run At** box under **Scheduling Options**, enter the start time for the job.
3. In the box next to **Run At** box, enter the start date for the schedule.
4. Under **Method**, select **Days of Week**.
5. Under **Options**, select the day(s) on which you want to run the job.
6. Under **Weeks in Month**, select **All** to run the job on any week. To run the job on n\textsuperscript{th} week, choose **Selected** and clear the check boxes for the weeks on which you do not want to run the job.

For example,

- To run a job on every Wednesday, select **Wednesday** in step 5 and select **All** in step 6.
- To run a job on every Wednesday and Friday, select **Wednesday** and **Friday** in step 5 and select **All** in step 6.
- To run a job on second or fourth Wednesday, select **Wednesday** in step 5 and clear all check boxes except **Second** and **Fourth** in step 6.
To run a job on second and fourth Wednesday, select Wednesday and Friday in step 5 and clear all check boxes except Second and Fourth in step 6.

The first instance of the job is scheduled to run on the n-th Wednesday or Friday, whichever occurs first after the schedule becomes effective. The subsequent instances are defined to run when the current job starts.

6.4.5 Scheduling a Job to Run on Specific Days of Month

You can use this procedure to define the following types of schedules:
- Run a job on the fifth of every month
- Run a job on the first, tenth and twentieth of every month
- Run a job on the last day of every month

To establish a recurrence pattern based on the days of month, perform the following steps:

1. On the Schedule tab select the Once schedule type.
2. In the Run At box under Scheduling Options, enter the start time for the job.
3. In the box next to Run At box, enter the start date for the schedule.
4. Under Method, select Days of Month.
5. Under Options, select the day(s) on which you want to run the job. Select Last to run the job on the last day of every month.

For example,
- To run a job on the fifth of every month, select 5.
- To run a job on first, tenth and twentieth of every month, select 1, 10 and 20.
- To run a job on the last day of every month, select Last.
The first instance of the job is scheduled to run on the $n^{th}$ day of the month after the schedule becomes effective. The subsequent instances are defined to run when the current job starts.

6.5  **Scheduling Non-recurring Jobs**

Non-recurring jobs are those jobs which are performed infrequently or at irregular intervals. For such jobs it is difficult to establish a definite recurrence pattern. However, you may need to run them more than once. For such jobs, you can either define a new job each time, or re-create an instance from a previous instance (or existing job definition). You can choose to run a non-recurring job according to the following schedule:

- Any day
- Particular day(s) of week
- Particular day(s) of month

The first instance of the job is scheduled to run on the first selected day that occurs after the schedule becomes effective. To run the job again any time later as per the defined schedule, you must re-create the instance. NetVault: Backup does not automatically re-create an instance for the non-recurring jobs. For details on re-creating a job instance, refer to *Re-creating a Backup Job Instance on page 141*.

6.5.1  **Scheduling Non-recurring Jobs to Run on Any Day**

To schedule non-recurring jobs to run on any day, perform the following steps:

1. On the Schedule tab select the **Once** schedule type.
2. In the Run At box under Scheduling Options, enter the start time for the job.
3. In the box next to Run At box, enter the start date for the schedule.
4. Under Method, select **Any Day**.

The first instance of the job is scheduled to run immediately after the schedule becomes effective. To run the job again, you must re-create the instance manually. For details on re-creating a job instance, refer to *Re-creating a Backup Job Instance on page 141*.

6.5.2  **Scheduling Non-recurring Jobs to Run on Specific Days of Week**

You can use this procedure to define the following types of schedules:

- Run a job on Wednesday (any week)
- Run a job on Wednesday and/or Friday (any week)
- Run a job on second or fourth Wednesday
Chapter 6
Scheduling Jobs

- Run a job on second or fourth Wednesday and/or Friday

To schedule non-recurring jobs to run on specific days of week, perform the following steps:
1. On the Schedule tab select the Once schedule type.
2. In the Run At box under Scheduling Options, enter the start time for the job.
3. In the box next to Run At box, enter the start date for the schedule.
4. Under Method, select Days of Week.
5. Under Options, select the day(s) on which you want to run the job.
6. Under Weeks in Month, select All to run the job on any week. To run the job on n\textsuperscript{th} week, choose Selected and clear the check boxes for the weeks on which you do not want to run the job.

For example,
- To run a job on Wednesday (any week), select Wednesday in step 5 and select All in step 6.
- To run a job on Wednesday and/or Friday (any week), select Wednesday and Friday in step 5 and select All in step 6.
- To run a job on second and/or fourth Wednesday, select Wednesday in step 5 and clear all check boxes except Second and Fourth in step 6.
- To run a job on second and/or fourth Wednesday, select Wednesday and Friday in step 5 and clear all check boxes except Second and Fourth in step 6.

The first instance of the job is scheduled to run on the nth Wednesday or Friday, whichever occurs first after the schedule becomes effective. To run the job again, you must re-create the instance manually. For details on re-creating a job instance, refer to Re-creating a Backup Job Instance on page 141.

6.5.3 Scheduling Non-recurring Jobs to Run on Specific Days of Month

You can use this procedure to define the following types of schedules:
- Run a job on the fifth
- Run a job on first, tenth and/or twentieth
- Run a job on the last day of a month

To schedule non-recurring jobs to run on specific days of month, perform the following steps:
1. On the Schedule tab select the Once schedule type.
2. In the Run At box under Scheduling Options, enter the start time for the job.
3. In the box next to Run At box, enter the start date for the schedule.
4. Under **Method**, select **Days of Month**.

5. Under **Options**, select the day(s) on which you want to run the job.

For example,
- To run a job on the fifth, select 5.
- To run a job on first, tenth and/or twentieth, select 1, 10 and 20.
- To run a job on the last day of a month, select **Last**.

The first instance of the job is scheduled to run on the n\textsuperscript{th} day after the schedule becomes effective. To run the job again, you must re-create the instance manually.

For details on re-creating a job instance, refer to **Re-creating a Backup Job Instance** on page 141.

### 6.6 Triggering a Job from an External Script

You can schedule a job by executing a script that defines the conditions for the task. This script can be executed via the Pre and Post Scripts options on the **Advanced Options** tab or from the command line. To schedule a job when the script runs, include the following line in the script:

```
nvtrigger <trigger_name>
```

*nvtrigger* is a CLI command that resides in the `.../bin` directory (where `...` refers to the NetVault: Backup installation directory). If this path in not configured in the path variable, use the complete file path for the *nvtrigger* command, or include commands to change to the appropriate directory in the script.

Set up the job definition as described in the following steps:

1. On the **Schedule** tab, select the **Triggered** schedule type.
2. In the **Trigger Name** box under **Scheduling Options**, enter trigger name that was used with the *nvtrigger* command in the script file.

The job is not scheduled to run when you submit the job. It is scheduled only when the *nvtrigger* command runs during the script execution.

### 6.7 Scheduling Number of Retries

NetVault: Backup can be configured to automatically retry a job if an initial attempt fails. You can specify the number of times the retry attempt should be made and at what interval. Each retry attempt runs with the original job ID and instance number.

To schedule the retry attempts for a job, perform the following steps:

1. On the **Schedule** tab, select the **Job Retries** check box under **Job Options**.
2. In the list next to **Job Retries** check box, enter or select the number of retries. You can set a maximum of 10 tries for a job.
3. In the **Retry After** boxes, set the interval. By default, NetVault: Backup tries to run the job again immediately when a previous attempt fails.

### 6.8 Setting the Job Priority

NetVault: Backup allows you to set the priority for jobs, which is useful when simultaneous jobs are scheduled to run at the same time. By default, the priority for backup jobs is set to 30. You can override this by setting a new value for the **Job Priority** parameter under **Job Options** on the **Schedule** tab. Set this parameter to a lower value for higher priority and vice versa. A value of 1 indicates highest priority, while a value of 100 indicates lowest priority.
Chapter 7: USING SELECTION SETS

This chapter explains how to create and use selection sets. The information in this chapter is organized into the following topics:

- Selection Sets – An Overview
- Creating a Selection Set
- Applying a Selection Set
- Modifying a Selection Set
- Copying a Selection Set
- Deleting a Selection Set

7.1 Selection Sets – An Overview

Selection sets provide an efficient way to define jobs. They store job properties that can be quickly and easily applied to multiple jobs, and changed with minimum effort. With selection sets, you do not have to perform each task manually while defining a new job. You can use the settings saved when defining a previous job and apply them to the new job in a single step. For example, you can save the data selected for a full backup in a Backup Selection Set and use this set when defining an incremental or differential backup job. This eliminates the need to select each item manually for the new job while ensuring that the same set of files is backed up each time and no file is accidentally omitted.

Selection sets also make it easy to re-configure the parameters and apply new settings to multiple jobs. For example, you can change the day, date or time in a Schedule Set to automatically change the job execution schedule for multiple jobs, or target a new device for backups by changing the Target Set.

You can use the following types of selection sets in NetVault: Backup:

- **Backup Selection Set** – To save a backup selection list.
- **Backup Options Set** – To save backup options.
- **Schedule Set** – To save the job schedule for a backup, restore or report job.
- **Source Set** – To save the source drive options which specify where the source media for a data copy, backup consolidation or restore job is located.
- **Target Set** – To save the target drive(s) and/or media options for a backup job.
- **Advanced Options Set** – To save advanced backup or restore options.
- **Restore Selection Set** – To save a restore selection list.
These selection sets are generated from the corresponding tab on the Backup, Restore and Report Job Editor windows. You can also generate sets for policy jobs from the NetVault Policy Editor window.

**Note:** A policy-based backup job can only be defined using selection sets.

### 7.2 Creating a Selection Set

To create a selection set, perform the following steps:

1. Depending on the task you want to perform, refer to the following steps:
   a. **Create Selection Sets for Regular Backups** – Open the Backup window, if the window is not already open.
   b. **Create Selection Sets for Policy Backups** – If the the NetVault Policy Editor window is not open, perform the following steps:
      1. Open the Policy Management window (on the Administration menu, click Policy Management).
      3. In the NetVault Policy Editor window, click Manage Sets. This opens the NetVault Set Management window, which is similar to the Backup window.
   c. **Create Selection Sets for Restore Jobs** – Open the Restore window, if the window is not already open.
   d. **Create Schedule Sets for Report Jobs** – If the Report Job Editor window is not already open, perform the following steps:
      1. Open the Reports window.

2. Depending on the set type, click the corresponding tab.

3. Select the required data, or configure the required options. For more information on data selection and job options, refer to the relevant section in this guide or the APM/Plugin User’s Guide.

For example, to create a backup selection set, click the Backup Selections tab and select the data for backup. To create a schedule set, configure the scheduling options in the Backup, Restore or Report Job Editor windows.
4. Click **Save As** under **<Set Type> Set** at the bottom of the tab.
5. In the **Save <Set Type> Set** window, enter a unique name for the set in the box provided.
6. Click **OK**.

### 7.3 Applying a Selection Set

To apply a selection set, perform the following steps:

1. If the corresponding window is not already open, perform step 1 described in the section *Creating a Selection Set on page 104.*
2. Click the corresponding tab.
3. Click **Load** under **<Set Type> Set** at the bottom of the tab.
4. Select the required set in the **Load Backup Selection Set** list.
5. Click **OK**. This will apply the saved settings to the current job.

If you modify the selection set any time later, the new settings are applied automatically to all jobs that use the set.

### 7.4 Modifying a Selection Set

To modify a selection set, perform the following steps:

1. If the corresponding window is not already open, perform step 1 described in the section *Creating a Selection Set* on page 104.
2. Click the corresponding tab.
3. Click **Load** under `<Set Type> Set` at the bottom of the tab.
4. Select the required set in the **Load `<Set Type> Set** list.
5. Click **OK**. This will load the saved settings.
6. Click **Modify** under `<Set Type> Set` at the bottom of the tab.
7. In the **NetVault Warning** window, click **Modify**.
8. Update the settings as required.
9. Click **Save As** under `<Set Type> Set` at the bottom of the tab.
To overwrite the loaded set, click **OK** in the **Save <Set Type> Set** window. To save the configuration in a different selection set, enter a new name in the box and click **OK**.

### 7.5 Copying a Selection Set

To copy the selections to a new set, perform the following steps:

1. If the corresponding window is not already open, perform step 1 described in the section *Creating a Selection Set on page 104*.
2. Click the corresponding tab.
3. Click **Load** under **<Set Type> Set** at the bottom of the tab.
4. Select the required set in the **Load <Set Type> Set** list.
5. Click **OK**. This will load the saved settings.
6. Click **Modify** under **<Set Type> Set** at the bottom of the tab.
7. In the **NetVault Warning** window, click **Copy**.
8. Change the settings, if required.
9. Click **Save As** under **<Set Type> Set** at the bottom of the tab.
10. In the **Save <Set Type> Set** window, enter a new name for the set in the box provided.
11. Click **OK**.
7.6 Deleting a Selection Set

To delete a selection set, perform the following steps:

1. If the corresponding window is not already open, perform step 1 described in the section Creating a Selection Set on page 104.
2. Click the corresponding tab.
3. Click Load under <Set Type> Set at the bottom of the tab.
4. Select the required set in the Load <Set Type> Set list.
5. Click OK. This will load the saved settings.
6. Click Modify under <Set Type> Set at the bottom of the tab.
7. In the NetVault Warning window, click Modify.
8. Click Delete under <Set Type> Set at the bottom of the tab.
9. In the confirmation window, click Yes.
Chapter 8: Working with Backup Policies

This chapter describes how to set up and manage backup policies. The information in this chapter is organized into the following topics:

- Backup Policies – An Overview
- Defining a Backup Policy
  - Creating Selection Sets for Policy Backups
  - Defining Jobs for Policy Backups
  - Adding Clients and/or Client Groups for Policy Backups
  - Finalizing and Submitting the Policy
- Policy View Types
- Setting up Custom Notification Events for Policy Jobs
- Editing an Inactive Policy
- Editing an Active Policy
- Modifying an Individual Policy Job
- Modifying Client List for a Policy
- Acknowledging Errors/Warnings
- Deleting a Policy

8.1 Backup Policies – An Overview

Policies provide a convenient method for implementing backup strategies and managing backup jobs. A policy contains one or more job definitions. The job definitions are created using selection sets which specify what data is to be backed up, the target device and media, job schedule and other job attributes. You can apply these definitions to multiple Clients or Client Groups.

You can use policies in numerous scenarios, such as the following:

- Implement a full and incremental/differential backup strategy
- Rotate media (e.g., Grandfather-Father-Son rotation scheme)
- Backup multiple Clients in a single job
- Perform incremental backups and backup consolidation
- Run Data Copy jobs on multiple Clients
For example, you can create a policy to backup the C drive on multiple Windows Clients as follows:

1. Create a Client Group and add the target Clients as members of this group.
2. Create backup selection set, backup options set, schedule, target and advanced options set.
3. Create a policy and add a job using these selection sets.
4. Add the Client Group to the job.
   NetVault: Backup automatically creates and schedules a job to run on each Member Client.

This example describes how to implement a Grandfather, Father and Son media rotation policy for daily incremental backups, and weekly and monthly full backups:

1. Create a backup selection set.
2. Create backup options set for full and incremental backups.
3. Create schedule sets for full and incremental backups.
4. Create target sets depending on your media rotation strategies.
5. Create advanced options sets defining the backup retention period (and other advanced backup options).
6. Create a policy and define jobs for daily, weekly and monthly backups.

Policies are managed from the Policy Management window on the GUI. The following NetVault: Backup plugins support policy-based backups:

- File System Plugin
- Consolidate Incremental Backups Plugin
- Data Copy Plugin
- NetVault Databases Plugin
- Oracle APM

### 8.2 Defining a Backup Policy

The procedure for defining a backup policy can be broadly divided into the following steps:

- Creating Selection Sets for Policy Backups
- Defining Jobs for Policy Backups
- Adding Clients and/or Client Groups for Policy Backups
- Finalizing and Submitting the Policy

#### 8.2.1 Creating Selection Sets for Policy Backups

Policy backups are defined using selection sets. You can either use existing selection sets defined for other backups or create new sets for policy backups. For
details on creating a new selection set, refer to *Creating a Selection Set on page 104.*

### 8.2.2 Defining Jobs for Policy Backups

A policy can contain one or more jobs. To create these job definitions, perform the following steps:

1. If the NetVault Policy Editor window is not open, perform the following steps:
   a. Open the Policy Management window (on the Administration menu, click Policy Management).

2. In the **Policy** box, enter a name for the policy.
3. In the **Job Name** box, enter a title for the job.
4. To display only the selection sets created for the File System Plugin, select File System in the **Selection Set Filter**. By default, NetVault: Backup displays all selection sets.
5. In the **Selections** list, select the Backup Selections Set for the job.
6. In the **Selection Options** list, select the Backup Options Set for the job.
7. In the **Target** list, select the Target Set for the job.
8. In the **Schedule** list, select the Schedule Set for the job.
9. In the Advanced Options list, select the Advanced Options Set for the job. If the Advanced Options set contains pre and/or post script options, copy the script files to the …/netvault/scripts directory on each Client included in the policy backup.

10. To schedule the job when you save the policy, leave the Job Active check box selected. To save the policy without scheduling the job, clear the Job Active check box.

11. To add another job, click Next Job. Otherwise, go to step 14.

12. In the NetVault - Information window, click Yes.

13. Perform steps 3–11.

14. Add the Clients and/or Client Groups as described in the following section.

8.2.3 Adding Clients and/or Client Groups for Policy Backups

Before starting this step, we recommend that you create the necessary Client Groups to implement the policy on multiple Clients. For details on creating a Client Group, refer to Creating a Client Group on page 32. To add Clients/Client Groups for policy backups, perform the following steps:

1. In the NetVault Policy Editor window, click Add Clients on the toolbar. Alternatively, on the Policy menu, click Add/Remove Clients. This opens the NetVault Policy Clients Manager window.

2. Under Available, you will find a list of NetVault: Backup Clients and Client Groups. To add a Client or Client Group, click the check box for it, and then click the Left Arrow. The selected Clients and Client Groups are now listed under Selected.
3. To remove an added Client or Client Group, click the check box for it under Selected, and then click the Right Arrow.

4. Click OK to complete the step.

### 8.2.4 Finalizing and Submitting the Policy

To complete and submit the policy definition, perform the following steps:

1. To raise any events for failed jobs or jobs completed with warnings, refer to Setting up Custom Notification Events for Policy Jobs on page 114.

2. To save the policy, click Save Policy on the toolbar. Alternatively, click Save Policy on the File menu.

When you save a policy, all jobs that have the Job Active check box selected are scheduled to run on the selected Clients/Client Groups.

### 8.3 Policy View Types

NetVault: Backup provides the following three methods to view Policy Jobs in the Policy Management window:

- **Domain View** – This view organizes the policies under the NetVault: Backup Server, Client Groups and individual clients.

- **Policy View** – This view classifies the jobs into Policy Jobs and Regular Jobs.

- **Client View** – This view categorizes the regular and policy jobs according to Clients on which they are implemented.
Chapter 8
Working with Backup Policies

The default view type is **Domain View**. To change it, select the required method in the **View Type** list.

To view the policy details navigate through the Policy Tree under **Policies**. To open any node in this tree, double-click it, or right-click and select **Open**. To the left of each node, a status indicator displays the status of the completed jobs.

NetVault: Backup uses the following color-codes to display the job status:

- **Green** – This icon indicates that the job(s) have completed successfully.
- **Orange** – This icon indicates that the job(s) have completed with warnings.
- **Red** – This icon indicates that the job(s) have failed.

The purpose of status indicators is to help administrators identify a failed job or a job completed with warnings, and take corrective action. At the parent node level, these indicators provide the overall status information. Thus, even if one job fails while the remaining jobs are successful, a red icon accompanies the parent node to indicate a problem. While the jobs are active, the parent and child nodes under **Policies** are displayed in blue text. The parent node in each view displays the total number of jobs that are active (e.g., 2 Active Jobs). The list of scheduled and active jobs is displayed under **Details**.

Each view allows you to perform similar functions; however, certain functions like deleting a schedule or quiescing a policy can only be performed from the **Policy View**.

### 8.4 Setting up Custom Notification Events for Policy Jobs

To raise custom notification event when a policy job fails or completes with warnings, perform the following steps:

1. Open the **Policy Events** window as described in the following steps:
   a. For a new job, click **Setup Events** on the toolbar for the **NetVault Policy Editor** window. Alternatively, click **Events** on the **Policy** menu.
   b. For an existing policy, perform the following steps:
      1. Open the **Policy Management** window.
      2. Choose any view.
      3. Open the nodes further to display the target policy node.
      4. Right-click this node and select **Policy Events**.
2. To raise an event when a job completes with warnings, select the **Raise Event if Policy has Warnings** check box.
3. To raise an event when a job fails, select the **Raise Event if Policy Fails** check box.
4. In the list next to the selected check box, select the custom event. If no custom events are defined, the list will be empty. To define a new event, enter the event name in the box.

5. To set the notification method for a new event, first save the policy. Click **Save Policy** on toolbar, or on the **File** menu, click **Save Policy**. For details on setting a global notification method, refer to *Setting up a Global Notification Method* on page 153, and for details on setting a user-specific notification method, refer to *Setting a Notification Profile for a User* on page 165.

### 8.5 Editing an Inactive Policy

A policy for which no jobs are currently active is termed as an Inactive Policy. To edit an inactive policy, perform the following steps:

1. Load the policy definition in the **NetVault Policy Editor** window using one of the following methods:
   a. **Method 1**
      1. Open the **Policy Management** window.
      2. On the **Edit** menu, click **Edit Policy**
      3. In the **Load Policy** window, select the target policy and click **OK**.
   b. **Method 2**
      1. Open the **Policy Management** window.
      2. Choose any view.
      3. Open the nodes further to display the target policy node.
      4. Right-click this node and select **Edit**.

2. For details on adding a new job, refer to *Defining Jobs for Policy Backups* on page 111.

3. To delete a job, perform the following steps:
   a. Load the job definition in the **NetVault Policy Editor** window. Use the **Next/Previous** buttons to navigate.
   b. Click **Delete Job** on the toolbar. Alternatively, on **Policy** menu, click **Delete Job**.

4. To edit a job definition, perform the following steps:
   a. Load the job definition in the **NetVault Policy Editor** window. Use the **Next/Previous** buttons to navigate.
   b. Click **Manage Sets** on the toolbar to modify the selection set. For details on modifying a selection, refer to *Modifying a Selection Set* on page 106.
      To apply a different selection set, choose the set in the Selection Set list.
5. For details on adding or removing a Client/Client Group, refer to Adding Clients and/or Client Groups for Policy Backups on page 112.

6. For details on setting up custom notification events, refer to Setting up Custom Notification Events for Policy Jobs on page 114.

7. To commit the changes, click Save Policy on the toolbar. Alternatively, click Save Policy on the File menu.

   To create a copy of the policy, enter a new name for the policy in the Policy box, and on the File menu, click Save Policy As.

8.6 Editing an Active Policy

A policy for which the jobs are currently running is termed as an Active Policy. To edit an active policy you must first quiesce the policy. A quiesced state is a temporary inactive/disabled state. To quiesce a policy, run the Quiesce command. While quiescing is in progress, NetVault: Backup performs the following tasks:

- Deletes all the scheduled instances for the policy jobs
- Completes the job(s) that are in progress
- Completes phase 2 (e.g., a Duplication job) for the job(s) in progress

Though cloning is supported during this operation, the actual policy can be modified only when the operation completes and the policy is in a quiesced state.

To modify an active policy, perform the following steps:

1. Open the Policy Management window.
2. In the View list, select Policy View.
3. Open the nodes further to display the target policy node.
4. Right-click the node and select Quiesce. While the operation is in progress, the text Quiescing is displayed beside the policy name.
5. NetVault: Backup deletes the scheduled instances, and completes the phase 1 and phase 2 for the active job(s). When these tasks complete, NetVault: Backup places the policy in a quiesced state. This state is indicated by the text Quiesce Complete next to the policy name. When the quiescing is completed, you can right-click the policy and select Edit.
6. To modify the policy, perform steps 2–7 described in the section Editing an Inactive Policy on page 115.
8.7 Modifying an Individual Policy Job

NetVault: Backup provides another simpler method to modify a policy job that is currently not active. To accomplish this task, perform the following steps:

1. Open the Policy Management window.
2. In the View list, select Policy View.
3. Open the nodes further to display the target policy node.
4. Open the policy node. Then, open the Job Definition node and the target job. The selection sets used to define the job are displayed under this node.
5. To edit a selection set, right-click the set name and select Manage Sets.
6. This opens the NetVault Set Management window. Make the required changes and save the set. For details on modifying a selection set, refer to Modifying a Selection Set on page 106.

The scheduled instance for the job is modified when you save the set.

8.8 Modifying Client List for a Policy

To add or remove Clients/Client Groups for a policy, you can also use the following method.

1. Open the Policy Management window.
2. In the View list, select Policy View.
3. Open the nodes further to display the target policy node.
4. Right-click the node and select Implement on Clients. This opens the NetVault Policy Clients Manager window.
5. To add a Client or Client Group, click the check box for it, and then click the Left Arrow. The selected Clients and Client Groups are now listed under Selected.
6. To remove an added Client or Client Group, click the check box for it under Selected, and then click the Right Arrow.
7. To save the changes, click OK.

8.9 Acknowledging Errors/Warnings

The purpose of the status indicators is to help administrators identify a failed job or a job completed with warnings, and take corrective action. When this is accomplished you can acknowledge the error/warning to clear them. To clear the errors/warnings, perform the following steps:

1. Right-click the corresponding policy node and select Acknowledge Errors/ Acknowledge Warnings. To acknowledge errors within multiple policies,
right-click the parent node. For example, right-click the Policies node in the Policy View and select Acknowledge Errors/Acknowledge Warnings.

2. NetVault: Backup clears the errors/warnings and replaces the red/orange status indicator with a green status indicator.

8.10 Deleting a Policy

You can use the procedure in this section only if the policy has no active jobs or the policy is in a quiesced state. For details on quiescing a policy, refer Editing an Active Policy on page 116. To delete a policy, perform the following steps:

1. Open the Policy Management window.
2. In the View list, select Policy View.
3. Open the nodes further to display the target policy node.
4. Right-click the node and select Delete.
5. In the confirmation window, click Yes.
Chapter 9: RESTORING DATA

This chapter describes how to restore data with NetVault: Backup. The information in this chapter is organized into the following topics:

- Restore – An Overview
- Restoring Data with NetVault: Backup Plugins
- Defining a Restore Job
- Configuring Source Device for Restore
- Configuring Advanced Restore Options
  - Using Pre and Post Restore Scripts
  - Enabling Network Compression for a Restore
  - Restoring Data from the Latest Saveset
- Restoring Data to an Alternate Server
- Restoring from a Saveset with Offline Indexes
- Restoring from a Saveset with Compressed Indexes
- Restoring Encrypted Savesets
- Changing the Saveset Sort Order
- Filtering Savesets
- Searching for Data Items
- Viewing Media List for a Saveset
- Additional Notes

9.1 Restore – An Overview

Restore refers to reconstructing all or part of a system from a backup. A restore can be performed for the following reasons:

- To recover lost data (e.g., a file that was accidentally deleted)
- To recover database/files which have been corrupted
- To copy or move data to another database/directory
- To recover to a previous point-in-time, if some operation goes wrong
- To migrate data when upgrading to a new system
- To copy or move data to a test/production server
- To recover from media failure, O/S corruption, loss of physical system
The NetVault: Backup plugins interface with the native APIs to restore and recover application-specific data from the backup savesets. The restore methods and options provided by these plugins vary depending on the application type. In general, NetVault: Backup offers the following restore features:

- Complete or granular restores
- Disaster recovery
- Restores to alternate location
- Restores to alternate server

### 9.2 Restoring Data with NetVault: Backup Plugins

Restores are performed from the Restore window. You can use the GUI running on the NetVault: Backup Server or any Client to define and submit the restore job.

A restore job definition generally consists of the following components:

- Selection list
- Plugin-specific restore options
- Source device options which specify where the source media is located
- Target Client name, when restoring to an alternate server
- Job schedule
- Advanced restore options

Each component contains a set of attributes which can be configured manually or using a selection set. For details on selection sets, refer to *Using Selection Sets on page 103.*

Each job has a Job ID and a title. The Job ID is a sequential number which is auto-generated. The job title is user-defined and allows you to easily identify the job when monitoring its progress or viewing the job logs.

### 9.3 Defining a Restore Job

To define a data restore job, perform the following steps:

1. Open the Restore window (click Restore on the toolbar or Large Buttons panel, or on the Operations menu, click Restore).
2. On the Selections tab, open the Client that was the source of the backup.
   
   To open any node in the Selections tab, you can do either of the following:
   - Double-click the node
   - Right-click the node and select Open
3. Select the plugin that was used to backup the data.
4. Open the target saveset and then select the data you want to restore. The selection tree varies for different plugins. Refer to the relevant APM/Plugin User's Guide for more information on selecting data for a restore.

**Note:** For savesets generated using a backup selection set, you can restore the latest backup without actually selecting the corresponding saveset. For details, refer to *Restoring Data from the Latest Saveset* on page 124.

5. Click the **Restore Options** tab and configure the run-time parameters for the job. These options are plugin-specific. Refer to the relevant APM/Plugin User's Guide for more information on specific restore options.

6. Click the **Source** tab and configure the source device options. For details on configuring these options, refer to *Configuring Source Device for Restore* on page 121. You can omit this step if you want NetVault: Backup to automatically handle the device selection.

7. Click the **Schedule** tab and configure the scheduling options. For details on defining a job schedule, refer to *Scheduling Jobs* on page 93. You can omit this step if you want to run the job immediately, which is the default schedule for all NetVault: Backup jobs.

8. Click the **Advanced Options** tab and configure the advanced options for the job. For details on configuring these options, refer to *Configuring Advanced Restore Options* on page 122. You can omit this step if you do not want to set any advanced options.

9. Enter a title for the job in the **Job Title** box at the top right corner of the **Restore** window.

10. Click **Submit** on the toolbar, or on the **Accept** menu, click **Submit Restore**.

### 9.4 Configuring Source Device for Restore

NetVault: Backup allows you to select the source device where the backup is stored. You can use this option to enforce local data transfers on a SmartClient. This option is also useful if a backup was performed to a VTL and then duplicated to a tape. It can be used to restore the data from the VTL to speed up the restore or if the tape has already been moved off-site. To specify the source device for a restore, perform the following steps:

1. In the **Restore** window, click the **Source** tab.
2. To use only locally attached devices, select the **Local Drives Only** under **Device Options**.
3. To use any device added to the NetVault: Backup Server, select **Any Device** under **Device Options**.
4. To use particular device(s), select **Specify Device** under **Device Options**.
In the box below, all the devices added to the NetVault: Backup Server are listed. Since NetVault: Backup is configured to automatically select a backup device, all the devices in the list are selected by default. To exclude devices, perform the following:

- To exclude a particular library, clear the check box for it. All the drives associated with the device are automatically removed when you remove the library.
- To exclude a particular drive, clear the check box for it.

### 9.5 Configuring Advanced Restore Options

This section describes how to configure the advanced options for a restore job. The information in this section is organized into the following topics:

- Using Pre and Post Restore Scripts
- Enabling Network Compression for a Restore
- Restoring Data from the Latest Saveset
9.5.1 Using Pre and Post Restore Scripts

NetVault: Backup provides the pre and post restore scripts feature, which allows you to run your own scripts at the start and/or completion of a restore job. These scripts can be used to perform tasks, such as dismounting or shutting down a database before starting the job, or mounting/starting the database after the job completes. Consider the following points when using the pre and post restore scripts feature:

- The script must be an executable file, for example, .bat on Windows, or .sh on Linux/UNIX.
- The scripts can contain run-time parameters. Use the NetVault: Backup environment variable `NV_USER_ARG` to access the values for these parameters in the script.
- You can also use other NetVault: Backup environment variables in the script. For details on environment variables, refer to NetVault: Backup Environment Variables on page 283.
- After creating the script, copy it to the `...\netvault\scripts` folder on the target Client. You can also create sub-folders to organize the scripts.
- By default, NetVault: Backup provides the following two scripts that can be run as post restore scripts:
Chapter 9
Restoring Data

- psmail – This script emails the job completion status to the addresses passed as user parameter.
- psmail_logs – This script emails the job completion status and the job logs to the addresses passed as user parameter.

- If a pre script fails, the restore job fails.
- If the pre script completes successfully while the restore job fails, the post script is still executed; the job status is reported as Restore Failed.
- If the pre script and the restore complete successfully while the post script fails, a script error is logged; the job status is reported as completed with warnings.

To run pre and post scripts for a restore job, perform the following steps:

1. In the Restore window, click the Advanced Options tab.
2. Under Pre and Post Scripts, select the following options:
   a. To run a script before the job starts, select Use Pre Script.
   b. To run a script after the job completes, select Use Post Script.
3. Enter the script file name in the box next to the selected check box. If the script resides in the ...
etvault\scripts folder, just enter the file name. Whereas, if it resides in a sub-folder within the ...
etvault\scripts folder, enter the relative path (e.g., if the script file myscript.bat resides in the folder ...
etvault\scripts\tst, enter \tst\myscript.bat in the box).
4. To pass run-time parameters, enter the value in the User Parameter box. The value must be valid and conform to its usage in the script. NetVault: Backup does not perform any validity checks on the user parameter.

9.5.2 Enabling Network Compression for a Restore

While transferring data over the network, you can compress the data to reduce the bandwidth usage. Data is first compressed on the Client to which the source device is attached before it is transferred over the network. On the target Client, the data is de-compressed before it is restored. To enable network compression for a restore job, perform the following steps:

1. In the Restore window, click the Advanced Options tab.
2. Under Compression, select the Network Compression check box.

9.5.3 Restoring Data from the Latest Saveset

By default, the data is restored to the state it was at the time the selected saveset was generated. You can override this default setting and restore the latest backup for the given selection set. To accomplish this, perform the following steps:

1. On the Selections tab, select any saveset generated using a particular backup selection set.
2. Click the **Advanced Options** tab.
3. Under **Restore type**, select **Restore from latest Backup**.

### 9.6 Restoring Data to an Alternate Server

Restoration to an alternate server is typically required when you are migrating data to a new system or copying data to a production/test server. Though all NetVault: Backup plugins support this feature, the actual implementation varies for each. Refer to the relevant APM/Plugin User’s Guide for the complete procedure.

### 9.7 Restoring from a Saveset with Offline Indexes

To browse or restore from a saveset with offline indexes, you must first re-load the indexes temporarily. To accomplish this, perform the following steps:

1. Open the **Restore** window (click **Restore** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Restore**).
2. On the **Selections** tab, open the Client that was the source of the backup.
3. Open the plugin that was used to backup the data.
4. Right-click the target saveset and select **Load Index**.
5. In the **Days to Keep Index** box, enter the number of days you want to retain the index in the NVDB.

![Figure 9-3: The load index window](image)

6. Click **OK**.
7. Continue from step 4 of the procedure *Defining a Restore Job* on page 120 to define and submit a restore job.

### 9.8 Restoring from a Saveset with Compressed Indexes

NetVault: Backup automatically de-compresses the index when you open a saveset with compressed indexes. The index is copied to a temporary directory which is automatically deleted when the operation completes.
9.9 **Restoring Encrypted Savesets**

No additional steps are required to restore an encrypted backup. However, before you start the restore procedure, ensure that the Encryption Plugin is installed and configured on the target Client. For details, refer to *Installing the Encryption Plugin on page 89* and *Configuring the Encryption Plugin on page 89*.

9.10 **Changing the Saveset Sort Order**

By default, the savesets are sorted by the plugin used to generate them. The *Selection Method* list on the *Restore Selections* tab provides two additional sort criteria which can be used change the order in which the savesets are listed. To change the sort order for the savesets, perform the following steps:

1. Click the *Restore Selections* tab.
2. To sort the savesets by the Selection Set used for the backup, select *Backup Set* in the *Selection Method* list.
3. To sort the savesets by the Job Title, select *Job* in the *Selection Method* list.
4. To change the sort order back to plugin, select *Plugin* in the *Selection Method* list.

9.11 **Filtering Savesets**

To filter the savesets displayed on the *Restore Selections* tab, perform the following steps:

1. Click the *Restore Selections* tab.
2. Under *Filter Options*, set the filter criteria as described below:
   - **By Date Range** – To list the savesets generated during a given period, select the *By Date Range* check box. Additionally, set the *From* and *To* dates in the boxes provided.
   - **Show On-line Status** – To list the savesets stored on the currently online media, select the *Show On-line Status* check box.
3. Click *Apply Filter* to set the filter.

9.12 **Searching for Data Items**

The *Search* feature on the *Restore Selections* tab allows you to find a particular file or data item inside a saveset without opening it or browsing through contents. You can use either the entity name or a regular expression to find the entities. Typically, you can perform a search at the plugin level to find which saveset contains the entity, or at the saveset level to determine whether the entity is included in a particular saveset. However, NetVault: Backup allows you to use this feature at any level in the restore selections tree.
To use the Search feature, perform the following steps:

1. Open the Restore window (click Restore on the toolbar or Large Buttons panel, or on the Operations menu, click Restore).
2. On the Selections tab, right-click the Client and select Search. If you want to perform a search at the plugin level or saveset level, open the nodes further. Right-click the plugin node or the target saveset node, and select Search. This opens the Restore Search window.

3. Enter the search string in the box provided.
4. To search for entities using regular expression, select the Regular Expression Search check box.
5. To match case during search, select Case Sensitive check box.

### 9.13 Viewing Media List for a Saveset

To view the media list for a saveset, perform the following steps:

1. Open the Restore window (click Restore on the toolbar or Large Buttons panel, or on the Operations menu, click Restore).
2. On the Selections tab, open the Client that was the source of the backup.
3. Open the plugin that was used to backup the data.
4. Right-click the target saveset and select Media List.
5. In the <Job Title> (Saveset #) window the following details are displayed: the total backup size, the list of media used to backup data, the total bytes written to the media, the media status, details of the media containing the backup index.
6. Click OK to close the window.
9.14 Additional Notes

Refer to the following notes when restoring data with NetVault: Backup.

- Attempting to restore an index larger than 2GB may result in a failed restore on Itanium platforms. If a restore fails with the error message Failed when sorting items to restore, you will need to manually increase the stack size by using one of the following methods:
  
  On standard Unix platforms, this can be resolved by editing the ulimit (-s option) in the CLI Terminal to increase the stack size. Open a CLI Terminal and utilize the following commands:
  
  - `ulimit -a` provides all the settings for the environment
  - `ulimit -s` provides the current stack size setting
  - `ulimit -s unlimited` sets an unlimited stack size
  - `ulimit -s n` (where n is the desired value) sets stack size to n.
  - `man ulimit` provides for more details on the ulimit command
  
  After modification, issue the `ulimit -a` command to ensure that the setting has been changed.

  On a HP-UX Itanium platform the bash command `kmtune` or `kctune` (depending on the operating system) can be used to access to the kernel stack size information. The stack vars are `maxssiz` for 32-bit applications and `maxssiz_64bit` for 64-bit applications. Open a CLI Terminal and utilize the following commands
  
  - `kmtune -l -q maxssiz` provides the verbose setting information for a 32-bit application
  - `kmtune -l -q maxssiz_64bit` provides the verbose setting information for a 64-bit application
  - `kmtune -u -s maxssiz=n` (where n is the desired value) sets the new stack size to n for a 32-bit application
  - `kmtune -u -s maxssiz_64bit=n` (where n is the desired value) sets the new stack size to n for a 64-bit application
  - `kmtune -u -s maxssiz+n` (where n is the desired value) increases the stack size by n for a 32-bit application
  - `kmtune -u -s maxssiz_64bit +n` (where n is the desired value) increases the stack size by n for a 64-bit application

  Note that all instances of `kmtune` should be replaced by `kctune` depending on the operating system. Enter the man command in a CLI Terminal for more details.
Chapter 10: MANAGING MEDIA

This chapter describes how to perform the media administration tasks. The information in this chapter is organized into the following topics:

- Backup Media – An Overview
- Labeling and Grouping Media
- Performing Bulk Media Labeling and/or Grouping
- Viewing Media Status
- Write-protecting Media
- Retiring Backup Savesets
- Marking Media for Re-use
- Scanning Foreign Media
- Tracking Off-site Location
- Marking Media as Unusable
- Deleting a Backup Index from the NVDB
- Blanking a Media
- Performing Bulk Media Blanking

10.1 Backup Media – An Overview

Each backup media must have an on-tape label for identification. A piece of media, whether a tape cartridge or a VTL can have one of the following labels:

- Media barcode
- NetVault: Backup Server name and date
- A user defined string

NetVault: Backup provides the following different ways to label a blank media:

- Automatically label blank media during backup
- Label individual media before it is used
- Label all media in a library in bulk
- Set barcode as media labels by default

To globally set barcode as media labels, start the NetVault: Backup Configurator. On the Media Manager tab, select the Use Barcodes as Labels check box.
To target the same set of tapes for backup, you can create media groups. The media groups can be used in conjunction with the re-use feature to rotate the media for full and incremental backups according to your media rotation policy.

Additionally, you can use NetVault: Backup’s media management tools to write-protect media, eliminate unusable media, and track the off-site location for a media.

### 10.2 Labeling and Grouping Media

To label an individual media and/or add it to a group, perform the following steps:

1. Open the **Device Management** window. On the **Devices** tab right-click the drive/slot that contains the media, and select **Properties**. This opens the **Media Properties** window.

![Media Properties window](image)

2. NetVault: Backup provides two default labels for a media – the Media Barcode, and a string combining the NetVault: Backup Server Name and Date. To assign one of these as the media label, select it in the **Media Label** list. To assign a user defined label, enter the string in the box.

3. To add the media to a group, select the group label in the **Group Label** list. To create a new group and add the media to it, enter the group label in the box.

4. To set a non-default tape format, select MTF (on Windows) or CPIO (on Linux/UNIX) in the **Tape Format** list.

5. Click **OK**.
10.3 Performing Bulk Media Labeling and/or Grouping

To bulk label and/or group all the media in a library, perform the following steps:

1. Open the Device Management window. On the Devices tab, right-click the library that contains the target media, and select Bulk Label. This opens the Bulk Label Media window.

2. Under Type of Media to Label, select the media types to label from the following categories:
   - Blank – Select this check box to label any blank, non-labeled media in a device that is currently accessible to the NetVault: Backup Server.
   - Other – Select this check box to bulk label media types that do not belong to any category listed here.
   - NetVault 5 – Select this check box to label any media that was used to backup data with NetVault: Backup v5.x.
   - Reusable – Select this check box to label media marked as reusable.

3. Under Type of Label, select one of the following:
   - Barcode – Select this option to use the barcode as media label.
   - Machine and Date – Select this option to use NetVault: Backup Server name and date as label.
   - User – For a user-defined label, select User and enter the following details:
Label – Enter the string to be used as media label. NetVault: Backup does not support a % character in the string.

Seed – In addition to the string, a sequential number is also added to the media label for unique identification. Enter the starting number for the sequence in the Seed box. The number will be incremented for each media. If the box is left blank, NetVault: Backup will start numbering the media from 1. The Seed does not apply to VTL media.

4. To add the media to a group, select the group label in the Group Label list or enter the name for a new group in the box.

5. Select the media for labeling. Use Shift+Click/Ctrl+Click to select multiple media in the list. To label all media in the list, select the All Media in List check box.

6. In the Enter ‘LABEL’ to Confirm Request box, enter LABEL (case insensitive) to confirm bulk labeling.

7. Click OK.

10.4 Viewing Media Status

To view the media status, perform the following steps:

1. Open the Media Management window. The currently online media are listed under Media. The online status for the media is indicated with a green light icon.

2. To view the details, double-click the media, or right-click and select Open.

3. Under Details, click the corresponding tab to view the following information:
   - The Details tab displays the media label, group label, off-site location for the media, space used, media type, barcode and the retirement date.
   - The Statistics tab displays the space left, size of the data stored, total segments, and the last read and write dates for the media.
   - The History tab displays the re-use statistics, read and write errors, and the total amount of data read and written. In case of any read/write errors, investigate the cause. If the media is damaged, mark it as unusable to prevent further writes.
   - The Library tab displays the library name, the current media location (the drive/slot number), and the original home location (drive/slot) for the media.

4. To view the details of a saveset contained in the media, double-click it, or right-click and select Status.

5. Under Details, click the corresponding tab to view the following information:
   - The Backup tab displays the job title, NetVault: Backup Server and Client names, plugin name, backup selection set, date, is an incremental
saveset, is an archive, and the number of generations left for the saveset expiration.

- The Segment n tab displays the length of the segment, offset, segment position, block size, total time required to complete the backup, total time required to transfer the data to segment n, user ID, and the backup retirement date.

- The Index tab provides the on-tape index information. The details include, the index size, the slot/drive on which the media resides, the user ID, and the retirement date.

### 10.5 Write-protecting Media

To prevent further writes on a media, perform the following steps:

1. Open the Device Management window. On the Devices tab, right-click the drive/slot that contains the media, and select Properties. You can also perform this task via the Media Management window. Open the Media Management window. Under Media, right-click the target media and select Properties.

2. In the Media Properties window, select the Read Only check box.

3. Click OK.

You can also select the Protect Media from Further Writes after Backup check box on the Target tab on the Backup window when defining a backup job to write-protect the media.

### 10.6 Retiring Backup Savesets

You can set a time-based or generation-based retirement date for a saveset. NetVault: Backup deletes the information about the saveset from the NVDB when the period elapses. To set the retirement date, perform the following steps:

1. Open the Media Management window.

2. Under Media, open the media that contains the target saveset (double-click the media, or right-click and select Open).

3. Right-click the saveset, and select Change Expiry. This opens the Backup Expiry window.
4. To set a time-based retirement date, perform the following steps:
   a. Select **Change Retirement Date**.
   b. Select **On**.
   c. Enter the date in the boxes provided.
      Select **Never** to retain the backup indefinitely.
5. To set a generation-based retirement period, perform the following steps:
   a. Select **Change Generations**.
   b. Select **Discard After**.
   c. Enter the number of generations in the **Full Backups** box.
      Select **Never** to retain the backup indefinitely.
6. Click **OK**.

**Note:** NetVault: Backup automatically marks a media for re-use when the last saveset on the media expires.

### 10.7 Marking Media for Re-use

To manually mark a media for re-use, perform the following steps. This will retain the media label and any group association.

1. Open the **Device Management** window. On the **Devices** tab, right-click the drive/slot that contains the target media, and select **Re-use**.
2. In the confirmation window click **OK**.

To use this media for a backup, you must set the **Reuse Media** option on the **Backup Target** tab to either **Any** or **With Same Group Label as Target Media**.

NetVault: Backup will overwrite the existing data when the media is re-used.
10.8 Scanning Foreign Media

NetVault: Backup cannot process data on a media for which the media information is not present in the NVDB until the media, the backups and the on-tape indices stored on that media have been successfully scanned into the NVDB. Such media is marked as **Foreign**. Typically, media that is swapped between libraries, removed, or for which no job details are available are marked as Foreign. To scan a foreign media, perform the following steps:

1. Open the **Device Management** window. On the **Devices** tab, right-click the library or the drive or slot that contains the target media, and select **Scan**.
2. NetVault: Backup will scan the header and add it to the NVDB. Scanning retrieves the header information from the tape and also the on-tape indices (backup saveset index files) that are then added to the NVDB. Foreign tapes then become known to NetVault: Backup. The scanning process does not read data on the tape. Instead it skips between the beginning and end of backups looking for the on-tape index for each backup saveset.

10.9 Tracking Off-site Location

To track the off-site location for a media, perform the following steps:

1. Open the **Device Management** window. On the **Devices** tab, right-click the drive/slot that contains the media, and select **Properties**. You can also perform this task via the **Media Management** window. Open the **Media Management** window. Under **Media**, right-click the target media and select **Properties**. This opens the **Media Properties** window.
2. In the **Offsite Location** list, select the media location or enter the new location in the box.
3. Click **OK**.

10.10 Marking Media as Unusable

To mark a damaged media as unusable and prevent its further use, or to mark a piece of media unusable until a later date, perform the following steps:

1. Open the **Device Management** window. On the **Devices** tab, right-click the drive/slot that contains the media, and select **Properties**. You can also perform this task via the **Media Management** window. Open the **Media Management** window. Under **Media**, right-click the target media and select **Properties**.
2. In the **Media Properties** window, select the **Unusable** check box.
3. Click **OK**.
10.11 Deleting a Backup Index from the NVDB

To delete a backup index from the NVDB, perform the following steps:

1. Open the Media Management window.
2. Under Media, open the media that contains the target saveset (double-click the media, or right-click and select Open).
3. Right-click the saveset, and select Remove.
4. In the confirmation window, click OK. The backup index will be removed from the NVDB. To use the saveset again, you must scan the media or recover a previous NVDB backup which contained the saveset information.

10.12 Blanking a Media

To erase all data on a media, perform the following steps. This will also delete the media label and remove any group association.

1. Open the Device Management window. On the Devices tab, right-click the drive/slot that contains the target media, and select Blank.
2. In the confirmation window, click OK.

10.13 Performing Bulk Media Blanking

To erase data on all media or a set of media in a library, perform the following steps. This will also delete the media labels and remove any group association.

1. Open the Device Management window. On the Devices tab, right-click the library that contains the target media, and select Bulk Blank. This opens the Bulk Blank Media window.
2. Use Shift+Click or Ctrl+Click to select multiple media in the list. To blank all media in the library, select the All Media in List check box.
3. In the Password box, enter the password for the NetVault: Backup Server.
4. In the Enter ‘BLANK’ to Confirm Request box, enter BLANK (case insensitive) to confirm bulk blanking.
5. Click OK.
Chapter 11:
MANAGING NETVAULT: BACKUP JOBS

This chapter describes how to perform job management tasks. The information in this chapter is organized into the following topics:

- NetVault: Backup Job Management – An Overview
- Viewing NetVault: Backup Job Records
- Customizing the Jobs Window
- Filtering Job Records
- Starting a Job Instance Immediately
- Re-creating a Backup Job Instance
- Holding and Resuming a Job
- Viewing Media Request Details for a Job
- Changing Media Request Priority for a Job
- Deleting a Job Schedule
- Deleting a Job Definition

11.1 NetVault: Backup Job Management – An Overview

NetVault: Backup jobs are managed by the Job Manager process which coordinates with the Server, Client, devices and other components and processes to complete the job execution. The job details are stored in the Scheduler database. The NetVault Jobs window provides an interface to access the information in the Scheduler database. This window provides a consolidated view of all NetVault: Backup jobs. While the Status tab on the NetVault Jobs window displays all the scheduled jobs, the Jobs tab displays the scheduled as well as the saved job definition which have not been run or scheduled. You can use this console to perform various job management tasks, including starting or stopping a job, resuming a job, putting a job on hold, aborting a job and other similar tasks.
11.2 Viewing NetVault: Backup Job Records

To view the NetVault: Backup job records, perform the following steps:

1. Click **Job Management** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Job Management**. This opens the **NetVault Jobs** window.

2. On the **Status** tab you can view the list of all scheduled jobs. The active jobs are highlighted in Yellow while the scheduled jobs are highlighted in Blue. The jobs that have already completed are displayed in normal text.

3. On the **Jobs** tab, you can view all the defined jobs. This list also includes the jobs that have been saved but not scheduled or run.

4. To view the logs for a particular job, double-click it in the **Jobs** or **Status** tab. Alternatively, right-click the job and select **View Log**.

11.3 Customizing the Jobs Window

NetVault: Backup allows you to customize the **Jobs** window and hide the columns that you do not want to view. To hide or show the columns, perform the following steps. This procedure will only work if the **Jobs** window contains at least one entry.

1. In the **Jobs** window, right-click the header row.

2. To hide the columns, clear the check marks for the columns.

3. To display the columns again, right-click the header row and select the columns.
11.4 Filtering Job Records

To filter the job list displayed in the NetVault Jobs window, perform the following steps:

1. Click Set Filter on the toolbar. Alternatively, on the View menu, click Set Filter.

2. To set a time-based filter condition, configure the following parameters under From and To:
   - **First Job** – Select the First Job option to start display from the first job definition. For a time-based filter, enter the start time in the Specify Time box.
   - **Last Job** – Select the Last Job option to view all logs from the start point until the last job definition. For a time-based filter, enter the end time in the Specify Time box.

3. To set a filter based on the job execution/completion status, configure the following parameters under Job Status:
   - **Scheduled Jobs** – To view the scheduled jobs, select the Scheduled Jobs check box. Then, select All to view all scheduled jobs, or select Run Within to view jobs scheduled to run within next n hours/days. For the
Run Within option, enter the number of hours or days in the box to the right and select Hours or Days.

- **Running Jobs** – To view the jobs in progress, select Running Jobs.
- **Completed Jobs** – To view jobs that have completed successfully or with warnings/errors, select Completed Jobs. Then, select All, Completed with Warnings or Errors, or Completed with Errors.

4. To set a filter criteria based on the job attributes, configure the following parameters:
   - **Job Title** – For a filter based on the job title, select this check box, and in the box to the right enter the job title.
   - **Type** – For a filter based on the job type, select this check box, and in the box to the right enter Backup, Restore or Report.
   - **Instance** – For a filter based on the job instance, select this check box. Then, enter/select the instance number in the From and To list.
   - **Client** – For a filter based on backup target, select this check box, and in the box to the right enter the NetVault: Backup Client name.
   - **Selection Set** – For a filter based on the backup selection set, select this check box, and in the box to the right enter the set name.
   - **Schedule Set** – For a filter based on the schedule set, select this check box, and in the box to the right enter the set name.
   - **Advanced Options** – For a filter based on the advanced options set, select this check box, and in the box to the right enter the set name.
   - **Policy** – For a filter based on backup policies, select this check box, and in the box to the right enter the policy name.
   - **ID** – For a filter based on the job ID, select this check box. Then, enter/select the job ID in the From and To list.
   - **Phase** – For a filter based on the job phase, select this check box. Then, enter/select the phase number in the From and To list.
   - **Owner** – For a filter based on the job owner, select this check box, and in the box to the right enter the user name.
   - **Selection Options** – For a filter based on the backup options set, select this check box, and in the box to the right enter the set name.
   - **Target Set** – For a filter based on the target set, select this check box, and in the box to the right enter the set name.
   - **Run Status** – For a filter based on job completion status, select this check box, and in the box to the right enter the status (e.g., Backup Completed).

5. By default, the filter settings are only applied to the current session. If you close the window, the settings will be discarded. Select Set as Default Filter to save the filter settings and use them as the default filter.
6. Click **Apply** to apply the filter condition(s). Then click **OK** to close the window.

### 11.5 Starting a Job Instance Immediately

To run a job immediately, perform the following steps:

1. Open the **NetVault Jobs** window (click **Job Management** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Job Management**).
2. On the **Status** or **Jobs** tab, right-click the job and select **Run Now**. You can use the Shift+Click or Ctrl+Click methods to select multiple jobs.

**Note**: The Run Now feature cannot be used to run multiple backup jobs that also contain a duplication phase.

### 11.6 Re-creating a Backup Job Instance

To re-create a job instance, perform the following steps:

1. Open the **NetVault Jobs** window (click **Job Management** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Job Management**).
2. On the **Status** or **Jobs** tab, right-click the backup job and select **Edit/View Job**.
3. In the **Backup** window, click **Submit** on the toolbar (or, click **Submit** on the **Accept** menu).

### 11.7 Holding and Resuming a Job

To put a scheduled job on hold, perform the following steps:

1. Open the **NetVault Jobs** window (click **Job Management** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Job Management**).
2. On the **Status** tab, right-click the job and select **Hold**.
3. To submit the job again, right-click it and select **Resume**.

### 11.8 Aborting an Active Job

To abort an active job, perform the following steps:

1. Open the **NetVault Jobs** window (click **Job Management** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Job Management**).
2. On the **Status** tab, right-click the job and select **Abort**.
3. In the confirmation window, click **Yes**.
11.9 Viewing Media Request Details for a Job

To view the media request details while a backup job is in progress, perform the following steps:

1. While a backup job is in progress, open the Media Management window.
2. Under Media, double-click the media, or right-click and select Open.
3. Under Details, click the Media Request tab to view the following details:
   - Request ID
   - Job ID
   - Request Type
   - Job Status
   - NetVault: Backup Client on which the job is running
   - Drive on which the media resides
   - Media and group label; if no specific media is targeted, Any is displayed
   - Amount of space required on the media to complete the current request
   - Whether Ensure This Backup is First on the Media check box is selected
   - Whether Mark Media Read-Only is selected
   - Whether Label Blank Media Automatically is selected
   - Media format
   - Whether media inactivity timeout is set
   - Whether Local Drives Only option is selected
   - Whether Network Compression is enabled

11.10 Changing Media Request Priority for a Job

To change the media request priority for a job, perform the following steps:

1. While the job is in progress, open the Device Management window.
2. On the Media Requests tab, right-click the job and select Set Priority.
3. By default, NetVault: Backup sets the request priority to the following values:
   - Backup Job – 30
   - Restore Job – 20
   - Continuation Request – 5

A job for which this value is set to 1 is given the highest priority, while a job for which this value is set to 0 runs in the background. A Continuation Request occurs when an unfinished restore or backup job is waiting for more media. It is possible for a job in a state of paused for media changes to be pre-
emptied by another request. To allow the original request to continue without interruption, set the priority number of the continuation restore or backup to a smaller number than that of the other requests.

4. Click OK.

11.11 Deleting a Job Schedule

To delete a job schedule, perform the following steps:

1. Open the NetVault Jobs window (click Job Management on the toolbar or Large Buttons panel, or on the Operations menu, click Job Management).
2. On the Status tab, right-click the job and select Delete Schedule.
3. In the confirmation window, click Yes.

11.12 Deleting a Job Definition

To delete a job definition, perform the following steps:

1. Open the NetVault Jobs window (click Job Management on the toolbar or Large Buttons panel, or on the Operations menu, click Job Management).
2. On the Jobs tab, right-click the job and select Delete.
3. In the confirmation window, click Yes.
This chapter describes how to view and manage the NetVault: Backup logs. The information in this chapter is organized into the following topics:

- NetVault: Backup Logs – An Overview
- Viewing NetVault: Backup Logs
- Customizing the Logs Window
- Filtering Logs
- Dumping Logs to a File
- Viewing Dumped Logs
- Deleting Logs Manually
- Raising a Custom Log Event
  - Removing a Log Event

12.1 NetVault: Backup Logs – An Overview

The various NetVault: Backup processes send messages to the Server to notify users about the operations taking place, and report any problems or errors encountered during these operations. The NetVault: Backup Server utilizes a log daemon to manage these messages and write them to log files. The log daemon starts automatically when you start the NetVault: Backup services.

By default, the daemon writes the logs to \`\`\NetVault\Logs\`\` folder on the Server (where ... represents the NetVault: Backup installation directory). You can configure a new path for the Logs Directory and change the log daemon properties via the NetVault: Backup Configurator. For more information on configuring these parameters, refer to the NetVault: Backup Configurator Guide.

The log files are in binary format and named log-0, log-1, log-2, etc. The log daemon reserves space for logs by creating a blank file. When one log file becomes full, it creates a blank file before writing to the next file. For example, when log-0 becomes full, logging daemon creates log-2 before writing to log-1. log-0 and log-1 are created during NetVault: Backup installation.

Logs are useful to track activities, and identify or troubleshoot a problem. You can view the operational logs from the GUI via the Logs window. The device logs and job logs can also be viewed from the Device Management and Jobs windows, respectively.
12.2 Viewing NetVault: Backup Logs

To view the logs generated during an operation, perform the following steps:

1. Click **Logs** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Logs**.

   To view device specific logs, click the **Device Logs** tab on the **Device Management** window.

   To view logs for a particular job, double-click the job in the **Status** or **Jobs** tabs on the **Jobs** window.

2. NetVault: Backup provides the following information about the log entries:

   - **Warning Level** – Depending on their severity, the messages are classified into different categories. Different color codes, called the **Warning Level Indicators**, are used to distinguish the log categories. An icon with an exclamation mark is used to represent messages that can be opened further to view the details or log contexts. The NetVault: Backup log categories include the following:
     - **Background Messages** – The general messages are classified as Background logs and represented with a green warning level indicator.
     - **Information Messages** – The messages related to media, scheduler, and system activities are classified as Information logs and represented with a blue warning level indicator.
     - **Job Message Messages** – The job activities are classified as Job Messages and represented with a purple warning level indicator. By default, only Job Messages and the higher categories are displayed.
     - **Warning Messages** – Interferences during process execution are classified as Warnings and represented with a yellow warning level indicator.
**Chapter 12**

**Managing NetVault: Backup Logs**

- **Error Messages** – Problems encountered during execution which might have caused a job to fail are classified as Error Logs and represented with a red warning level indicator.

- **Severe Error Messages** – Critical problems encountered during execution which might have caused a job to fail are classified as Severe Error Logs and represented with a red warning level indicator.

- **Date/Time** – The time stamp for the log in Year/Month/Date Hour:Minute:Second format.

- **Job ID** – The Job ID for a backup, restore or a report job.

- **Class** – The type of operation that generated the log. For example, media activity logs are classified as Media, messages sent by the plugin are classified as Data Plugin, and job messages are classified as Job.

- **Client** – The name of the Client on which the process that generated the log is running.

- **Log Message** – The detailed log message/description.

3. Double-click a message with an exclamation mark to open one of the following windows:
   - **Additional Information Window** – If the log contains information about data transfer or other such information, a window containing this information is displayed.
   - **View Job Context** – The log context typically contains the execution scripts or output generated by the plugin.

4. To save a log context, click **Save to File**. In the **Save Log Context** window, enter the file name and click **OK**. The file is saved to `...\NetVault\Logs` directory (where `...` represents the NetVault: Backup installation directory).

### 12.3 Customizing the Logs Window

NetVault: Backup allows you to customize the Logs window and hide the columns that you do not want to view. To hide or show the columns, perform the following steps. This procedure will only work if the Logs window contains at least one entry:

1. In the **Logs** window, right-click the header row.

2. To hide the columns, clear the check marks for the column names.

3. To display the columns again, right-click the header row and select the columns.

### 12.4 Filtering Logs

To filter the logs appearing in the **Logs** window, perform the following steps:
1. Click **Set Filter** on the toolbar, or on the **View** menu, click **Set Filter**.

2. To set a time-based filter condition, configure the following parameters under **From** and **To**:
   - **Start Point** – Select the **First Event** option if you want to view logs beginning with the first recorded event. For a time-based filter, enter the start time in the **Specify Time** box.
   - **End Point** – Select the **Last Event** option to view all logs from the start point until the most recent recorded event. For a time-based filter, enter the end time in the **Specify Time** box.

3. To filter logs based on their severity, select the minimum severity level under **Warning Levels**. The warning levels are listed in the ascending order of severity. When you select a category, all logs belonging to the selected category and higher categories are displayed. For example, if you select Job Messages, then all logs classified as Job Messages, Warnings, Errors, and Severe Errors are displayed in the **NetVault Logs** window. **All** displays messages belonging to all log categories.

4. To hide certain classes of messages, clear the check boxes for them under **Classes**.
5. To hide messages related to particular NetVault: Backup Client(s), clear the check boxes for them under **Clients**.

6. To view only logs for a particular job, select the **Filter on Job** check box under **Jobs** and enter the **Job ID**.

7. To set a filter string, select the **Filter on Text** check box under **Text** and enter the filter string in the box beneath.

8. Click **Apply** to apply the filter condition(s). Then click **OK** to close the window.

### 12.5 Dumping Logs to a File

NetVault: Backup allows you to create a copy of the current logs and save them into a binary or text file before purging them from the NVDB. For selective dumping, first set a time-based filter criterion. For example, to dump all logs generated during last month, set a filter to display only those logs and then run this option.

To dump logs into a binary or text file, perform the following steps:

1. In the **NetVault Logs** window, click **Dump Logs to File** on the toolbar, or click **Dump Logs to File** on the **Options** menu.

2. In the **Dump Log Entries to File** window, configure the following options:

   - **Dump Log File Name** – Enter a file name for the log dump. If you do not enter the complete path, the dump file is saved to `...\NetVault\log\dumps\<text>` or `<binary>` folder. In this path `...` represents the installation directory for NetVault: Backup and `<text>` or `<binary>` represent the name of the final folder based on the selected dump **Format**.

   - **Format** – The logs can be dumped into one of following two formats:
     - **Text** – Select this option to dump the logs into a text file.
     - **Binary** – Select this option to dump the logs to a binary file (.nlg) which can be loaded to NetVault: Backup temporarily, if required. The binary format is required when sending the logs to BakBone Technical Support.

3. Click **OK** to save the logs.
12.6 Viewing Dumped Logs

To view the logs dumped as .nlg files, perform the following steps:

1. In the NetVault Logs window, click Select Log Source on Options menu.
2. The dump files present in the ..\logs\dumps\binary folder are listed in the box beneath. To load a file in this folder, select it in the list.
3. To load a dump file residing in a different location, enter the complete file path in the box.
4. Click OK to view the dumped logs.
5. To reset the view to current logs, select the Use Default Log source option.

12.7 Deleting Logs Manually

The logs are automatically deleted after 120 days. You can change the log daemon properties and set a new auto purge period for the logs via the NetVault: Backup Configurator. For details on setting an auto purge period, refer to the description for the Logging Daemon tab in the NetVault: Backup Configurator Guide. To manually delete the unnecessary logs, perform the following steps:

1. In the NetVault Logs window, click Purge Logs on the Options menu.
2. In the Purge Log Entries To box, enter the date up to which you want to delete the logs.
3. Click OK.

12.8 Raising a Custom Log Event

You can raise a custom log event when a particular message is logged, and use any of the global or user-specific notification methods to alert you when this occurs. The custom log events are added to the Log Daemon class in the Global Notification window. To raise a custom log event, perform the following steps:

1. In the NetVault Logs window, right-click a message and select Set Event. This opens the Set Event Log window.
2. In the Event Name box, enter the event name.
3. In the Description box, enter a detailed description for the event.
4. Click OK to save the event definition.
5. Set up a notification method for the event. For details on global notification methods, refer to Setting up a Global Notification Method on page 153, and for details on user-specific notification methods, refer to Setting a Notification Profile for a User on page 165.
12.8.1 Removing a Log Event

To remove a custom log event, perform the following steps:

1. In the **NetVault Logs** window, right-click the message for which the event was set.
2. In the **Set Event Log** window, click **Remove**.
Chapter 13: Setting up Event Notification

This chapter describes how to set up notification methods for the NetVault: Backup events. The information in this chapter is organized into the following topics.

- Events and Notification – An Overview
  - Available Notification Types
- Event Notified By Default
- Setting up a Global Notification Method
- Configuring Mail Server Address for Email Notification Method
- Configuring Sysop Mail Address for Email Notification
- Configuring a Default Printer for Notification
- Viewing Operator Messages

13.1 Events and Notification – An Overview

An event can be described as any significant occurrence within the NetVault: Backup system that you want to be notified about. It can be a user action, a system event, or a change in the status of any of NetVault: Backup component. The events can indicate an error or a problem, or just completion of a task.

NetVault: Backup provides a set of pre-defined events that are organized into the following Event Classes – Audit, BakBone Time, Device, Job, Licensing, Log Daemon, Machines, Media, Media Database, Policy, Scheduler Database and Stats Collection. For details on event types in each class, refer NetVault: Backup Pre-defined Events on page 263. In addition to the pre-defined events, NetVault: Backup also allows you to define custom job and log events which are raised for individual jobs and log messages.

You can set one or more notification methods to generate and receive a notification when these events occur within the NetVault: Backup Domain. The supported notification methods include the following:

- **Sysop Email** – Send an email to the configured mail ID when an event is raised.
- **Sysop Operator Message** – Log an operator message when an event is raised. You can view these logs from the Status window.
- **Print Report** – Print a report when an event is raised.
Chapter 13
Setting up Event Notification

13.1 Available Notification Types

NetVault: Backup provides three methods to generate notification:

- **Generate Notification for Pre-defined Events Globally** – You can set up one or more notification methods for an event in the Global Notification window to generate a notification whenever the event occurs within the NetVault: Backup Domain. Global notification methods can only be set for pre-defined events. You can choose the Sysop E-mail, Sysop Operator Message or Print a Report notification methods for a pre-defined event.

- **Generate Notification for Individual Users** – Notification methods can also be set up for individual users (e.g., NetVault: Backup Administrator). This allows a particular user to receive emails and/or Windows pop-up messages whenever the event occurs within the NetVault: Backup Domain. This is done by setting up a notification profile for the user in the NetVault User Properties window. For details on setting up a user notification profile, refer to Setting a Notification Profile for a User on page 165. The notification will be generated each time the event occurs within the domain.

- **Generate Notification for Custom Job or Log Events** – NetVault: Backup allows you to define custom job or log events for a particular instance of a job or a log message.

  To create a custom job or log event, refer to the following sections:
  - Setting up Custom Notification Events for a Job
  - Setting up Custom Notification Events for Policy Jobs
  - Setting up Custom Notification Events for the Report Job
  - Raising a Custom Log Event

  You can choose the Sysop E-mail, Sysop Operator Message, Print a Report or Run a Report notification methods for a custom event. A notification is generated only for the job/log for which it is configured.

13.2 Event Notified By Default

For certain significant events, NetVault: Backup sets up the SysOp Operator Message notification method by default. These include the following events:

- **Event Class: BakBone Time, Event Type: Server Time Unknown** – This event is raised when the Time Server is not able to fetch BakBone Time from the Source.

- **Event Class: Device, Event Type: No Suitable Drive** – This event is raised when NetVault: Backup is not able to find a suitable drive to run a backup or restore job.
- **Event Class: Licensing, Event Type: License Exceeded** – This event is raised when usage exceeds the available licenses.
- **Event Class: Licensing, Event Type: License Expired** – This event is raised when the NetVault: Backup evaluation license is nearing expiration.
- **Event Class: Log Daemon, Event Type: Home Drive Becoming Full** – This event is raised when the disk space usage reaches warning or critical threshold.
- **Event Class: Media, Event Type: No Suitable Media** – This event is raised when NetVault: Backup is not able to find a suitable media to complete the backup job.

You can also set another notification method if required.

### 13.3 Setting up a Global Notification Method

To set a global notification method for a pre-defined or custom event, perform the following steps:

1. On the **Administration** menu, click **Global Notification**. This opens the **Global Notification** window. On the **Global Notification Profile** tab, you will find the list of event classes.
2. Double-click an event class node, or right-click it and select **Show Event Types**. The list of available event types in a class is displayed under this node.
3. Double-click an event type node, or right-click it and select **Show Notification Methods**.
4. The available notification methods are listed under this node. Select the required method. NetVault: Backup allows you to set more than one notification method for an event.
   a. **Sysop E-mail** – Select this method to receive an email notification when the event is raised. To use this method, you must configure the mail server address and the sysop email address. For details refer to [Configuring Mail Server Address for Email Notification Method](#) on page 155 and [Configuring Sysop Mail Address for Email Notification](#) on page 156.
b. Sysop Operator Message – Select this method to log an operator message when the event is raised. These logs can be viewed from the Status window. For details on accessing the operator log messages, refer to Viewing Operator Messages on page 156.

c. Print Report – Select this method to print a report when the event is raised. This method can only be used for Report Job event types.

To use this method on Windows, you must either configure a default printer or set a printer for an individual event. For details on configuring a default printer for event notification, refer to Configuring a Default Printer for Notification on page 156. If a default printer is not configured or you want to use another printer for a particular event, perform the following steps:

1. Double-click Print Report node, or right-click it and select About Extra Variables. This opens the Notification Method Information window.

2. Under Setting Variables, configure the NVPRINTER variable:

   NVPRINTER=<Printer URL>

3. Click OK to save the settings.

d. Run a Job – Select this method to run another job when the event is raised. For example, you can use this notification method to omit a
database that failed and run another job to backup the critical databases, or run a report job when the backup fails to determine the cause.

To use this method, first define the job you want to run when the event is raised. Then, specify the job using its Job ID as described in the following steps:

1. Double-click Run a Job node, or right-click it and select About Extra Variables. This opens the Notification Method Information window.
2. Under Setting Variables, configure the JOBID variable:
   
   \[
   \text{JOBID} = \langle \text{Job ID for the job to run when the event is raised} \rangle
   \]
3. Click OK to save the settings.
5. Perform steps 2–4 for any other event for which you want to set up a notification method.
6. Click Save Global Notification Profile on the toolbar, or on the File menu, click Save.

### 13.4 Configuring Mail Server Address for Email Notification Method

The email notification method requires the mail server address to send sysop emails or user emails when the event is raised. To complete this configuration, perform the following steps:

2. Click the Notification tab.
3. On the Mail Server tab, configure the following parameters:
   - **Outgoing E-mail Server (SMTP)** – Enter the machine name or IP Address for the mail server.
   - **Port Number** – The default port for SMTP is pre-configured. Change it if the Server is configured to listen on a different port.
Chapter 13
Setting up Event Notification

13.5 Configuring Sysop Mail Address for Email Notification

To use the Sysop Mail notification, configure the mail address as described in the following steps:

2. Click the Notification tab, and then click the Global Notification tab.
3. Enter the sysop mail address in the Enter Email Address of System Administrator box.
4. Enter the receiver’s name in the Real Name of System Administrator box.
5. Click Apply to save the settings. Then, click OK to close the window.

13.6 Configuring a Default Printer for Notification

On a Windows platform, configure a default printer for Print a Report notification method as described in the following steps:

2. Click the Notification tab, and then click the Default Printer tab.
3. Enter the URL for the printer in the Default Printer Name box.
4. Click Apply to save the settings. Then, click OK to close the window.

13.7 Viewing Operator Messages

To view the operator messages that are logged when an event occurs, perform the following steps:

1. Click Status on the toolbar or Large Buttons panel, or on the Operations menu, click Status.
2. The sysop operator messages for the events are listed under Operator Messages.
3. You can set the **Flag** property for a message if it requires any action. To flag a message, right-click it and select **Flag**. To clear the flag, right-click and select **Unflag**.

4. To acknowledge a message, right-click it and select **Acknowledge**.

5. To delete a particular message, right-click it and select **Delete**.

6. To clear all logs, right-click any message and select **Delete All**.
Chapter 14: IMPLEMENTING ACCESS CONTROL MECHANISMS

This chapter describes how to implement NetVault: Backup’s access control mechanisms. This section is primarily intended for the NetVault: Backup Administrator who is responsible for managing the NetVault: Backup system. The information in this chapter is organized into the following topics:

- Access Control Mechanisms – An Overview
- Creating a New User Account
- Modifying a User Profile
- Updating General Details for a User Account
- Assigning Client Access Rights to a User
- Assigning Permissions for NetVault: Backup Operations
- Assigning Media Group Memberships to a User
- Setting Media Usage Quota for a User Account
- Setting Job Quota for a User Account
- Setting a Notification Profile for a User
- Setting User Account Password
- Setting Global Password Expiration Policy
- Deleting a User Account

14.1 Access Control Mechanisms – An Overview

NetVault: Backup provides user-level access control mechanisms, which can be implemented to accomplish the following:

- Prevent unauthorized access to your backup system
- Grant rights and permissions based on the user role/functions

For example, you can create a user for the DBA role and grant permissions to perform backup and restore jobs for the database system, or you can create an account for the network administrator and grant privileges to add and remove backup devices. For details on NetVault: Backup user rights and permissions, refer to NetVault: Backup User Permissions on page 279.

NetVault: Backup creates the following two user accounts by default:
- **default** – This is a normal user account. NetVault: Backup is configured to perform an auto logon using this account when no access control mechanisms are in place. This user has full access to the NetVault: Backup system. By default, no password is set for this account, which enables auto logon. Though setting a password for this account will disable auto logon, it will prevent unauthorized access to your NetVault: Backup system. If the NetVault: Backup system is accessed by several users, it is recommended that you create separate user accounts for them. The user accounts can be based on individual users, roles or groups/department.

- **admin** – This is the Administrator account for the NetVault: Backup system. By default, no password is set for this account. It is recommended that you set up a password for the admin account for security purposes.

The access control mechanisms are controlled by the NetVault: Backup auditor. This process runs on the NetVault: Backup Server, and tracks and controls user activities. The Auditor validates each user request, and depending on the rights and permissions granted to the user, allows or denies the request. It records the events in the audit log, also referred to as Audit Trail. The audit trail is named `audit.bin` and stored in the `.../netvault/db` directory (where ... refers to the NetVault: Backup installation directory). You can view these logs via NetVault: Backup Audit Trail report. By default, the Auditor logs each user activity regardless of whether the request is accepted or denied. The Auditor automatically purges the logs that are older than 31 days. You can change these properties via the NetVault: Backup Configurator. For details, refer to the NetVault: Backup Configurator Guide.

### 14.2 Creating a New User Account

To create a new user account, perform the following steps:

1. On the **Administration** menu, click **Access Control**. This opens the NetVault Access Control window.
2. On the **Users** tab, click **Add User**. NetVault: Backup creates a new account and adds it to the user list. The user is named **New User** by default.
3. To rename the user account, right-click **New User** on the **Users** tab and select **User Properties**.
4. In the **NetVault User Properties** window, click the **User Details** tab.
5. In the **Account** box under **Identification**, enter the name by which the user/group account will be identified. It is recommended that you change the default name and assign a proper name based on the user group, role or actual name. Each user name must be unique.
6. In the **Real Name** box, enter the actual name of the user/group. This information is not mandatory.
7. Click the **Group Memberships** tab, and assign the access rights to Clients. For details on assigning Client access rights to a user, refer to *Assigning Client Access Rights to a User* on page 162.

8. Click the **Privileges** tab, and assign the permissions to perform NetVault: Backup operations. For details on assigning user permissions, refer to *Assigning Permissions for NetVault: Backup Operations* on page 162.

9. The remaining attributes are optional. Refer to the following sections for instructions on configuring these attributes:
   - Updating General Details for a User Account
   - Assigning Media Group Memberships to a User
   - Setting Media Usage Quota for a User Account
   - Setting Job Quota for a User Account
   - Setting a Notification Profile for a User

10. For details on setting a password for the user account, refer to *Setting User Account Password* on page 165.

11. Click **Save User Details** on the toolbar. Alternatively, on the **File** menu, click **Save User**.
14.3 Modifying a User Profile

To modify a user account profile, perform the following steps:

1. On the Administration menu, click Access Control. This opens the NetVault Access Control window.
2. In the user list, right-click the user, and select User Properties.
3. Refer to the following sections to modify the user profile:
   - Updating General Details for a User Account
   - Assigning Media Group Memberships to a User
   - Setting Media Usage Quota for a User Account
   - Setting Job Quota for a User Account
   - Setting a Notification Profile for a User
4. For details on changing user password, refer to Setting User Account Password on page 165.
5. Click Save User Details on the toolbar. Alternatively, on the File menu, click Save User.

14.4 Updating General Details for a User Account

To change the user name and/or update general details for an account, perform the following steps:

1. In the NetVault User Properties window, click the User Details tab.
2. To change the user name, enter the new name in the Account box under Identification.
3. Enter the actual name in the Real Name box.
4. Under E-mail, configure the email addresses for the user/group. Enter the address in the E-mail 1 box if you want to set up an email notification method for pre-defined or custom events. For details on event notification, refer to Setting a Notification Profile for a User on page 165. The other details are not mandatory.
5. Under Contact, enter the phone numbers and other details in the corresponding boxes. These details are not mandatory.
6. Under Details, enter the workstation name, location and the user/group description in the corresponding boxes. These details are not mandatory.
14.5 Assigning Client Access Rights to a User

To assign client access rights to a user, perform the following steps:

1. In the NetVault User Properties window, click the Group Memberships tab.

![Figure 14-2: Assign Client Access rights by granting Client Group membership]

2. To allow access to all Clients within the domain, select the User is a Member of All Clients Group check box under Client Groups. When you select this check box, the user account is automatically granted membership to any Client/Client Group that are added in future.

Alternatively, select default in the Not Member Of list under Client Groups, and click the Left Arrow.

3. To grant access to selective Client Groups, select the group in the Not Member Of list and click the Left Arrow.

4. To allow access to a Client only when the user is locally logged on to the Client, select the Local Access Only check box. When you select this check box the user cannot target the Client for backups remotely from the NetVault: Backup Server or any other Client.

5. To remove a Client Group membership, select the group in the Member Of list and click the Right Arrow.

14.6 Assigning Permissions for NetVault: Backup Operations

To assign permissions for NetVault: Backup operations, perform the following steps:

1. In the NetVault User Properties window, click the Privileges tab.

2. To grant full access to NetVault: Backup, select the User is Granted All Privileges check box under Privilege Flags.
3. To grant access to selective functions, select the functions in the **Denied** list. Use Shift+Click or Ctrl+Click to select the functions. Then, click the Left Arrow. These privileges are now added to the **Granted** list.

4. You can save these selections into a preset and apply the preset to another user account. This eliminates the chances of error while assigning necessary privileges to a user. To save the privileges into a set, click **Save Preset**. In the **Select Preset** window, enter a name for the set in the box provided at the bottom of the window. Then, click **OK**.

5. To apply a preset, click **Load Preset**. In the **Select Preset** list, select the set you want to apply. Then, click **OK**.

6. To revoke any granted privilege, select it in the **Granted** list and click the Right Arrow. This moves the privilege to the **Denied** list.
14.7 Assigning Media Group Memberships to a User

To assign media group memberships to a user, perform the following steps:

1. In the NetVault User Properties window, click the Group Memberships tab.
2. For no media group restrictions, select the User is a Member of All Media Groups check box under Media Groups. When you select this check box, the user account is automatically granted access to any new media groups that are added.
3. To restrict the user account to target specific media groups for backups (e.g., DB-Full and DB-Inc media groups for the backups of a database), select the media group in the Not Member Of list and click the Left Arrow.
4. To remove a Media Group membership, select the group in the Member Of list and click the Right Arrow.

14.8 Setting Media Usage Quota for a User Account

By default, NetVault: Backup users have access to unlimited media quota. No restrictions apply to the amount of media used by any user account. You can, however, override this default setting and configure a quota for a user to curtail media usage. When the usage reaches the defined quota, the jobs submitted by the user will fail. The media usage amount is calculated from the existing records in the media database. When a saveset expires, the media used by it becomes available for new jobs. To set the media usage quota for a user account, perform the following steps:

1. On the Privileges tab, select the option Media Usage Up to under Media Quota.
2. In the box to the right enter the media usage quota in GB.

14.9 Setting Job Quota for a User Account

By default, NetVault: Backup users can run infinite number of jobs. No restrictions apply to the number of jobs performed by any user account. You can, however, override this default setting and configure the maximum number of jobs for a user. When the total number of existing jobs reaches the defined quota for a user, the user will not be able to submit more jobs. The number of jobs performed by a user is derived from the existing records in the scheduler database. For the deleted job definitions, the user can submit an equal number of new jobs. To set the maximum number of jobs for a user, perform the following steps:

1. On the Privileges tab, select the option Job Count Up to under Job Quota.
2. In the box to the right enter the maximum number of jobs for the user.
14.10 Setting a Notification Profile for a User

NetVault: Backup provides a set of pre-defined events for which you can configure global and/or user-specific notification methods. For details on pre-defined events, refer to NetVault: Backup Pre-defined Events on page 263. You can choose to generate an email or a Windows pop-up message whenever the event is raised within the domain. To set an event notification profile for a user account, perform the following steps:

1. On the Administration menu, click Access Control. This opens the NetVault Access Control window.
2. In the user list, right-click the user, and select User Properties.
3. In the NetVault User Properties window, click the Notification Profile tab.
4. Double-click an event class node, or right-click it and select Show Event Types. The available event types are listed under this node.
5. Double-click an event type node, or right-click it and select Show Notification Methods.
6. The available notification methods are listed under this node. Select the required method.
   - **E-mail** – Select this method to send an email notification to the user when the event is raised. The email is sent to the mail address configured in the **E-mail-1** box on the User Details tab.
   - **Windows Pop-up Message** – Select this method to display pop-up messages to the user when the event is raised. This method is only supported on Windows. Note that the pop-up messages will not be displayed if firewall or other settings block such messages. The pop-up message notification method is not supported on Windows 2008.
7. Repeat steps 4–6 to set up notification methods for other events.
8. Click Save User Details on the toolbar. Alternatively, on the File menu, click Save User.

14.11 Setting User Account Password

To set or change the password for a user account, perform the following steps;

1. Open the NetVault Access Control window.
2. In the user list, right-click the user, and select Set Password.
3. Configure the following parameters in the Set User Password window:
   - **Existing Password** – Enter the current password for the account. Leave it blank if no password was set.
   - **New Password** – Enter the new password for the user account.
   - **Confirm Password** – Re-enter the password for confirmation.
4. Click **OK**.

To set the **Password Never Expires** flag, perform the following steps:

1. In the **NetVault Access Control** window, right-click the user and select **User Properties**.
2. Click the **Privileges** tab.
3. Under **General**, select **Password Never Expires**.
4. Click **Save User Details** on the toolbar. Alternatively, on the **File** menu, click **Save User**.

This setting overrides any global password expiration policy you have set.

### 14.12 Setting Global Password Expiration Policy

To define a global password expiration policy for all NetVault: Backup user accounts, perform the following steps:

1. On the **Administration** menu, click **Access Control**.

2. In the **NetVault Access Control** window, click **Edit Password Policy**.
3. In the **Edit Password Policy** window, select the **Passwords have a Maximum Age** check box.
4. In the box next to this check box, enter the age for user password in number of days.
5. In the **Display Reminder** box, enter how many days before the expiration date you want NetVault: Backup to start displaying the reminder. The message is displayed when the user logs on to the NetVault: Backup system.

### 14.13 Deleting a User Account

To delete a user account, perform the following steps:

**Important:** Do not remove the **admin** user account.

1. Open the **NetVault Access Control** window.
2. In the user list, right-click the user, and select **Remove User**.
3. In the confirmation window, click **OK**.
Chapter 15: REPORTING IN NetVault: BACKUP

This chapter describes how to use the NetVault: Backup Reporting tool. The information in this chapter is organized into the following topics:

- NetVault: Backup Reports – An Overview
- Generating a Canned Report
- Creating a Custom Report
  - Selecting the Report Components
  - Inserting Custom Headers and Footers
  - Defining Job Schedule
  - Setting up Custom Notification Events for the Report Job
  - Finalizing and Submitting the Job
  - Retaining Excluded Data for Historic Reports
- Working with Custom Report Components
  - Selecting the Base Component
  - Selecting Fields for a Component
  - Sorting the Output
  - Specifying the Output Type
  - Setting the Output Options
  - Defining Headers and Footers for the Component
  - Setting Filter Conditions
    - Creating or Modifying Filter Expressions
    - Saving the Component
- Working with Historic Reports
- Editing/Viewing a Report Template
- Viewing Logs for a Report Job
- Configuring the Default Browser for Viewing Reports
- Deleting a Report Template
15.1 **NetVault: Backup Reports – An Overview**

NetVault: Backup offers two types of reports:

- **Canned Reports** – Canned reports are pre-defined report templates that give you details on jobs performed during a given period, completion status of the policy jobs, media utilization details, backup performance and other useful information. For details on canned reports, refer to *Canned Reports* on page 269.

- **Custom Reports** – The advanced reporting capabilities allow you to design your own custom reports that can be scheduled to run at pre-defined time and intervals. You can include pre-defined or derived components in these templates, add your own headers/footers and set multiple filter conditions.

The canned and custom reports can be generated in the following formats:

- **HTML** – On Windows, you can use the built-in browser to view these reports. On Linux/UNIX, you can use any browser installed on your system as the default browser for the NetVault: Backup reports. For details on configuring the default browser on Linux/UNIX, refer to *Configuring the Default Browser for Viewing Reports* on page 188.

- **Text** – This format can be used to view the reports from the command line or using any text editor.

- **Comma Separated Value** – This format can be used to generate Comma Separated Value (CSV) file that can be imported to your spreadsheet or database application.

The reports are generated and run from the **Reports** window. The job definitions for pre-defined and custom reports are listed on the **Jobs** tab of the **Reports** window. On the **Status** tab, the submitted report jobs are listed.

The reporting functionality is integrated with the event notification system. This allows you to set up global or user-specific notification methods, and receive notification when a job completes or fails, or when certain conditions are met. You can use this feature to send reports as email attachments to the Administrator or any other user.

NetVault: Backup stores the report templates and components in the reports database. By default, this database resides in the .../NetVault/reports directory (where ... refers to the NetVault: Backup installation directory). You can relocate this database by configuring a new path via the NetVault: Backup Configurator. For more information on relocating the reports database, refer to the *NetVault: Backup Configurator Guide*.

Note that a basic version of the NetVault: Report Manager for Backup (NRMB) is included in all NetVault: Backup DataCenter and Enterprise packages when the backup server is running on an operating system supported by NRMB.
NRMB consolidates information from multiple NetVault: Backup servers to provide a visual monitoring and alerting capability with additional backup reporting. The system identifies potential problems early and graphically communicates vital data protection results to key constituents. NRMB reduces administrative time, helps centralize operations and lowers media costs.

If you are licensed for it, refer to the NRMB information contained in the NetVault: Report Manager Administrators Guide at the following address:

http://www.bakbone.com/documentation

15.2 Generating a Canned Report

Canned Reports contain pre-defined templates that provide information on the jobs, media, devices and other NetVault: Backup components. For details on canned reports, refer to Canned Reports on page 269. These reports are generated in HTML format. To run a canned report, perform the following steps:

1. Open the Reports window (on the Operations menu, click Reports). On the Jobs tab, you will find the list of canned reports.

2. Double-click a report, or right-click and select Run and View. Select Run and Notify, if you want to raise the associated events and receive a notification.

3. If any filter condition is set for the report (e.g., reports that are to be generated for a particular period or for a particular job), the Set Filters for Report window will be displayed. Enter the values and click OK.

4. The report opens in the built-in or the configured browser.

Figure 15-1: The Set Filters window for a report
15.3 Creating a Custom Report

NetVault: Backup provides the ability to define custom report templates that match your specifications. These user-defined templates are called custom reports. The custom reports can contain multiple report components. You can include both the pre-defined and derived components in these templates. For a list of pre-defined components that can be included in a custom report, refer to Pre-defined Report Components on page 271. You can also customize these components and create a derived component. For details on creating a custom component, refer to Working with Custom Report Components on page 175.

The procedure for creating a custom report can be divided into the following steps:

- Selecting the Report Components
- Inserting Custom Headers and Footers
- Defining Job Schedule
- Setting up Custom Notification Events for the Report Job
- Retaining Excluded Data for Historic Reports
- Finalizing and Submitting the Job

These steps are described in detail in the following sections.

15.3.1 Selecting the Report Components

To select the components for a report job, perform the following steps:

1. On the Operations menu, click Reports. This opens the Reports window.
2. Click Report Job on the toolbar. Alternatively, on the Reports menu, click Report Job. This opens the Reporting Job Editor window.
3. The available pre-defined and derived components are listed under **Available Components**. The default view method is **By Class**, which arranges the components under their respective classes.

You can change the view to **All** in the **Viewing Method** list for an alphabetical listing of the components. The **By Output Type** viewing method organizes the components by their output type – **Comma Separated Values**, **HTML Text** or **Plain Text**.

4. To add an available component, perform the following steps:
   a. Open the parent class or output type. You can double-click the node, or right-click and select **Show Components**.
   b. Double-click a component. Alternatively, right-click it and select **Add to Job**. The added component is displayed under **Selected Components**.
   c. To add other available components, repeat steps a–b.
5. To change the order of the components in which they appear in the report, select the component in the **Selected Components** list, and click **Up** or **Down**.

6. To include a new custom component in the report, click **New Component**. For details on creating a custom component, refer to *Working with Custom Report Components on page 175*. After creating the component, click **Save and Add to Job** on the toolbar. Repeat this step for any other new component you want to include in the report.

7. To modify an added component, select it in the **Selected Components** list and click **Edit**. This opens the **Report Component Editor** window. For details on modifying a report component, refer to *Working with Custom Report Components on page 175*.

8. To remove a component, select it and click **Remove**.

### 15.3.2 Inserting Custom Headers and Footers

Each report contains a default header and footer, which is in HTML or text format depending on the output format of the component. To replace them with your own custom header/footer, perform the following steps:

1. Click the **Header/Footer** tab in the **Reporting Job Editor** window. The available header templates are listed under **Choose Header**.

2. To insert a custom header, first clear the check box for the **Default** header.

3. If the required header is already defined, select it in the **Choose Header** list. Ignore the remaining steps in this section.

4. To define a new header, select one of the following methods. To create HTML headers, you must be familiar with the HTML tags.
   - **Clone an Existing Header Template** – To create a new header from an existing template, right-click the header, and select **Clone**.
   - **Create a New Header Template** – To create a header using a blank template, click **New** at the bottom of the window.

   This opens the **Edit Header** window.

5. In the **Header Name and Text** box, enter a name for the template.

6. In the box below, enter/modify the text. You can use any HTML tag in an HTML template.

7. To include images (e.g., company logo) in an HTML template, use the SRC HTML tag. The image must be in .jpeg or .gif format.

8. Click **OK**. The template is added and displayed under **Choose Header**.

9. Select the template.

10. If you have added images, copy the file to `..\NetVault\reports\jobheaders\HTMLJobDefault\images` folder. Then,
right-click the new custom header and select Add Image. In the browse window, enter the file path or select the file.

15.3.3 Defining Job Schedule
Click the Schedule tab and configure the scheduling options. You can define a daily, weekly, monthly or any other custom schedule for the report job. For details on defining a job schedule, refer to Scheduling Jobs on page 93. You can omit this step if you want to run the report job immediately.

15.3.4 Setting up Custom Notification Events for the Report Job
NetVault: Backup supports three types of custom events for a report job – a conditional event, an event that is raised when the job completes and an event that is raised when the job fails. You can set up global or user-specific notification methods for these events. The custom report events are added to the Report Job class in the Global Notification window. You can use this feature to send reports as email attachments to the Administrator or any other user. To raise a custom report event, perform the following steps:

1. In the Reporting Job Editor window, click the Options tab.
2. Under Output Options, select the following option(s):
   - **Raise an Event Conditionally** – To raise an event conditionally, configure the following parameters:
     - Select the Run as Condition Check check box.
     - Select or enter the event name in the Event to Raise if Condition is Met list.
     - To raise an event only when conditions set for all components are met, select the Conditions of all Components must be Met to Raise an Event check box.
   - **Raise an Event when the Job Completes** – The conditional event and job completion events are mutually exclusive. If the Run as Condition Check check box is selected for a report job, then this option will not be available. To raise an event when the job completes, select or enter the event name in the Event to Raise when the Job Completes list.
   - **Raise an Event if the Job Fails** – To raise an event if the job fails, enter or select the event name in the Event to Raise on Job Failure list.
3. Set up a notification method for the event. For details on global notification methods, refer to Setting up a Global Notification Method on page 153, and for details on user-specific notification methods refer to Setting a Notification Profile for a User on page 165. Note that a new event is only listed in the Global Notification and the NetVault User Properties window when you save or submit the job definition.

To send the report as an email attachment to the Administrator or any user, set up the Sysop E-mail global notification method or the E-mail user notification method.

15.3.5 Retaining Excluded Data for Historic Reports

NetVault: Backup keeps a copy of the data set that was used to generate a report, allowing you to re-analyze the historic data by applying new settings/filters. By default, the data that is excluded as a result of some filter condition is not saved. To keep a copy of the excluded data, select the Keep Filtered out Records check box on the Options tab. This allows you want to re-apply the filters on the entire data set. When generating the report again, you can remove the exclude condition or set a new filter to view the excluded records. Note that the filters can only be based on the fields selected for the original report job. For details on making changes to historic reports, refer to Working with Historic Reports on page 186.
15.3.6 Finalizing and Submitting the Job

Complete the following steps to finalize and submit the job.

1. Enter a title for the job in the Job Title box at the top right corner of the Reporting Job Editor window.

2. Choose one of the following methods to save, submit and/or run the report.
   a. **Save the Definition without Scheduling the Job** – To save the job definition without scheduling it, click Save on the toolbar. Alternatively, on the File menu, click Save. A saved job does not appear in the Status tab of the Reports window and does not run unless you submit it (or use the Triggered scheduling option). You can load a saved job again in the Reporting Job Editor window, or open it for editing from the Jobs tab of the Reports window. For details on editing a job definition, refer to Editing/Viewing a Report Template on page 187.
   b. **Schedule the Job** – To submit the job and run it at the defined schedule, click Submit on the toolbar. Alternatively, on the Accept menu, click Submit Backup.
   c. **Run the Job Immediately** – To run the job immediately and view the report, click Save, Run and View Job on the toolbar. Alternatively, on the Accept menu, click Save, Run and View.

15.4 Working with Custom Report Components

NetVault: Backup allows you to customize a pre-defined component and derive your own custom component. This gives you the ability to choose the fields, re-order the fields, sort the records and set custom filter conditions for a component. The procedure for creating or modifying a custom component can be divided into the following steps:

- Selecting the Base Component
- Selecting Fields for a Component
- Sorting the Output
- Specifying the Output Type
- Setting the Output Options
- Defining Headers and Footers for the Component
- Setting Filter Conditions
- Saving the Component
15.4.1 Selecting the Base Component

To select the base component, perform the following steps:

1. Select one of the following methods to choose the base component:
   a. Define a New Component for the Current Job – To add a new component to the job you are defining, click New Component in the Reporting Job Editor window.
   b. Modify a Component for the Current Job – To change a component added to the job you are defining, perform the following steps:
      1. In the Reporting Job Editor window, select the component in the Selected Components list.
      2. Click Edit.
   c. Create a Component for Future Use – To create a component for future use, perform the following steps:
      1. In the Reports window, click Report Component on the Reports menu. This opens the Report Component Editor window.
      2. In the Report Component Editor window, click New on the toolbar, or on the File menu, click New.
   d. Modify a Component for Future Use – To modify a component for future use, perform the following steps:
      2. In the Report Component Editor window, click Load on the toolbar, or on the File menu, click Load. This opens the Choose New Component's Class window.
      3. Double-click a class, or select it and click OK.

2. In the Choose New Component's Class window, double-click a component, or select it and click OK.
15.4.2 Selecting Fields for a Component

To select the fields for a component, perform the following steps:

1. In the Report Component Editor window, click the Field Selection tab.

2. Under Available Fields, you will find the list of fields that can be included. Refer to the Description column in the table to find out the value stored in these fields.

3. To include a field double-click it. The added field is displayed under Selected Fields. Repeat this step to add the other fields.

4. Under Selected Fields, two views are provided – Simple and Advanced/Free Format.
   - Simple View – The Simple view lists the selected fields in a tabular format.
To change the order of the fields, select it in the Selected Fields list and click Up or Down.

To remove a field, select it and click Remove.

- **Advanced/Free Format View** – The Advanced/Free Format view uses the HTML table tags to display the order of the selected fields. If you are familiar with HTML tags, you can use this view to add, rearrange or remove fields. Use the names listed under the Real Name column under Available Fields. Prefix each field name with % to replace it with the actual field value in the report.

### 15.4.3 Sorting the Output

To sort the output on multiple fields, perform the following steps:

1. In the Report Component Editor window, click the Sort Order tab.
2. Under **Available Fields**, you will find the list of fields that can be used to specify the sort order.

3. To sort the records by a particular field, select it in the **Available Fields** list. Click **Add as Ascending** or **Add as Descending**. The added field is displayed under **Sort Order**. To add other fields, repeat this step.

4. To change the order of the fields, select it in the **Sort Order** list and click **Up** or **Down**.

5. To remove a field, select it and click **Remove**.

15.4.4 Specifying the Output Type

To specify the type of output generated by the component, perform the following steps:

1. In the **Report Component Editor** window, click **Set Output Type** on the toolbar. Alternatively, on the **Options** menu, click **Output Type**.
2. In the Choose Component's Output Type list, select Plain Text, HTML Text or Comma Separated Values list.
3. Click OK.

15.4.5 Setting the Output Options
To configure the output options for a component, perform the following steps:

1. In the Report Component Editor window, click the Output Options tab.
2. Depending on the type of output generated by the component, refer to the following points:
   a. HTML Text – For a component that produces HTML output, configure the following parameters.
      1. Leave the Automatically Generate Column Headers check box selected to include a header row for the columns. The titles are obtained from the Field Name column under Available Fields on the Field Selection tab.
         If you have defined a custom header row in the HTML template, clear the check box.
      2. Select the Disable Main Record Output check box if you just require the total and average record counts and do not want to view the list of records.
      3. Select the Output Total Records check box to include total record count.
      4. Select the Output Average Record check box to include average record count.
      5. Select the Advanced Options check box to define how the titles, total count and average count data are displayed. The formatting parameters for these fields are displayed when you select Advanced Options. Update these parameters as required.
   b. Plain Text – For a component that produces plain text output, configure the following parameters:
      1. Leave the Automatically Generate Column Headers check box selected to include a header row for the columns. The titles are obtained from the Field Name column under Available Fields on the Field Selection tab. Clear the check box if you do not require the column headers.
      2. Select the Disable Main Record Output check box if you just require the total and average record counts and do not want to view the list of records.
      3. The plain text format uses fixed field length for proper alignment. However, this results in truncation of the records. If you do not want to
truncate the field values and display the entire contents, select the Variable Width Output check box. The output will not be aligned when you select this check box.

4. Select the Output Total Records check box to include total record count.

5. Select the Output Average Record check box to include average record count.

6. Select the Advanced Options check box to define how the titles, total count and average count data are displayed. The formatting parameters for these fields are displayed when you select Advanced Options. Update these parameters as required.

c. Comma Separated Values – For a component that produces a CSV output, configure the following parameters:

1. Leave the Automatically Generate Column Headers check box selected to include a header row for the columns. The titles are obtained from the Field Name column under Available Fields on the Field Selection tab. Clear the check box if you do not require the column headers.

2. Select the Advanced Options check box to define how the titles, total count and average count data are displayed. The formatting parameters for these fields are displayed when you select Advanced Options. Update these parameters as required.

15.4.6 Defining Headers and Footers for the Component

The custom components inherit the header and footer templates from the base component. However, you can replace them with your own custom headers or footers. To define custom headers or footers, click the Header/Footer tab in the Report Component Editor window. Perform steps 2–10 described in the section Inserting Custom Headers and Footers on page 172.

15.4.7 Setting Filter Conditions

The filter conditions for a component include the include and exclude conditions, and the conditions for raising a custom event. To set the filter conditions for a component, perform the following steps:

1. In the Report Component Editor window, click the Filter tab.

2. In the Filter list, select the filter type:
   
   - Include – Select this filter when you want to include those records that meet the condition you specify and exclude the remaining.
   
   - Exclude – Select this filter when you want to exclude those records that meet the condition you specify and include the remaining.
- **Condition** – Select this filter when you want to include those records that meet the condition and at the same time raise an event.

3. NetVault: Backup provides two views to create and view filter expressions – **Simple** and **Advanced**.

![Simple Filter View](image)

**Figure 15-7:**
The Simple Filter View

- **Simple View for Filter Expression** – The **Simple** view lists the filter expressions in a tabular format. This view is recommended for users who do not have advanced knowledge of SQL (Structured Query Language). Note that in this view you can join the multiple expressions using either **and** or **or**. You cannot combine both clauses in joins. To create a filter expression in this view, perform the following steps:

1. To create a filter, click **New**. To create a filter expression, refer to Creating or Modifying Filter Expressions on page 184.

2. To join another expression with **and**, select **Match All Clauses** under **Simple Filter View**. Then, click **New**. To create a filter expression, refer to Creating or Modifying Filter Expressions on page 184.
3. To join another expression with **or**, select **Match Any Clause** under **Simple Filter View**. Then, click **New**. To create a filter expression, refer to **Creating or Modifying Filter Expressions on page 184**.

4. To edit an expression, select it and click **Edit**. This opens the **Edit Filter Expression** window. To modify a filter expression, refer to **Creating or Modifying Filter Expressions**.

5. To remove an expression, select it and click **Delete**.

b. **Advanced View for Filter Expression** – The **Advanced** view displays the filter expressions in a tree format. Use this view only if you have advanced knowledge of SQL. This view allows you to use both **and** and **or** to join expressions. To create a filter expression in this view, perform the following steps:

1. Under **Advanced Filter Tree View**, right-click the root and select **Add an Expression**. To create a filter expression, refer to **Creating or Modifying Filter Expressions on page 184**.

2. To join another expression with **and**, right-click the node where you want to add the expression. Then, select **Insert Expression (AND’d)**.

3. To join another expression with **or**, right-click the node where you want to add the expression. Then, select **Insert Expression (OR’d)**.

4. To edit a particular expression, right-click that node and select **Edit Expression**. This opens the **Edit Filter Expression** window. To modify a filter expression, refer to **Creating or Modifying Filter Expressions on page 184**.

5. To edit the whole filter, right-click the root node and select **Edit Whole Filter**. This opens the **Edit Whole Filter** window. In the **Edit the Filter Here** box at the bottom of the window, re-order, add, delete or change the clauses as required. Include only the field names that are provided in the list above.
Creating or Modifying Filter Expressions

NetVault: Backup supports three types of filter expressions – value comparison, regular expression comparison and field state comparison. The state comparison option is designed for advanced NetVault: Backup users who have a good understanding of the Reporting tool.

To create or modify a filter expression, perform the following steps:

1. Depending on the expression type, choose one of the following methods:
   a. **Value Comparison** – To generate an expression that compares a constant, perform the following steps:
      1. Select the **Check Field Value** option.
      2. Select the field in the list. Refer to the **Available Fields** list on the **Field Selection** tab for the field description.
      3. Select the operator (=, !=, >, <, >= or <=).
      4. Enter the value for comparison in the box next to the operator list. The value you enter must match the field type. For example, enter numeric values for Integer fields, enter YES/NO/TRUE/FALSE for boolean fields, etc. Refer to the field type table under **Information** for information on the supported value type for the fields.
   b. **Regular Expression Comparison** – To generate an expression that compares regular expressions, perform the following steps:
      1. Select the **Check Field Value** option.
      2. Select the field in the list. Refer to the **Available Fields** list on the **Field Selection** tab for the field description.
3. Select **Regexp Search**.
4. Select the operator (=, !=, >, <, >= or <=).
5. Enter the filter expression in the box next to the operator list.

c. **Field State Comparison** – You can use this method to include or exclude records based on the field state. For example, you can choose the state **Unknown** to find/exclude records that are not available in one of the tables. To generate an expression that compares the field state, perform the following steps:
   1. Select the **Check Field State** option.
   2. Select the field in the list. Refer to the **Available Fields** list on the **Field Selection** tab for the field description.
   3. Select the operator (=, !=, >, <, >= or <=).
   4. Select the field state in the list.

2. To provide a value during runtime, select **Prompt for Value**. For example, to view the details for a particular job, you can set a filter condition using the Job ID field and select the **Prompt for Value** check box. When you run the report, NetVault: Backup waits for user input, allowing you to enter the Job ID that is to be used as the filter value. This option will only work if the report is run immediately. The prompt will not appear if the job is scheduled to run later. For scheduled jobs, the filtering will be done on the basis of the value you set for the field in the **Edit Filter Expression** window.

3. In conjunction with the **Prompt for Value** check box, you can also select the **Inherit Value** check box, if you want the other report components included in the job to use the same value entered during runtime for filtering the records.

4. Click **OK** to save the expression.

### 15.4.8 Saving the Component

To select save the component, perform the following steps:

1. To create a new derived component, change the component title in the **Component Title** box at the top right corner of the **Reporting Component Editor** window.

2. Choose one of the following methods to save the component:
   
a. **Add the Component to a Job** – To add the component to a job that you are currently defining, click **Save** and **Add to the Job** on the toolbar. Alternatively, on the **File** menu, click **Save to Job**.

   b. **Save the Component for Future Use** – To save a component for future use, click **Save** on the toolbar. Alternatively, on the **File** menu, click **Save**.
Working with Historic Reports

NetVault: Backup keeps a copy of the data set that was used to generate a report, allowing you to re-analyze the historic data by applying new settings/filters. By default, the data that is excluded as a result of some filter condition is not saved. To keep a copy of the excluded data, the Keep Filtered out Records check box must have been selected for the template. For details on this option, refer to Retaining Excluded Data for Historic Reports on page 174. This allows you to re-apply the filters on the entire data set. To run a historic report again, perform the following steps:

1. Open the Reports window.
2. Click Historic Reports on the toolbar. Alternatively, on the Reports menu, click Historic Reports. This opens the Historic Reports View window.

3. The historic reports are listed under Available Components. By default, the reports are arranged by job date in a descending order.
You can change the view to Title in the Viewing Method list for an alphabetical listing of components. To view run date with the alphabetical listing, select All in the Viewing Method list.

4. To run all the components for a historic report again, right-click the report and choose Select All Job Components or Select Everything from Job.
   To add selective components, right-click the report and select Show Components. The components included in the report are listed under this node. Double-click a component to include it in the report.

5. To include components from multiple reports, repeat step 4 for each historic report. The added components are displayed under Selected Components.

6. In the Selected Components list, you can change the order of the components in which they appear in the report. Select the component in the list, and then click Up or Down.

7. To modify an added component, select it in the Selected Components list and click Edit. This opens the Report Component Editor window. For details on modifying a component, refer to Working with Custom Report Components on page 175.
   This allows you to add, remove and modify the include, exclude and conditional filters.

Important: Any changes you make to the component are applied only to the current instance of the historic report. You cannot save the changes made to the component.

8. To remove a component, select it in the Selected Components and click Remove.

9. To modify header/footer, click the Header/Footer tab. For details on modifying or inserting a header, refer to Inserting Custom Headers and Footers on page 172.

10. If a conditional filter has been set for the report, the Apply Condition Filters check box is selected by default. To disable the conditional filters, you can either delete the condition filters as described in step 7, or clear this check box.

11. To generate and view the report, click View Report on the toolbar.

### 15.6 Editing/Viewing a Report Template

To edit/view a report template, perform the following steps:

1. Choose one of the following methods to load the report definition:
   a. Load the Template from the Report Window – This method can be used for both saved and scheduled jobs.
1. Open the Reports window.

2. Click Report Job on the toolbar. Alternatively, on the Reports menu, click Report Job. This opens the Reporting Job Editor window.

3. Click Load on toolbar, or on the File menu, click Load.

4. In the Select the Report to Load window, select the report and then click OK. The template is loaded in the Reporting Job Editor window.

b. Load the Template from the Jobs Tab of the Reports Window – This method can be used for both saved and scheduled jobs.

   1. Open the Reports window.
   2. On the Jobs tab, right-click the job and select Edit/View Job. The template is loaded in the Reporting Job Editor window.

c. Load the Template from the Status Tab of the Reports Window – This method can only be used for scheduled jobs.

   1. Open the Reports window.
   2. Click the Status tab; right-click the job and select Edit/View Job. The template is loaded in the Reporting Job Editor window.

2. Refer to the following sections to modify the template:
   - Selecting the Report Components
   - Inserting Custom Headers and Footers
   - Defining Job Schedule
   - Setting up Custom Notification Events for the Report Job
   - Finalizing and Submitting the Job

15.7 Viewing Logs for a Report Job

To view the report job logs, perform the following steps:

1. Open the Reports window.

2. On the Status tab, right-click the report and select View Log. This opens the NetVault Logs window. Only the logs messages related to the selected report job are displayed in this window.

15.8 Configuring the Default Browser for Viewing Reports

On a Linux/UNIX platform, configure browser for viewing reports as described in the following steps:


2. Click the GUI tab, and then click the Browser tab.
3. Enter the browser file path in the **UNIX Default Web Browser** box.
4. Click **Apply** to save the settings. Then, click **OK** to close the window.

### 15.9 Deleting a Report Template

To delete a report template, perform the following steps:

1. Open the **Reports** window.
2. On the **Jobs** tab, right-click the report and select **Delete**.
3. In the confirmation window, click **Yes**.
This chapter describes how to use NetVault: Backup to manage multiple sites. The information in this chapter is organized into the following topics:

- Domain Management – An Overview
- Adding a Server
  - Locating a Server
- Controlled Server Status Summary
- Managing a Domain Remotely
- Changing the Default Server
- Viewing Properties of a Controlled Server
- Checking Access to a Remote NetVault: Backup Server
- Removing a Controlled Server

16.1 Domain Management – An Overview

NetVault: Backup is designed to work in an environment in which one machine is configured as a NetVault: Backup Server and various other machines throughout the network act as NetVault: Backup Clients assigned to it. A single Server and its Clients make up a NetVault: Backup Domain. NetVault: Backup allows you to administer a domain either locally from the machine acting as the NetVault: Backup Server, or remotely from another NetVault: Backup server outside the domain. This enables centralized administration of multiple sites from a single location.

A NetVault: Backup Server that is accessed remotely is referred to as a Controlled Server. To control a NetVault: Backup domain remotely, the first step is to grant access to the domain by adding the remote NetVault: Backup Server to a Controlling Server. This is done via the Domain Management window.

To perform a remote operation, just open the corresponding window, and select the Server in the Server Selection list under the menu bar. For example, to add a Member Client to a remote NetVault: Backup Server, open the Client Management window; in the Server Selection list select the NetVault: Backup Server for that domain, and complete the steps for adding a Client. Similarly, to backup a Member Client of a remote NetVault: Backup Server, open the Backup
window; in the **Server Selection** list select the NetVault: Backup Server for that domain, and complete the steps for submitting a backup job.

To use this feature, the Controlled and the Controlling Servers must run the same version of NetVault: Backup software.

### 16.2 Adding a Server

To add a NetVault: Backup Server to a Controlling Server, perform the following steps. Before starting this procedure, ensure that both the Controlling Server and the Controlled Server run the same version of NetVault: Backup Server.

1. On the **Administration** menu, click **Domain Management**.
2. Under **Available NetVault Servers**, you will find a list of NetVault: Backup Servers located in the network. The current status of a Server is represented by the following status indicators:

   ![Figure 16-1: The NetVault: Backup Servers in the network are listed under Available NetVault Servers](image)

   - **Blue** – This icon indicates that the Server is currently up and running.
   - **Red** – This icon indicates that the Server is currently unavailable.

3. To add a Server that is currently available, double-click the Server in the **Available NetVault Servers** list. Alternatively, right-click the Server and select **Add as Server**.

4. This opens the **Password Required** window. In the **Enter Password** box, enter the NetVault: Backup password for the Server.

5. To save the Server password, select **Save Password**. This allows automatic logon to the Controlled Server without waiting for user input. Otherwise, you
must enter the password manually each time you want to perform a remote operation.

6. Click OK to add the Server. The added Server is listed under Controlled Server.

16.2.1 Locating a Server

To locate a Server that is not listed under Available NetVault Servers, perform the following steps:

1. Under Find NetVault Machine at the bottom right, enter the NetVault: Backup name for the Server or its IP address.
2. Click Find.

NetVault: Backup re-scans the network for the Server, and if found adds it under Available NetVault Servers (in alphabetical order).

A search can also fail for a number of reasons, including the following:

- The DNS lookup table or the machine’s host table cannot be contacted.
- NetVault: Backup service is not running on the machine.
- NetVault: Backup is removed from the machine.

16.3 Controlled Server Status Summary

A Server that is added to Controlling Server is listed under Controlled Servers in the Domain Management window. The current status of these machines is represented by one of the following status indicators:

- **Blue** – This icon indicates that the Server is up and running, and can be accessed to perform any operation remotely.
- **Red** – This icon indicates that the Server is currently unavailable. Either the machine is offline or NetVault: Backup service is stopped.

16.4 Managing a Domain Remotely

To manage a domain remotely, perform the following steps:

1. Open the corresponding window. For example, to backup a Client added to a remote NetVault: Backup Server, open the Backup window.
2. In the Server Selection list, select the Server for the remote NetVault: Backup Domain.
3. When you change the Server, the GUI layout will switch to that of the Controlled Server. For example, when you change the Server in the Backup window, the Selections tab will display the Clients added to the selected Server.

4. If you have saved the Server password when adding it, no action is required in this step. If the password was not saved, perform the following steps:
   a. In the Password Required window, enter the valid password for the Server.
   b. Select Save Password to enable auto logon for future operations.
   c. Click OK.

5. Perform the steps to complete the task. Refer to the relevant section of the guide for instructions.

16.5 Changing the Default Server

To make remote management easier, NetVault: Backup allows you to designate a remote NetVault: Backup Server as the Default Server. This eliminates the need to select the Server in the Server Selection list before performing each operation. Until you change the default Server again, all the operations are performed on the selected NetVault: Backup Server. To designate a remote NetVault: Backup Server as the Default Server, right-click the target Server under Controlled Servers and select Make Default. You can reset the default Server or designate another Controlled Server as the default Server by performing the same step.
16.6 Viewing Properties of a Controlled Server

To view the properties of a Controlled Server, perform the following steps:

1. Under **Controlled Servers**, right-click the Server and select **Properties**.
2. The **Server Properties** window contains five tabs - **System**, **Plugins**, **Installed Software**, **Capabilities** and **Usage**. Click the corresponding tab to view the following information:
   - The **System** tab displays the machine name and description, NetVault: Backup version and build number, machine ID, network name for the machine, IP address, release information and operating system version number.
   - The **Plugins** tab lists the NetVault: Backup plugins installed on the Server. The details include the plugin name, version number, plugin ID, and installation date and time.
   - The **Installed Software** tab lists all the NetVault: Backup plugins installed on the Server. The details include the plugin name and the installation date.
   - The **Capabilities** tab provides the license information for the built-in plugins.
   - The **Usage** tab provides the license usage information for the built-in plugins.
3. Click **OK** to close the window.

16.7 Checking Access to a Remote NetVault: Backup Server

To check access between the Controlled and the Controlling Servers, perform the following steps:

1. Under **Controlled Servers**, right-click the machine and select **Check Access**.
2. NetVault: Backup attempts to connect to the Controlled Server and displays the status message corresponding to the machine accessibility.
3. Click **OK** to close the dialog.

16.8 Removing a Controlled Server

To remove a Controlled Server, perform the following steps:

1. Under **Controlled Servers**, right-click the Server and select **Remove**.
2. In the confirmation window, click **Yes**.
   - The Server is removed and listed again under **Available NetVault Servers**.
Chapter 17: USING NETVAULT: BACKUP IN A CLUSTER SETUP

This chapter provides guidelines and information that will help you set up and use NetVault: Backup in a cluster environment. The information in this chapter is organized into the following topics:

- **Support for Cluster Setup in NetVault: Backup**
- **Virtual Clients - An Overview**
- **Installing a Cluster-aware Plugin**
  - Prerequisites
  - Installation Procedure
- **Configuring a Cluster-aware Plugin**
  - Configuring Preferred Network Address
  - Configuring Default Parameters
- **Configuring Devices in a Cluster Setup**
- **Managing Virtual Clients**
  - Modifying a Virtual Client
  - Checking Access to Virtual Clients
  - Finding the Real Client
  - Granting User Access to Virtual Clients
  - Removing a Virtual Client
  - Upgrading a Cluster-aware Plugin
- **Backing up Data with a Cluster-aware Plugin**
  - Cluster Failover During Backups
- **Restoring Data with a Cluster-aware Plugin**
- **Viewing Logs and Job Status**
17.1 Support for Cluster Setup in NetVault: Backup

NetVault: Backup extends support to cluster setup on an application-supported basis via cluster-aware plugins. The cluster nodes are grouped together into a Virtual Client on which the cluster-aware plugin is installed. The cluster backups and restores are performed via the Virtual Client. The cluster-aware plugins are granted Virtual Client licenses instead of the Standard Client licenses.

The NetVault: Backup plugins which can be deployed in a cluster setup include the following:

- **File System Plugin** – This plugin is shipped with the NetVault: Backup software and can be used to backup the shared file system data on the following platforms:
  - Windows Server Clusters
  - Linux Advanced Server Clusters
  - Sun Clusters (Solaris SPARC)
For details on the supported cluster software versions, refer to the Supported Platforms Matrix on BakBone Software’s Web site.

A default installation of NetVault: Backup does not require licensing of its native File System Plugin. However, to use this plugin in a cluster setup, a File System cluster license key is required.

- **NetVault: Backup APM for SQL Server (SQL Server APM)** – This APM can be used in an SQL Server Failover Cluster setup to backup the database. For details, refer to the NetVault: Backup APM for SQL Server User’s Guide.


17.2 Virtual Clients - An Overview

In NetVault: Backup, the cluster nodes are grouped together into a single entity called the Virtual Client. This entity is created when you install a cluster-aware plugin.

A Virtual Client is managed just like any other standard NetVault: Backup Client. You can browse this Client in the same manner as any other Client in NetVault: Backup, add it to Client Groups and Policies, grant or deny user access to it, and generate reports for it. A Virtual Client is represented with a yellow icon (instead of blue).
NetVault: Backup
Administrator’s Guide

197

Though the NetVault: Backup Server administers the creation and configuration of
a Virtual Client, the plugin runs locally on the Member Client and the data is
processed locally. Therefore, a SmartClient configured within a cluster will send
data directly to its attached device.

17.3

Installing a Cluster-aware Plugin
This section explains how to install a cluster-aware plugin.

17.3.1

Prerequisites
Before starting the plugin installation, refer to the following notes and complete the
required tasks:

17.3.2



Install the NetVault: Backup Server software on the designated machine. The
Server must be a separate machine outside the cluster setup. For instructions
on installing the software, refer to the NetVault: Backup Installation/Upgrade
Guide.



Install the NetVault: Backup Client software on the cluster nodes. For
instructions on installing the software, refer to the NetVault: Backup
Installation/Upgrade Guide.



Add NetVault: Backup Clients to the NetVault: Backup Server. For details on
adding a Client, refer to Managing Clients on page 26.



The NetVault: Backup encryption feature is not supported in a cluster setup. If
this feature has been enabled on any cluster node, you must disable it before
proceeding. To disable the functionality, start the NetVault: Backup
Configurator and on the Encryption tab clear the check box Use Secure
Encryption on this Client.



Copy the installation file (.npk) for the cluster-aware plugin to
...\NetVault\packages folder on the NetVault: Backup Server (where ...
represents the NetVault: Backup installation directory). The File System
Plugin (for the Server operating system) is already available in this folder. You
can also copy the installation files to sub-folders within.

Installation Procedure
To install a cluster-aware plugin, perform the following steps:
1. Open the Client Management window (click Client Management on the
toolbar or Large Buttons panel, or on the Administration menu, click Client
Management).
2. On the Cluster menu, click Create Virtual Client. This opens the NetVault
Virtual Client Installation window.


3. Under Cluster Eligible Client List, the available NetVault: Backup Clients are listed in the box to the left. Use Shift+Click to select consecutive Member Clients and Ctrl+Click to select non-consecutive Member Clients, and then click the right arrow. The selected Clients are moved to the box to the right and grouped as a Virtual Client.

Although NetVault: Backup Server is listed as an eligible Client, it must not be included. To remove any Client from the group, select the Client in the box to the right and click the left arrow.

4. In the Package list, select the installation file for the plugin. This list contains all the cluster-aware .npk files copied to the packages directory and its subdirectories. The files are named as follows (where x-x-x-x refers to the build and version numbers):

<table>
<thead>
<tr>
<th>Plugin Name</th>
<th>Binary File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>File System Plugin for Windows</td>
<td>win-x-x-x-x.npk</td>
</tr>
<tr>
<td>File System Plugin for Linux</td>
<td>nvf-x-x-x-x.npk</td>
</tr>
<tr>
<td>File System Plugin for Solaris (SPARC)</td>
<td>nvf-x-x-x-x.npk</td>
</tr>
<tr>
<td>SQL Server APM</td>
<td>sql-x-x-x-x.npk</td>
</tr>
<tr>
<td>Exchange Server APM</td>
<td>exs-x-x-x-x.npk</td>
</tr>
</tbody>
</table>

5. In the Virtual Client Name box, enter a unique name for the Virtual Client. The name cannot be changed. Spaces are not recognized in a Virtual Client name and will be replaced with underscores (“_”).

6. In the Application IP Address box, enter the cluster application’s IP address.

7. Click OK. The NetVault: Backup Server begins installing the plugin on all the Member Clients. This process overwrites any standard version of the same plugin installed on the members. However, you can use the cluster-aware version to make backups of the local/non-shared data.
Once the installation is complete, the Virtual Client is displayed under Clients in the Client Management window, represented by a yellow icon.

17.4 Configuring a Cluster-aware Plugin

This section explains how to configure a cluster-aware plugin.

17.4.1 Configuring Preferred Network Address

To access the cluster nodes via their public IP addresses, perform the following steps:

1. Determine the IP address for the cluster node. (You can use the `ifconfig` method on Linux/UNIX platform, or the `ipconfig` command on Windows.)
2. Start the NetVault: Backup Configurator.
3. Click the Network Manager tab and then click the Connections tab.
4. In the Preferred Network Address box, enter the machine's public IP address.
5. Click Apply to save the setting, followed by OK to close the window.
6. Repeat steps 1-4 for each Member Client.

17.4.2 Configuring Default Parameters

To configure the default attributes for cluster backups and restores, perform the following steps. These values can be changed on a per-job basis from the Backup window. To configure these parameters for backups of local data, refer to the relevant APM/Plugin User’s Guide.

1. Open the Backup window on the NetVault: Backup Server (click Backup on the toolbar or Large Buttons panel, or on the Operations menu, click Backup).

Note: The default attributes for cluster backups and restores can be set only via the Backup Selections tab. Setting these attributes via the NetVault Configurator or Remote Configurator is not supported for the cluster backups and restores.

2. On the Selections tab, locate the Virtual Client. Double-click this node, or right-click and select Open.
3. Right-click the cluster-aware plugin and select Configure to open the Configure window. The configuration settings for the cluster-aware version are the same as the standard version. Refer to the relevant APM/Plugin User’s Guide to configure these settings.
4. Click OK to save the settings. These settings are stored on the NetVault: Backup Server in a configuration file specific to the Virtual Client and applied during cluster backups and restores. These settings only apply to backups and restores of shared data performed via Virtual Client.
17.5 Configuring Devices in a Cluster Setup

In a cluster setup, a backup device can be connected in different ways. This section describes the pros and cons of some of the device configuration methods.

- **Connecting a Device to NetVault: Backup Server or SmartClient** – The pros and cons of this configuration are described below:
  - This type of configuration allows the control of a robotic arm.
  - However, during backups and restores, the data is transferred over the network.

- **Sharing Drives** – A derivative of the previous method can be used by connecting the library to the NetVault: Backup Server, thus, giving it the control of robotic arm, and sharing the drive with the cluster nodes. This allows the control of robotic arm and at the same time enables local data transfers. The pros and cons of this configuration are described below:
  - This configuration offers high drive availability. With all Member Clients sharing the control of drives, the drives are always available.
  - However, the member Client that currently controls the drive need not be the node that currently controls the cluster.

- **Connecting a Device to a Cluster Node** – The pros and cons of this configuration are described below:
  - This configuration offers the fastest method of data transfer as the data is routed directly to a locally attached device.
  - However, the disadvantage is that the robotic arm cannot be controlled by a machine within the cluster, limiting the device type usage for this type of configuration to standalone drives.
  - Moreover, the drive becomes unavailable when the cluster node is down.

17.6 Managing Virtual Clients

This section describes the various Virtual Client administration procedures.

17.6.1 Modifying a Virtual Client

To add or remove Member Clients, or to change the application IP address, perform the following steps. For details on upgrading the cluster-aware version of the plugin, refer to *Upgrading a Cluster-aware Plugin on page 202*.

1. Open the **Client Management** window.
2. Under **Clients**, right-click the Virtual Client and select **Edit Virtual Client Configuration**. This opens the **NetVault Virtual Client Installation** window.
3. To add Member Clients, select the Clients in the box to the left under **Cluster Eligible Client List**. Use Shift+Click to select consecutive Member Clients.
and Ctrl+Click to select non-consecutive Member Clients, and then click the right arrow. The selected Clients are moved to the box to the right and added to the Virtual Client.

Although NetVault: Backup Server is listed as an eligible Client, it must not be included.

To remove any Client from the group, select the Client in the box to the right and click the left arrow.

4. To change the IP address for the application, enter the new IP in the Application IP Address box.

5. Click OK to save the updated settings. NetVault Services must be stopped and re-started if you have changed the Application IP address.

17.6.2 Checking Access to Virtual Clients

At least one of the Member Clients must be on-line and active for a backup/restore job to succeed. In order to check accessibility to a Virtual Client, perform the following steps:

1. Open the Client Management window.
2. Under Clients, right-click the Virtual Client and select Check Access.
3. NetVault: Backup will check access between the Server and each machine within the cluster and return a message with the current status.

17.6.3 Finding the Real Client

To determine which machine within the cluster is currently in control of the cluster application, perform the following steps:

1. Open the Client Management window.
2. Under Clients, right-click the Virtual Client and select Current Real Client.
3. The NetVault: Backup name of the controlling cluster node is displayed in a dialog box.

17.6.4 Granting User Access to Virtual Clients

To grant access to a Virtual Client while denying access to individual Member Clients, perform the following steps:

1. Click the Client Groups tab in the Client Management window and create a Client Group with only the Virtual Client as the member. For details on creating a Client Group, refer to Creating a Client Group on page 32.
2. On the Administration menu, click Access Control.
3. Right-click a User and select User Properties.
4. Click the Group Memberships tab
5. Select the Client Group in the **Not Member Of** box and click the left arrow. Do not select the **User is a Member of All Clients Group** and **Local Access Only** check boxes.

6. Click **Save User Details**.

**Note:** To add and/or remove Virtual Clients, a user must have the **Add/Remove Virtual Client** and **Manage Software** privileges. Additionally, the user requires permissions to perform backups and restores, and to manage devices. For details on granting these permissions, refer to **Assigning Permissions for NetVault: Backup Operations on page 162.**

### 17.6.5 Removing a Virtual Client

If you do not want to use the plugin in a cluster setup, perform the following steps to remove the Virtual Client:

1. Open the **Client Management** window on the NetVault: Backup Server.
2. Under **Clients**, right-click the Virtual Client and select **Remove**. The Virtual Client is removed but the Member Clients are displayed as standard NetVault: Backup Clients under **Clients**.

This removes the ability of the plugin to backup cluster nodes. You can, however, use the plugin for backups of the local data on the NetVault: Backup Client. If the plugin is not required on any Virtual Client member, perform the following steps to remove the plugin. This procedure must be performed on each Client on which the plugin is no longer required.

**Important:** Do not use this procedure to remove the standard version of the File System Plugin.

1. Under **Clients**, right-click the Client and select **Remove Software**.
2. In the **Remove Software** window, select the plugin and click **Remove**.
3. In the confirmation window, click **Yes**. The cluster-aware version of the plugin is removed from the Client. If a standard version was installed/licensed on the Client, it can be used to backup/restore the local data.

### 17.6.6 Upgrading a Cluster-aware Plugin

To upgrade to a newer version of the cluster-aware plugin, perform the following steps:

1. First, remove the Virtual Client that was created during plugin installation. For details on removing a Virtual Client, refer to **Removing a Virtual Client on page 202.**
2. Then, create a new Virtual Client using the upgraded version of the cluster-aware plugin. For details on installing the plugin, refer to **Installation Procedure on page 197.** Assign the same name to the Virtual Client. If a
different name is assigned, the jobs defined for the previous Virtual Client cannot be run again.

17.7 **Backing up Data with a Cluster-aware Plugin**

The procedure for backing up data is similar for both the Standard Clients and the Virtual Clients. The cluster-aware plugins are used in the same manner as the standard version and all the options that can be set for the standard version are also available with the cluster-aware version. The only difference is that when you open the Virtual Client node, just the cluster-aware plugin that was installed during the creation of the Virtual Client is displayed.

The File System Plugin displays both the shared and local drives/mount points on the **Selections** tab and does not differentiate between the two. You must make a note of the drive letter/mount point for the shared resource and make data selections accordingly. For detailed instructions on backing up data, refer to the relevant APM/Plugin User’s Guide.

17.7.1 **Cluster Failover During Backups**

Typically, if a failover occurs when a backup job is running, the job aborts and returns **Job Failed** status. You can use the Job Retry feature to run the job again when the failover is complete. For details on scheduling job retries, refer to **Scheduling Number of Retries** on page 101.

With the File System Plugin, when a failover occurs in Windows, the reason for the failover has a direct bearing upon the status of the aborted job. Accordingly, perform one of the following:

- If the machine in control of the cluster resources goes offline during backup, the job is aborted and returns the status **Job Failed**. You can use the job retry feature to run the backup again.

- If the machine in control of the cluster remains online but the actual cluster resource that is being backed up fails, then the job is aborted and returns the **Backup Completed with Warnings** status. The scheduled job retries do not work for such jobs. In this scenario, examine the job logs to find the missing data or run the job again to backup all data.

17.8 **Restoring Data with a Cluster-aware Plugin**

The procedure for restoring data is similar for both the Standard Clients and the Virtual Clients. The cluster-aware plugins are used in the same manner as the standard version and all the options that can be set for the standard version are also available with the cluster-aware version. The only difference is that the backups are restored from the Virtual Client node and not the actual Client node. When a restore job is initiated, NetVault: Backup communicates with the cluster
Chapter 17
Using NetVault: Backup in a Cluster Setup

17.9 Viewing Logs and Job Status

When you backup a Virtual Client, the data is essentially backed up from a single client and it is accessed from the controlling node. NetVault: Backup displays the Virtual Client name in the Jobs and Status windows for Virtual Client backups and restores. The Logs window, however, displays the actual NetVault: Backup Client name to facilitate quick troubleshooting.
NetVault: Backup
Core Plugins
Chapter 18: USING THE NETVAULT: BACKUP FILE SYSTEM PLUGIN

This chapter describes how to use the NetVault: Backup File System Plugin. The information in this chapter is organized into the following topics:

- The NetVault: Backup File System Plugin – An Overview
- Available Backup Methods
  - Backups Using Volume Shadow Copy Service (VSS)
  - System State Backups on Windows
- Defining a Backup Strategy
- Available Restore Methods
- Configuring Global Parameters for the File System Plugin
- Performing a Full Backup with File System Plugin
  - Selecting Data for a Backup
  - Selecting the Backup Method
  - Configuring the Backup Options
  - Configuring a Job as Restartable
  - Finalizing and Submitting a Job
- Performing an Incremental Backup with the File System Plugin
- Performing a Differential Backup with the File System Plugin
- Performing VSS Backups
  - Installing Evaluation License Keys for VSS Backups
  - Procedure for Performing VSS Backups
- Configuring a Network Share
- Stopping and Restarting a Job
- Restoring Data with the File System Plugin
  - Selecting Data for a Restore
  - Configuring the Restore Options
  - Finalizing and Submitting a Job
- Renaming and/or Relocating Data During Restore
- Restoring Data to an Alternate Server
- Performing System State Restore
Chapter 18

Using the NetVault: Backup File System Plugin

18.1 The NetVault: Backup File System Plugin – An Overview

The NetVault: Backup File System Plugin (File System Plugin) provides a complete solution for the backup and recovery needs of your servers and workstations. From an intuitive GUI, you can set policies to backup an entire system, or selected volumes or files on local or remote clients. Support for full, incremental and differential backup methods gives you the flexibility to choose a preferred strategy, while the Volume Shadow Copy Service (VSS) backup method on Windows guarantees consistent backup of the data. The plugin offers granular control over restores, allowing you to restore a single file that has been deleted accidentally, or recover an entire partition, volume or disk. Support for system state backups on Windows makes it possible to recover an entire system in the event of a disaster.

18.2 Available Backup Methods

The File System Plugin provides full, incremental and differential file-level backup methods. These methods backup individual files and directories.

- **Full Backup**

  This method backs up all the selected files and folders. Full backups take longer to complete and consume more backup media. However, restores are faster since the plugin only requires to restore a single saveset.

  The full backups serve as the base for the future incremental and differential backups.
Incremental Backup

This method backs up new files or files that have changed since the last full or incremental backup. Incremental backups consume minimum storage space and are quicker to perform. However, data recovery takes longer and may require the plugin to access several savesets depending on the number of incremental savesets that must be restored.

Differential Backup

This method backs up new files or files that have changed since the last full backup. Differential backups speed up recovery since the plugin is only required to restore two savesets. However, they consume more storage space and take longer than the incremental backups. The differential backups duplicate the data backed up by previous backups of the same type.

18.2.1 Backups Using Volume Shadow Copy Service (VSS)

The Volume Shadow Copy Service (VSS) provides the backup infrastructure for Windows 2003, Windows Vista and Windows 2008. This component provides a mechanism for creating consistent point-in-time copies of data known as shadow copies. Shadow copies have two primary advantages:

- They allow the creation of consistent backups of a volume, ensuring that the contents cannot change while the backup is being made.
- They avoid problems of file locking. By creating a read-only copy of the volume, backup programs are able to access every file while minimizing interruption to other applications writing to those same files.

On Windows 2003, Vista and 2008, you can use the File System Plugin to perform full, incremental and/or differential backups using VSS.

18.2.2 System State Backups on Windows

On Windows, the File System Plugin allows you to backup the system state data, which is essential to get a functional system back in the event of a system failure. Typically, the system state backup includes Active Directory, boot files, COM+ class database, registry and the system volume (SYSVOL) on a domain controller. On a non-domain controller, it includes boot files, COM+ class database and the registry.

18.3 Defining a Backup Strategy

A well-designed backup strategy helps you recover from the damages caused by failure, and resume normal operations as quickly as possible. Before you start backing up your data, ensure that a good strategy is in place that safeguards your data against various failure modes, such as media failure, data corruption, user error, and complete loss of a data centre.
Some backup sequences are described below to offer you guidelines.

- **Full Backups Only**
  
  A strategy comprising of only full backups can be considered only if (1) the amount for data to be backed up is small (2) backup window is not an issue, and (3) storage media is not a constraint. You can schedule full backups every night, or every \(<n>\) hours depending on the frequency of updates.
  
  In conjunction, you can establish a media rotation policy that enables media re-use. For example, you can set a policy to re-use media after 3 or 4 backup generations.
  
  In the event of a failure, the plugin only requires to restore a single saveset.

- **Full + Incremental Backups**
  
  For quicker backups and/or minimum use of storage media, choose a Full + Incremental backups strategy. For example, schedule full backups every Sunday and incremental backups every day or every \(<n>\) hours depending on the frequency of updates.
  
  In conjunction, you can establish a grandfather, father and son media rotation policy for media re-use.
  
  In the event of a failure, the plugin must restore data from the recent full backup and each incremental in the series. The restore might take longer if several incremental savesets have to be restored. For example, if the failure occurs on Saturday, the restore procedure would include restoration of full backup taken on Sunday and incremental backups taken from Monday through Friday.
  
  The following example describes the general steps involved in an incremental backup strategy for performing weekly full backups and daily incremental backups:
  
  - Create a media group
  - Define a full backup job.
    - Save the data selections into a backup selection set.
    - Set the retention period for backup (e.g., 5 generations to re-use the media every month).
    - Select the target media group in the **Group Label** list on the **Backup Target** tab.
    - Select **Re-use** media property on the **Backup Target** tab; set the attribute for this parameter to **With Same Group Label as the Target Media**.
    - Set a weekly schedule for the job.
  - Define an incremental job. A separate job definition is required if you want to set a media re-use policy that uses the same set of media on each day.
of the week. The number of incremental jobs will depend on your media re-use policy.

- Use the selection set created for the full backup.
- To reuse the media on the same day of each week, set the retention period as 1 week.
- Select the target media group in the Group Label list on the Backup Target tab.
- Select Re-use media property on the Backup Target tab; set the attribute for this parameter to With Same Group Label as the Target Media.
- Define a Day of Week schedule for each job.

**Full + Differential Backups**

For quicker restores and reduced media usage, choose Full + Differential backup strategy. For example, schedule full backups every Sunday and differential backups every day or every <n> hours depending on the frequency of updates.

In conjunction, you can establish a media rotation policy for re-using media for full and differential backups. For example, you can set a 3 or 4 generations retention period for the full backups, and a weekly retention period for differential backups.

In the event of a failure, restore will be a two-step process consisting of restoration of the savesets for the full backup and the recent differential backup.

**Full, Full + Incremental or Differential Backups Using VSS**

If you are using Windows 2003, Vista and 2008, choose Full, Full + Incremental Backups or Full + Differential Backups using VSS for consistent backups. The media rotation policy can be similar to the file-level backup methods.

**System State Backup**

On Windows, your backup strategy must include regular backups of the system state data. You can choose to run a separate job for backing up the system state or back it up together with the data files. The VSS method is recommended for a consistent backup of the system state. Regardless of the method selected, certain system state elements are always backed up in full.

If your strategy includes a single job that backs up the entire C Drive or the Fixed Drives, it is recommended that you include system state backup in the same job. This eliminates duplication of the system files in the saveset. In separate jobs, the system files are included in both savesets.

**Policy Backups**
At enterprise-level, you can define a policy to backup the root directory on Linux/UNIX platforms, or the Fixed Drives + System State on Windows and schedule the job on multiple clients.

18.4 Available Restore Methods

With the File System Plugin, only a single job is required to restore a full + incremental backup or a full + differential backup sequence. The plugin provides the following methods to restore backups:

- **Restore Up to a Particular Backup**
  You can restore data up to the point in time at which a particular saveset was generated. For example, restore till Tuesday’s incremental/differential if a folder containing critical data has been accidentally deleted on Wednesday, or some invalid entries have been recorded on Wednesday leading to data corruption.
  
  You just have to select the required incremental/differential saveset and the plugin automatically restores all the relevant savesets. For example, to restore till Tuesday’s incremental, just select Tuesday’s saveset and the plugin automatically restores Sunday’s full backup, Monday’s Incremental and Tuesday’s incremental in a single job.

- **Restore Up to Last Backup**
  You can restore data up to the last available saveset by selecting any saveset in the regular backup series. The plugin automatically restores all the relevant savesets in a single job. For example, to restore data till yesterday’s daily incremental or today’s incremental performed <n> hours ago, select any saveset generated in the series. The plugin automatically restores the recent full backup and each incremental in the sequence till the last one, in a single job.

18.5 Configuring Global Parameters for the File System Plugin

To configure the global parameters for the File System, perform the following steps:

1. Open the Backup window (click Backup on the toolbar or Large Buttons panel, or on the Operations menu, click Backup).
2. Open the required Client node.
3. Right-click File System in the list of plugins and select Configure. This opens the Configure window. You can also use the methods described in the following sections to open the Configure window
   - Accessing the Configure Window from Client Management Window
4. Configure the following parameters:

- **Cluster Backup Directory** – In a Windows cluster set up, enter the share location to store the cluster database backup file. Use the format `\<machine name>\<share name>`.

![The Configure window for File System Plugin](image)

- **Delete Cluster Backup File From Disk after Backup** – During cluster backup, the File System Plugin copies a backup file of the cluster database to the specified share directory. Leave this check box selected to delete this copy when the backup completes. Clear the check box if you want to retain the copy.

- **File Containing a List of Name-Only Patterns to Exclude from Backups** – To use a name based exclusion for backups, enter the file path in this box.

*Note:* For details on exclusion lists, refer to *Using Inclusion and Exclusion Lists on page 229.*
- **File Containing a List of Name-Only Patterns to Exclude from Restores** – To use a name based exclusion list for restores, enter the file path in this box.
- **File Containing a List of Path Based Patterns to Exclude from Backups** – To use a path based exclusion list for backups, enter the file path in this box.
- **File Containing a List of Path Based Patterns to Exclude from Restores** – To use a path based exclusion list for restores, enter the file path in this box.
- **Restore Windows File Short Names** – Select this check box on Windows Clients to restore the short name attributes for a file. To use this option, you must backup the short name attributes by selecting **Backup Windows File Short Names** attributes configuration parameter.
- **Backup Windows File Short Names** – Select this check box to backup the short name attribute for the selected files.
- **Initial Size of Memory Cache when Analyzing Entries to Restore** – Enter the minimum memory cache available to the File System Plugin for analyzing entities that are to be restored.
- **Initial Size of Memory Cache when Analyzing Directories to Restore** – Enter the minimum memory cache available to the File System Plugin for analyzing directories that are to be restored.
- **Maximum Size of Memory Cache when Analyzing Entries to Restore** – Enter the maximum memory cache available to the File System Plugin for analyzing entities that are to be restored.
- **Maximum Size of Memory Cache when Analyzing Directories to Restore** – Enter the maximum memory cache available to the File System Plugin for analyzing directories that are to be restored.
- **Show Mapped Drives in File System Network Share Node** – On Windows Clients, select this check box to list the mapped drives under the Network Share node.
- **Maximum File System Read** – This parameter can be used to limit the maximum amount of data that can be read at a time. The maximum value is specified in KB. Retain the default value (zero) if you do not want to set any maximum read limit.
- **Maximum File System Write** – This parameter can be used to limit the maximum amount for data that can be written at a time. The maximum value is specified in KB. Retain the default value (zero) if you do not want to set any maximum write limit.
Important: Changing the default values for the Maximum File System Read/Write parameters could result in a performance downgrade. The backup and restore speeds may slow considerably. It is recommended that you change these settings only when network constraints demand.

5. Click OK to save the settings.

18.5.1 Accessing the Configure Window from Client Management Window

To open the Configure window from the Client Management window, perform the following steps:

1. Open the Client Management window on the NetVault: Backup Server (click Client Management on the toolbar or Large Buttons panel, or on the Administration menu, click Client Management).
2. Under Clients locate the NetVault: Backup Server. Right-click it, and then select Configure. This starts the Remote Configurator.
3. On the Remote Configurator, click the Plugin Options tab. Then, click the File System Plugin tab.
4. Complete steps 4–5 described in the section Configuring Global Parameters for the File System Plugin on page 212.

18.5.2 Accessing the Configure Window from NetVault: Backup Configurator

To open the Configure window from the NetVault: Backup Configurator, perform the following steps:

2. Click the Plugin Options tab.
3. Click the File System Plugin tab.
4. Complete steps 4–5 described in the section Configuring Global Parameters for the File System Plugin on page 212.

18.6 Performing a Full Backup with File System Plugin

The procedure for performing full backups with the File System Plugin can be divided into the following steps:

- Selecting Data for a Backup
- Selecting the Backup Method
- Configuring the Backup Options
Selecting Data for a Backup

To select data for a backup, perform the following steps:

1. Open the Backup window (click Backup on the toolbar or Large Buttons panel, or on the Operations menu, click Backup).
2. On the Selections tab, open the NetVault: Backup Server or Client node. To open any node on the Selections tab, you can do either of the following:
   - Double-click the node
   - Right-click the node and select Open
3. Locate File System in the list of plugins and open this node.
4. Depending on the Client operating system, refer to the following points to select the required data:
   a. Linux/UNIX Platform – On Linux/UNIX platforms, perform the following steps:
      1. To backup the entire system, select the root node. To backup particular files and directories, open the root node. This displays the directory tree.
      2. Browse through the directory tree, and locate the files you want to backup.
      3. To include a file, select the check box for it. When a parent node is selected, all files below are automatically selected.
      4. To exclude a file that is selected with the parent node, click the check box again. The check mark will be replaced with a cross.
   b. Windows Platform – On Windows, perform the following steps:
      1. Select the data on the Fixed Drives, Removable Drives and/or Network Shares.
      2. To backup all the fixed drives on the Client, select the Fixed Drives node. To backup individual drives, folders or files, open this node.
      3. To backup data on removable drive, open the Removable Drives node.
      4. To backup shared network folders, open the Network Shares folder. To use this option, you must first configure the network share. For details on configuring network shares, refer to Configuring a Net-
work Share on page 221.

2. Select a drive or open the nodes further to display the directory tree.
3. Browse through the directory tree, and locate the files or folders you want to backup.
4. To include a file/folder, select the check box for it. When a parent node is selected, all files/folders below are automatically selected.
5. To exclude a file/folder that is selected with the parent node, click the check box again. The check mark will be replaced with a cross.
6. To backup system state data, select the **System State** node. It is recommended that you backup the entire system state instead of individual components/services.

5. To implement an incremental or a differential backup strategy, save the selected data into a Backup Selection Set. For details on creating a selection set, refer to **Creating a Selection Set on page 104**.

### 18.6.2 Selecting the Backup Method

Click the **Backup Options** tab, and select **Full** under **Backup Type**.

![Backup Options](image.png)

### 18.6.3 Configuring the Backup Options

On the **Backup Options** tab, configure the following parameters under **Miscellaneous Options**:

- **Log of Files Backed Up** – To generate a backup log file, enter the filename in the **Log of Files Backed up** box. The log contains the list of all files selected for a backup. The files that are backed up successfully are marked with an **o** while the others are marked with an **x**. You can use this option with
an incremental backup to find out which new/changed files have been actually backed up. If you specify an existing filename, the File System Plugin will overwrite the file.

- **Check For Files Being Modified During Backup** – To mark files modified during backup, select the **Check for Files being Modified during Backup** check box. The File System Plugin marks such files as *in flux*. During restore the files in flux state are not restored by default. You can override the default action by selecting the **Restore Files Modified During Backup** option on the **Restore Options** tab.

- **Backup through Mount Points (Windows)/Backup through Remote Mounts (Linux/UNIX)** – On Windows, select the **Backup through Mount Points** check box to backup data on volumes mounted on an NTFS folder. On Linux/UNIX, select the **Backup through Remote Mounts** check box to backup the data on the mounted file systems.

- **Check for and Skip Locked Mandatory Locking Files (Linux/UNIX)** – On Linux/UNIX systems, select the **Check for and Skip Locked Mandatory Locking Files** check box to check whether mandatory locking is enabled or not on the system. If mandatory locking is enabled, the File System Plugin tries to lock the file before backing it up. A file which cannot be locked is not backed up. For example, the File System Plugin will not be able to lock a file which is locked by another application. As a result, this file will not be backed up.

18.6.4 Configuring a Job as Restartable

The File System Plugin provides the ability to stop a running job and resume it any time later from the point the backup was stopped. To use this feature, you must configure the job as restartable. When you stop the job, the plugin generates an index for the files backed up and writes it to the backup media and the NVDB. When you restart the job later, the plugin runs an incremental job to backup the remaining files/folders. The backups can be stopped and resumed from the Jobs window. For details on stopping and resuming backup jobs, refer to **Stopping and Restarting a Job** on page 222.

To configure a job as restartable, select **Restartable Backup** under **Miscellaneous Options**. Only jobs that are defined using a backup selection set can be configured as restartable.

18.6.5 Finalizing and Submitting a Job

Complete the following steps to finalize the job and submit it.

1. Click the **Schedule** tab and configure the scheduling options. For details on defining a job schedule, refer to **Scheduling Jobs** on page 93.
2. Click the Target tab and configure the target device and media options. For details on configuring these options, refer to Configuring Backup Media Options on page 80.

3. Click the Advanced Options tab and configure the advanced backup options, such as backup retention period, custom events, etc. For details on configuring these options, refer to Advanced Backup Options on page 81.

4. Enter a title for the job in the Job Title box at the top right corner of the Backup window.

5. Click Submit on the toolbar, or on the Accept menu, click Submit Backup.

Note: If a target file is open, the backup may complete with warnings. In such cases, the following message will appear in the logs "The process cannot access the file because it is being used by another process". This problem often occurs when the system files are selected on Windows. It can be avoided by choosing the VSS backup method on Windows.

18.7 Performing an Incremental Backup with the File System Plugin

To define an incremental backup job with the File System Plugin, perform the following steps:

1. Open the Backup window (click Backup on the toolbar or Large Buttons panel, or on the Operations menu, click Backup).

2. On the Selections tab, open the NetVault: Backup Server or Client node. To open any node on the Selections tab, you can do either of the following:
   - Double-click the node
   - Right-click the node and select Open

3. Locate File System in the list of plugins and click this node.

4. Load the Backup Selection Set created for the full backup. For details on loading a selection set, refer to Applying a Selection Set on page 105.

5. Click the Backup Options tab.

6. Under Backup Type, select Incremental.

7. Under Incremental Type, select Changed Since Last Backup.

8. On Windows, select Ignore Archive Bit, if you do not want to use the archive bit settings to determine which files will be included in the backup.

9. For configuring the remaining backup options, refer to Configuring the Backup Options on page 217.

10. For configuring the job as restartable, refer to Configuring a Job as Restartable on page 218.
11. Complete the steps described in the section Finalizing and Submitting a Job on page 218.

18.8 Performing a Differential Backup with the File System Plugin

To define a differential backup job with File System Plugin, perform the following steps:

1. Perform steps 1–6 described in the section Performing an Incremental Backup with the File System Plugin on page 219.
2. Under Incremental Type, select Changed Since Last FULL Backup
3. On Windows, select Ignore Archive Bit, if you do not want to use the archive bit settings to determine which files will be included in the backup.
4. For configuring the remaining backup options, refer to Configuring the Backup Options on page 217.
5. For configuring the job as restartable, refer to Configuring a Job as Restartable on page 218.
6. Complete the steps described in the section Finalizing and Submitting a Job on page 218.

18.9 Performing VSS Backups

The VSS backup feature is not available with a default installation of NetVault: Backup. To use this feature, you must install the license key for VSS backups. NetVault: Backup includes a temporary license key which can be used during the 45-day evaluation period. To continue using the VSS feature after the evaluation period expires, you must install the permanent license key.

18.9.1 Installing Evaluation License Keys for VSS Backups

To install the evaluation license keys for VSS backups, perform the following steps:

1. Open the Client Management window.
2. Under Clients, right-click the target Client and select the Install Software.
3. In the browse window, navigate to the ...
etvault\packages\extra directory (where ... refers to the NetVault: Backup installation directory).
4. Select the vss<XXXX>.npk file.
5. Click Open to install the file.

For details on installing the permanent license key, refer to Installing License Keys on page 31.
18.9.2 Procedure for Performing VSS Backups

The procedure for performing VSS backups is similar to the procedure for performing file-level full, incremental or differential backups. Refer to the following sections for instructions on defining a VSS backup job:

- Performing a Full Backup with File System Plugin
- Performing an Incremental Backup with the File System Plugin
- Performing a Differential Backup with the File System Plugin

When selecting the backup method as described in the section Selecting the Backup Method on page 217, you must also select the Create and Backup Shadow Copy check box under Miscellaneous Options for the VSS backup jobs.

Note that you cannot backup data on mount points using the VSS method.

18.10 Configuring a Network Share

You can use the File System Plugin to backup shared network folders residing on non NetVault: Backup Clients. To use this feature you must configure the network share on a NetVault: Backup Client as described in the following steps:

1. Open the Backup window.
2. Open the Client from which you want to backup the shared network drives.
3. Open File System in the list of plugins.
4. Right-click the Network Shares node and select Add Network Share.
5. In the Add New Network Share window, enter the filepath for the shared drive in the format: \\
\<IP Address or Resolvable Network Name\>\<Share Name\>.
6. Click Add. This adds the shared folder to the Network Shares node.
7. Right-click the shared folder and select Connect As.
8. In the Connection Details window configure the login details:
   - Domain – Enter the Windows domain for the system that contains the shared folders.
   - Username – Enter a user name with necessary privileges to perform backups and restores.
   - Password – Enter the password associated with the user specified in the box above.
9. Click OK.

18.11 Stopping and Restarting a Job

A job that is configured as restartable can be stopped while it is running and resumed any time later from the point it was stopped. When you stop the job, the File System Plugin generates an index for the files that have been processed up to the point the backup is stopped and writes the index to the media and the NVDB. When you restart the job later, the File System Plugin runs the job as a new instance and performs an incremental backup of the remaining files and folders.

To stop an active job, perform the following steps:
1. Open the NetVault Jobs window (click Job Management on the toolbar or Large Buttons panel, or on the Operations menu, click Job Management).
2. On the Status tab, right-click the job and select Stop. The File System Plugin will generate the saveset index and stop the job. The status for the job will change to Job Stopped. If the plugin is writing a very large backup index, the jobs status will continue to display Writing to Media: Storing Backup Index until the index is written.
3. To restart the stopped job, right-click it and select Restart Job.
   Select only a single instance on the Status tab at a time. This feature will not work if you select multiple job instances simultaneously.

18.12 Restoring Data with the File System Plugin

The procedure for restoring any backup with the File System Plugin can be divided into the following steps:
- Selecting Data for a Restore
- Configuring the Restore Options
18.12.1 Selecting Data for a Restore

To select the data for restore, perform the following steps:

1. Open the **Restore** window (click **Restore** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Restore**).

2. On the **Selections** tab, open the Client that was the backup target.

   To open any node in the **Selections** tab, you can do either of the following:
   - Double-click the node
   - Right-click the node and select **Open**

3. Open the **File System** node. All the savesets generated using the plugin are listed under this node.

4. Depending on your requirements, choose one of the following methods:
   a. **Restore Up to a Particular Backup** – To restore data using this method, perform the following steps:
      1. In the saveset list, open the target saveset node.
      2. Select the primary/root node or open this node. If required, open the nodes further to display the files/folders you want to restore.
      3. To include a file/folder, select the check box for it. When a parent node is selected, all files/folders below are automatically selected.
      4. To exclude a file/folder that is selected with the parent node, click the check box again. The check mark will be replaced with a cross.
   b. **Restore Up to Last Backup** – To restore data using this method, perform the following steps:
      1. In the saveset list, open any saveset in the series.
      2. Select the primary/root node or open this node. If required, open the nodes further to display the files/folders you want to restore.
      3. To include a file/folder, select the check box for it. When a parent node is selected, all files/folders below are automatically selected.
      4. To exclude a file/folder that is selected with the parent node, click the check box again. The check mark will be replaced with a cross.
      5. After selecting the data, click the **Advanced Options** tab.
      6. Under **Restore Type**, select **Restore from Latest Backup**.

18.12.2 Configuring the Restore Options

Click the **Restore Options** tab and configure the following parameters:
Chapter 18
Using the NetVault: Backup File System Plugin

Figure 18-4: The restore options for File System Plugin

- **Overwrite Newer Files** – To overwrite the files on disk with the version in the saveset, leave the **Overwrite Newer Files** check box selected. Clear the check box if you do not want to overwrite the files that are present on the disk.

- **Reset File Datestamps** – To reset the timestamps for the restored files to what is recorded in the backup, leave the **Reset File Datestamps** check box selected. Clear the check box if you want to restore the files with current timestamp.

- **Reset Directory Datestamps** – By default, the directory time stamps will be set to the time of the restore job. To reset the timestamp to what is recorded in the saveset, select the **Reset Directory Datestamps** check box. You must also select the **Reset File Datestamps** check box to reset the timestamps for the restored directories to what is recorded in the backup.

- **Restore Files Modified During Backup** – Select the **Restore Files Modified during Backup** check box to restore the files that were marked as *in flux* state during backup.

- **Excluded Paths File** – To use an exclusion list, enter the file path in the **Excluded Paths File** box. For details on creating exclusion lists refer to Using Inclusion and Exclusion Lists on page 229.

- **Logs of Files Restored** – To generate a restore log file, enter the filename in the **Log of Files Restored** box. The log file contains the list of all files selected for a restore. The files that are restored successfully are marked with an o while the others are marked with an x. If you specify an existing filename, the File System Plugin will overwrite the file.

### 18.12.3 Finalizing and Submitting a Job

Complete the following steps to finalize and submit the job:

1. Click the **Source** tab and configure the source device options. For details on configuring these options, refer to Configuring Source Device for Restore on page 121. You can omit this step if you want NetVault: Backup to automatically handle the device selection.
2. Click the **Schedule** tab and configure the scheduling options. For details on defining a job schedule, refer to *Scheduling Jobs on page 93*. You can omit this step if you want to run the job immediately.

3. Click the **Advanced Options** tab and configure the advanced options for the job. For details on configuring these options, refer to *Configuring Advanced Restore Options on page 122*. You can omit this step if you do not want to set any advanced options.

4. Enter a title for the job in the **Job Title** box at the top right corner of the Restore window.

5. Click **Submit** on the toolbar, or on the **Accept** menu, click **Submit Restore**.

### 18.13 Renaming and/or Relocating Data During Restore

The File System Plugin allows you to restore a file/folder with a different name during restore. The renaming feature can be used when you do not want to overwrite an existing file and want to create a copy of the file/folder. You can also relocate the file/folder to a different directory during restore. To rename/relocate data during restore, perform the following steps:

1. Select the required data. For details on selecting data for a restore, refer to *Selecting Data for a Restore on page 223*.

2. Right-click the file/folder that you want to rename/relocate and select **Rename**. This opens the **Restore-Rename** window.

3. To rename a file/folder, select the **Rename to** check box. In the box next to the check box, enter the new name for the file/folder.

4. To relocate a file/folder, select the **Relocate to** check box. In the box next to the check box, enter the new path.

5. Click **OK**.

6. For configuring the restore options, refer to *Configuring the Restore Options on page 223*.

7. Complete the steps described in the section *Finalizing and Submitting a Job on page 224*. 
Restoring Data to an Alternate Server

Restoration to an alternate server is typically required when you are migrating data to a new system or copying data to a production/test server. This section describes the procedure for restoring data to an alternate server. Before starting this procedure, ensure that the alternate server is added as a Client to the NetVault: Backup Server.

1. Select the required data. For details on selecting data for a restore, refer to Selecting Data for a Restore on page 223.
2. For details on renaming/relocating data during restore, refer to Renaming and/or Relocating Data During Restore on page 225.
3. For details on configuring the restore options for the job, refer to Configuring the Restore Options on page 223.
4. Click the Target Client tab.
5. Select the alternate server in the Client list.
6. Complete the steps described in the section Finalizing and Submitting a Job on page 218.

Performing System State Restore

This section describes how to restore the system state data using the File System Plugin. It is recommended that you restore the System State only when recovering the entire system as part of a disaster recovery.
18.15.1 Prerequisites

When restoring system state data to an alternate server, the following prerequisites must be met:

- Both the source and the destination servers must run the same version of the operating system; the patches, hotfixes and updates installed on the source server must also be installed on the destination server.
- The number and size of drives on the source and destination servers must match.
- The file system format on the source and destination servers must match.
- Both the source and the destination servers must run the same version of NetVault: Backup.
- If the destination server is a Windows domain controller, start it in the Directory Services Restore Mode (press F8 during boot and select Directory Services Restore Mode in the list of boot methods).

18.15.2 Procedure for Restoring System State

To restore the system state data, perform the following steps:

**Warning:** Before restoring the system state in a particular registry, ensure that there are no Automatic Updates that will be applied on reboot. If necessary, disable Automatic Updates and reboot the machine. After restoring the system state, reboot the machine and then enable Automatic Updates. If the Automatic Updates that are installed during reboot are inconsistent with restored data, it may cause system failure.

1. Open the Restore window.
2. On the Selections tab, open the Client that was the backup target.
3. Open the File System node. All the savesets generated using the plugin are listed under this node.
4. Open the saveset containing the latest System State backup.
5. Select System State.
6. Click the Restore Options tab.
7. Under System State, select the SYSVOL restore type:
   - Select the Primary SYSVOL Restore check box only when you are recreating the domain. Do not select this option if any other domain controller is still active.
   - Select the Authoritative SYSVOL Restore check box, when you want the restored data to take precedence over the existing data.
   - Select the Non-authoritative SYSVOL Restore check box when you want the existing data to take precedence over the restored data.
8. In a Windows 2000/2003 cluster environment, select the **Force Cluster Database Restore** check box to complete the restore operation even under the following conditions:
   - Other cluster nodes are currently active.
   - The partition layout of the current quorum resource is not identical to the partition layout of the quorum resource that was in place when the backup was made. The term “partition layout” refers to the number of partitions on the disk and the offsets to each partition. The disk signature and drive letter assignments do not have to be identical.\)
   If this check box is not selected, then the restore operation will fail if either of the above condition is true.

9. In a Windows 2000/2003 cluster environment, enter the drive in the **Cluster Quorum Drive Letter** box. Use this parameter only if the quorum resource has been replaced since the backup was performed.

10. Enter a title for the job in the **Job Title** box at the top right corner of the **Restore** window.

11. Click **Submit** on the toolbar, or on the **Accept** menu, click **Submit Restore**.

Note the following:
   - The File System Plugin only supports the Non-Authoritative restore of the Active Directory. After restoring the data you can use the Windows `ntdsutil` to set the restored database as authoritative.
   - A domain controller in a non-authoritative state will not function as a domain controller until it has synchronized with active domain controller. The synchronization is implemented using Microsoft File Replication Service and SYSVOL. If the SYSVOL data on a target Client has been restored non-authoritatively, then the File Replication Service must successfully replicate the data to the active controller with Authoritative version of the SYSVOL data before the machine functions as a domain controller.
   - If a restored domain controller owns the Flexible Single Master Operations (FSMO) roles, it will not start performing these roles until it has synchronized with the active domain controller. It may take some time before the restored domain controller starts performing the FSMO roles.

**18.16 Cluster Database Backup and Restore on Windows 2008**

On Windows 2008, the File System Plugin uses VSS for backing up and restoring the cluster database. The Windows Cluster Service must be running to use this feature. The File system Plugin only supports the authoritative restore schema. In an Active-Active cluster, VSS will stop other nodes when you perform a restore.
operation. These nodes must be manually restarted after restore. Note that the Restore Options tab will not include the following options:

- Force Cluster Database Restore
- Use Original Cluster Database Location
- Cluster Quorum Drive Letter

### 18.17 Using Inclusion and Exclusion Lists

Inclusion and Exclusion Lists are basically text files that contain the list of files/folders to be included/excluded during a job. You can use any text editor to create this list. The file must be saved on the target client to which it is applied.

Depending on the operating system running on the target client, the inclusion and exclusion lists must be saved in the following formats:

- **Linux/UNIX** – Multi-byte text format
- **Windows** – Unicode text format

#### 18.17.1 Exclusion List Considerations

Consider the following points when generating an exclusion list:

- An exclusion list must be based on names or paths:
  - **Name based Exclusion List** – Use this exclusion method to omit particular files that match the name pattern. For example, if you add `*.tmp` in an exclusion list, all files with extension .tmp are omitted during backup. You can also add directory paths that are to be excluded. For example, if you add `/usr/tmp/` or `C:\TempFiles\` in the list, these directories and their contents are excluded. Make sure to terminate the path with a `/` on Linux/UNIX and a `\` on Windows.

An example of a name based exclusion list is given below:

```bash
# Name based Exclusion List
#
*.htm
tmp/
mp3_player.exe
*.mp3
install?.exe
test.*
```

This exclusion list will exclude the following directories and files from a job:

- All files with the extension `.htm`
Any directory named **tmp**

A specific file named **mp3_player.exe**

Any file with the extension **.mp3**

Any file named **install?.exe**, where ? is any single character

All files that begin with the characters **test** (e.g., testdata.doc; however, a file named atest1.txt will not be excluded)

Path based Exclusion List – Use this list to omit particular files and directories. Enter the file paths to omit files in the specified path. For example, `usr/backup.tar` or `C:\MyFiles\*.tmp`. To exclude a directory and its contents, enter the path and terminate the path with a `/` on Linux/UNIX and a `\` on Windows (e.g., `usr/tmp/` or `C:\TempFiles\`).

An example of a path based exclusion list is given below:

```
# Exclusion List for All Clients - Path Exclusions
#
C:\Application\Data\Test\
C:\Program Files\Microsoft\nC:\WINNT\system32\nD:\Work in Progress\nD:\Files\*.txt
D:\Database\*
```

This exclusion list will exclude the following directories and files from a job:

- All contents of the directory `C:\Application\Data\Test`
- All contents of the directory `C:\Program Files\Microsoft`
- All contents of the directory `C:\WINNT\system32`
- All contents of the directory `D:\Work in Progress`
- All files with the extension `.txt` in the directory `D:\Files`
- All directories within `D:\` that begin with the characters **Database**

You can use the following special characters and wildcards in an exclusion list:

- `/` – Path terminator on Linux/UNIX
- `\` – Path terminator on Windows
- `?` – Match any one character
- `!n` – New line
- `!r` – Carriage return
- `!t` – Tab
- `!f` – Form feed
!b – Backspace
! – To escape any special character that follows
!! – To specify ! character in the filename or path

- Spaces are not ignored.
- Names are case-sensitive on Linux/UNIX but not on Windows.
- To insert comments use # at the beginning of the each line.
- On Windows, it is recommended that you do not include any System State components, especially Windows File Protection and SYSVOL files on a domain controller.

18.17.2 Adding an Exclusion List

Exclusion lists are added globally for all backup and restore jobs on the Target Client. To configure an exclusion list on a Client, perform the following steps:

1. Open the Backup window (click Backup on the toolbar or Large Buttons panel, or on the Operations menu, click Backup).
2. On the Selections tab, open the target Client node.
3. Right-click the File System node in the list of plugins and select Configure.
4. In the Configure window, set the following parameters:
   - To use a name based exclusion for backups, enter the file path in File Containing a List of Name-Only Patterns to Exclude from Backups box.
   - To use a name based exclusion list for restores, enter the file path in File Containing a List of Name-Only Patterns to Exclude from Restores box.
   - To use a path based exclusion list for backups, enter the file path in File Containing a List of Path Based Patterns to Exclude from Backups box.
   - To use a path based exclusion list for restores, enter the file path in File Containing a List of Path Based Patterns to Exclude from Restores box.
5. Click OK to apply the settings.

Note the following:
- The File System Plugin ignores invalid entries in an exclusion list and generates a log message for such entries.
- The File System Plugin excludes the file/folder named in an exclusion list, even if it is present in an inclusion list or selected explicitly on the Selections tab. The plugin logs warning messages for such entries and the resultant job status is Completed with Warnings. However, if the excluded files/folders
are child nodes of parent nodes that are explicitly included, then the plugin only generates standard log messages.

18.17.3 Removing an Exclusion List

To remove an exclusion list added to a Client, perform the following steps:

1. Open the Backup window (click Backup on the toolbar or Large Buttons panel, or on the Operations menu, click Backup).
2. On the Selections tab, open the target Client node.
3. Right-click the File System node in the list of plugins and select Configure.
4. In the Configure window, clear the following boxes:
   - To remove a name based exclusion list for backups, clear the File Containing a List of Name-Only Patterns to Exclude from Backups box.
   - To remove a name based exclusion list for restores, clear the File Containing a List of Name-Only Patterns to Exclude from Restores box.
   - To remove a path based exclusion list for backups, clear the File Containing a List of Path Based Patterns to Exclude from Backups box.
   - To remove a path based exclusion list for restores, clear the File Containing a List of Path Based Patterns to Exclude from Restores box.
5. Click OK to apply the settings.

18.17.4 Inclusion List Considerations

When generating an inclusion list, consider the following points:

- Enter the file paths for the file or directory that is to be included in a backup.
  The inclusion list does not support wildcards.
- Enter one inclusion per line.

18.17.5 Adding an Inclusion List

Inclusion lists are added on a per-job basis. To configure an inclusion list on a Client, perform the following steps:

1. Open the Backup window (click Backup on the toolbar or Large Buttons panel, or on the Operations menu, click Backup).
2. On the Selections tab, open the target Client node.
3. Open the File System node.
4. Right-click the File System node in the list of plugins and select Show Inclusion Lists.
5. This adds an **Inclusion List** node to the tree. Open this node.

6. Choose one of the following methods to add the inclusion list:
   a. To select the file from the directory tree, perform the following steps:
      1. Open the **Browse for Inclusion List** node.
      2. Open the root node or the **Fixed Drives** node, and then the relevant drive node. Open the nodes further to display the directory that contains the inclusion list.
      3. Select the check box to the left of the inclusion list file.
   b. To specify the file path, perform the following steps:
      1. Right-click the **Specify Inclusion Files** node, and select **Add Inclusion Lists**. This opens the **Enter Path to Inclusion File** window.
      2. In the **Path** box, enter the file path for the inclusion file.
      3. Click **OK**.

### 18.17.6 Removing an Inclusion List

To remove an inclusion list added to a job, perform the following steps:

1. Open the **Backup** window (click **Backup** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Backup**).
2. On the **Selections** tab, open the target Client node.
3. Open the **File System** node.
4. Open the **Inclusion List** node.
5. Right-click the **Specify Inclusion Files** node, and select **Show Inclusion Files**.
6. Clear the check box for the inclusion file.

### 18.18 Additional Notes

**General Notes on File System Plugin**

Consider the following points when using the File System Plugin for backing up or restoring data:

- The maximum length of a backup file path depends on the operating system and the file system the data resides on. Windows, by default, supports a maximum path length of 260 characters (format: D:\<256 chars>NUL). Longer path names up to 32,000 characters are supported with components of maximum length of 255 characters. On Linux/UNIX systems, consider the following limitations:
  - A backup file path can consist of a maximum of 1024 characters, including the target filename and path.
A backup path can consist of a maximum of 255 elements. An element here refers to individual directory named in the path as well as the target filename. Restores of data to platforms or file systems with different namespace support may result in truncation of some path elements. These limitations do not apply to all UNIX file systems, particularly ZFS. NetVault: Backup uses cpio tape format for Linux/UNIX backups, which does not impose these limitations. However, O/S imposed limitations do apply. For details on O/S imposed limitations, refer to the relevant O/S documentation.

When backing up the hard-linked files on Linux/UNIX systems consider the following:

- Various instances of the hard-linked files are considered separate entities. The File System Plugin backs up the complete file and the link information for each selected hard-linked file. To backup all instances of a hard-linked file, include each instance in the selection. For example, if a file /usr/data1/a.txt is hard-linked to the file /usr/data2/b.txt, then selecting /usr/data1/a.txt will backup only this file (with the link information). To backup /usr/data2/b.txt you must include this file in the backup.

- To maintain synchronization between the files, it is recommended that you backup and restore all instances of hard-linked files together.

- When a symbolic link is explicitly selected for a backup, only the link information is backed up and not the file or directory the link points to.

The maximum size of an inclusion list depends on how much memory is available to the backup process while it is running; it depends on the system load at the time of backup. The list can still contain tens of thousands of entries on a small system to hundreds of thousands of entries on a 64-bit system with large memory configuration. The maximum size of an exclusion list is one hundred exclusion expressions.

On systems utilizing the Solaris Zones Partitioning technology, consider the following point:

The Non-global Zones share files with the Global Zone through the use of loopback file system read-only mounts, usually /usr, /lib, /sbin, and /platform. When the Global Zone (i.e., /) is selected for a file system backup, these directories are backed up for the Global Zone and for each Zone configured on the system. For example, if four Zones are configured on the system and root is selected for a file system backup, then five copies of these Global Zone directories are backed up. To avoid multiple backups of these directories during the Global Zone backup, de-selected them individually, or create an exclusion list.

Currently the network share backup support is limited to only Windows network shares. Problems might be encountered if you use this feature to backup CIFS-compatible shares such as Samba, Snap Appliance Filers or Mac OS X Shares. This includes the inability to backup files with certain
filename encoding or lengths, changing the filename while backing them up, or not restoring the permissions correctly.

- The File System plugin contains certain platform-specific backup options. Do not apply a Backup Options Set created for a Windows Client to a Linux/UNIX Client.

- When running incremental backups of network shares using the File System Plugin, the user that has been configured to connect to a particular share must be given Change privileges to the shared folder. Failure to so will cause incremental backup job instances to repeatedly backup modified files, as the File System Plugin will be unable to update the necessary file attribute to indicate that the backup read the file successfully. Potentially, incremental backups will backup all share files repeatedly.

- The following filesystem types are treated as special mount points and are not recursed into. The mount point itself, which is a directory, will be backed up:

  For example, on a Linux system if the proc filesystem is mounted as follows:
  ```
  none on /proc type proc (rw)
  none on /var/chroot/named/proc type proc (rw)
  ```

  When you perform a backup of the entire system, the directories /proc and /var/chroot/named/proc will be included in the backup. However, the pseudo-files under /proc or /var/chroot/named/proc will not be backed up as these mount points are not traversed.

- Linux, HP-UX and IRIX
  - proc
  - swap
  - sysfs

- FreeBSD and Mac OS X
  - procfs
  - kernfs
  - swap
  - devfs
  - fdesc
  - volfs

- NCR
  - proc
  - stats

- OSF
  - procfs
Doors on Solaris and Sockets on Linux/UNIX are not backed up.

On Windows, the files listed under the following registry keys are not backed up:

- HKLM\SYSTEM\CurrentControlSet\Control\BackupRestore\FilesNotToBackup
- HKLM\SYSTEM\CurrentControlSet\Control\hivelist

The savesets generated using the older versions of the File System Plugin (v6.0.2 and earlier) cannot be restored using File System Plugin v6.17 or later. The job will fail if you attempt this and a message will be logged. The version of the File System Plugin that was used to create saveset is required to restore the data.

If a directory included in the selection set is changed to a mount point, then any future Incremental backups performed using the selection set will be performed as Full backups. This will occur even if an intervening full backup is performed using the selection set. To correct this problem, you must re-create/manually edit the selection set.

An attempt to overwrite a file that is marked as read-only may not always be successful. The File System Plugin will attempt to remove the read-only before restoring the file. However, success is not guaranteed because the SetFileAttributes call is not sensitive to the elevated privileges of the plugin.

It is not possible to restore a non-encrypted file over an encrypted file.

### 18.18.1 Backing up Extended Attributes on NSS Volumes

To backup and restore the `novell.metadata` extended attributes on NSS volumes, install the `attr` package and enable `ListXattrNWMetadata` and `CtimeIsMetadataModTime` switches. The following example illustrates how to enable these switches from NSSCON:

1. Start a terminal session.
2. Log in as root.
3. Issue the following commands:
   - `nss /ListXattrNWMetadata`
   - `nss /CtimeIsMetadataModTime`
These settings are temporary and will be lost after a system reboot. To set these switches permanently across reboots, add the following lines to the `/etc/opt/novell/nss/nssstart.cfg` file:

- `/ListXattrNWMetadata`
- `/CtimeIsMetadataModTime`

Ensure the switches are spelled correctly, and do not have any spaces after the forward slash (/). If the switch names are entered incorrectly in the `nssstart.cfg` file, parsing errors can prevent the NSS pool from mounting.

### 18.18.2 Backing up and Restoring Distributed File System (DFS) Paths

If the user account configured to access the root node in the DFS tree does not have access to the shared folders, a symbolic link icon accompanies the shares instead of a folder icon. If the user does not have necessary privileges, the backup will complete with warnings.

The File System Plugin only backs up the DFS files and directories and not the DFS tree. If the tree structure does not exist during restore, the data is restored to the local file system. To backup the DFS tree, run a backup pre-script on the client that contains the DFS root to write the tree structure to a file that is included in the backup. Alternatively, you can backup the DFS structure external to NetVault: Backup. For example, the DFS structure can be written to a `.bat` file using `dfscmd` Windows tool with the `/batch` option:

```
dfscmd /view \rootservername\namespace /batch > <path\filename.bat>
```

In the event that the whole tree has to be restored, re-create the root of the DFS tree or namespace. Execute the batch file created with the pre-script (restore this file individually if required). This re-creates symbolic links to the shares which form the structure of the DFS tree. Files are restored recursively while directories are only restored if they are present. Files are restored authoritatively. If replication is implemented on the DFS tree, authoritative restore in not recommended. In this scenario, de-select the option to overwrite newer files, or select only items that are required.
Chapter 19: Using the NetVault: Backup Consolidate Incremental Backups Plugin

This chapter describes how to use the NetVault: Backup Consolidate Incremental Backups Plugin to create a composite set of full and incremental backups. The information in this chapter is organized into the following topics:

- The NetVault: Backup Consolidate Incremental Backups Plugin – An Overview
- Performing a Backup Consolidation Job
- Restoring Consolidated Savesets
- Defining a Backup Consolidation Job in a Policy

19.1 The NetVault: Backup Consolidate Incremental Backups Plugin – An Overview

The NetVault: Backup Consolidate Incremental Backups Plugin can be used to combine a full backup and multiple incremental backup savesets to create a composite saveset, which can then serve as the base for the future incremental backups. You can use this plugin to generate a weekly full backup saveset without actually performing a full backup. For example, after performing an initial full backup, you can schedule incremental or differential backups from Monday to Friday, and schedule a consolidation job on Saturday. The next week’s incremental/differential backups will use the consolidated saveset as the base.

The Consolidate Incremental Backups Plugin is built-in and available with a default installation of NetVault: Backup. The plugin does not actually backup the data; it just creates a composite set from the existing savesets. The plugin provides the following two methods for backup consolidation:

- **Consolidate up to a Selected Saveset** – You can select a saveset as the point in time up to which you want to consolidate the existing savesets. This method is recommended when you want to run an ad-hoc consolidation job; for example, before implementing changes in your backup schedule, create an archive, or re-use media used for incremental backups.
Consolidate up to the Latest Saveset Using a Selection Set – This method is recommended when you want to run regular consolidation jobs. It allows you to consolidate backups up to the latest saveset generated using a Backup Selection Set. In a backup policy, the data consolidation jobs can only be performed using this method.

A backup consolidation job can only be defined and submitted from the NetVault: Backup Server.

19.2 Performing a Backup Consolidation Job

To consolidate incremental backups using a saveset or a selection set, perform the following steps:

1. Open the Backup window (click Backup on the toolbar or Large Buttons panel, or on the Operations menu, click Backup).
2. On the Selections tab, open the NetVault: Backup Server node. To open any node on the Selections tab, you can do either of the following:
   - Double-click the node
   - Right-click the node and select Open
3. Locate Consolidate Incremental Backups in the list of plugins and open this node.
4. Select one of the following methods:
   a. Consolidate up to a Selected Saveset – To select a saveset, perform the following steps:
      1. Open the Backup Jobs node.
      2. Open the plugin node that was used to generate the saveset.
      3. Select the saveset up to which the backups are to be consolidated.
   b. Consolidate up to the Latest Saveset Using a Selection Set – To choose a selection set, perform the following steps:
      1. Open the Backup Sets node.
      2. Open the plugin node that was used to generate the saveset.
      3. Choose the selection set.
Figure 19-1: The selection sets used to generate full and incremental savesets are displayed under Backup Sets.

5. By default, the data copy job runs on the NetVault: Backup Server. To override this setting and run the job on another Client, click the Backup Options tab. Select the target Client in the Run Duplication On list. You can use this feature to run local jobs on the SmartClients.

6. Click the Schedule tab and configure the scheduling options. For details on defining a job schedule, refer to Scheduling Jobs on page 93. You can omit this step if you want to run the job immediately.

7. Click the Source tab, and configure the following source drive options:
   - To use only locally attached devices, select the Local Drives Only check box under Device Options.
   - To use any device added to the NetVault: Backup Server, select Any Device under Device Options.
   - To use particular device(s), select Specify Device under Device Options. All the devices added to the NetVault: Backup Server are listed in the box below. Since NetVault: Backup is configured to automatically select a backup device, all the devices in the list are selected by default. To exclude devices, perform the following:
     - To exclude a particular library, clear the check box for it. All the drives associated with the device are automatically removed when you remove the library.
     - To exclude a particular drive, clear the check box for it.

8. Click the Target tab and configure the target device and media options. For details on configuring these options, refer to Configuring Backup Media Options on page 80. You can omit this step if you want NetVault: Backup to automatically handle the device and media selection.
9. Click the **Advanced Options** tab and configure the advanced backup options, such as backup retention period, custom events, etc. For details on configuring these options, refer to **Advanced Backup Options on page 81**. You can omit this step if you do not want to set up any advanced options for the job.

10. Enter a title for the job in the **Job Title** box at the top right corner of the **Backup** window.

11. Click **Submit** on the toolbar, or on the **Accept** menu, click **Submit Backup**.

### 19.3 Restoring Consolidated Savesets

NetVault: Backup does not differentiate between the original full backup and a consolidated save set. You can use either of them to restore data. The procedure remains the same and depends on the plugin used to create the original save set. For instructions on restoring the data, refer to the relevant section of this guide or the APM/Plugin User's Guide.

### 19.4 Defining a Backup Consolidation Job in a Policy

The following example shows how to set up a policy to run backup consolidation jobs on three Clients – Client-1, Client-2 and Client-3. The job consolidates full and incremental backups performed using the Filesystem Plugin. A Client Group named Group1 containing the three Member Clients Client-1, Client-2 and Client-3 already exists. The backup selection set used for the original full/incremental backup is named TstBackupSelectionSet. The consolidation job is scheduled to run on Saturday morning at 11 a.m.

1. Open the **Policy Management** window (on the **Administration** menu, click **Policy Management**).

2. Click **New Policy** on the toolbar. Alternatively, on the **File** menu, click **New Policy**. This opens the **NetVault Policy Editor** window.

3. In the **Policy** box, enter a name for the policy.

4. In the **Job Name** box, enter a title for the job.

5. Click **Manage Sets**. This opens the **NetVault Set Management** window.

6. Perform the following steps to create the required selection sets:
   a. Create a Backup Options set as described in the following steps:
      1. Click the **Backup Options** tab.
      2. Use the default setting for the **Run Consolidation on Client** parameter.
      3. Save the Backup Options Set as ConsolidationOptionsSet. For details on saving a selection set, refer to **Creating a Selection Set on page 104**.
b. Click the **Schedule** tab and create a set to run the job every Saturday at 11 a.m. Save this set as ConsolidationScheduleSet.

c. Click the **Target** tab and set the target device and media options. Save this set as ConsolidationTargetSet.

d. Click the **Advanced Options** tab and set the required options. Save this set as ConsolidationAdvOptionsSet.

7. In the **NetVault Policy Editor** window, complete the policy definition as described in the following steps:

   a. In the **Selections** list, select TstBackupSelectionSet.

   b. In the **Selection Options** list, select ConsolidationOptionsSet.

   c. In the **Target** list, select ConsolidationTargetSet.

   d. In the **Schedule** list, select ConsolidationScheduleSet.

   e. In the **Advanced Options** list, ConsolidationAdvOptionsSet.

   **Note:** Currently NetVault: Backup does not support Source Sets in Policy Jobs.

8. Click **Add Clients** on toolbar. Alternatively, on the **Policy** menu, click **Add/Remove Clients**. This opens the **NetVault Policy Clients Manager** window.

9. Under **Available**, select Group1 and click the Left Arrow.

10. In the **NetVault Policy Editor** window, click **Save Policy** on the toolbar. Alternatively, on the **File** menu, click **Save Policy**.)
Chapter 20:

USING THE NetVault: BACKUP DATA COPY PLUGIN

This chapter describes how to use the NetVault: Backup Data Copy Plugin to create copies of the backup savesets. The information in this chapter is organized into the following topics:

- The NetVault: Backup Data Copy Plugin – An Overview
- Making a Copy of the Selected Saveset
- Making a Copy of the Latest Saveset Using a Selection Set
- Restoring Copies of Savesets
- Defining a Data Copy Job in a Policy

20.1 The NetVault: Backup Data Copy Plugin – An Overview

The NetVault: Backup Data Copy Plugin allows you to create multiple copies of existing backup savesets or migrate data from one media to another. Functionally it is similar to the Backup Duplication feature but designed to be used after the original job has run. The Data Copy jobs can be scheduled to run independently or included in a backup policy for copying or migrating backups on a regular basis.

The Data Copy Plugin is built-in and available with a default installation of NetVault: Backup. The plugin does not actually backup the data; it just creates a copy of an existing saveset. The plugin supports the following two methods for copying savesets:

- **Copy Selected Saveset** – This method is recommended when you want to run an ad-hoc copy job and create a copy of the selected saveset.
- **Copy Latest Saveset Using a Selection Set** – This method is recommended when you want to run regular data copy jobs. It allows you to create a copy of the latest saveset generated using a Backup Selection Set. In a backup policy, the data copy jobs can only be performed using this method.

The data copy jobs can only be defined and submitted from the NetVault: Backup Server.
20.2 Making a Copy of the Selected Saveset

To create a copy of the selected saveset, perform the following steps:

1. Open the Backup window (click Backup on the toolbar or Large Buttons panel, or on the Operations menu, click Backup).
2. On the Selections tab, open the NetVault: Backup Server node. To open any node on the Selections tab, you can do either of the following:
   - Double-click the node
   - Right-click the node and select Open
3. Locate Data Copy in the list of plugins and open this node. You will see the following two nodes:
   - Backups
   - Backup Sets
4. Open the Backups node.
5. Open the plugin node that was used to generate the saveset.
6. Select the saveset you want to copy or migrate.
7. Click the Backup Options tab.
8. Under Data Copy select one of the following copy types:
   - Copy a Full Backup to Produce a New Independent Copy of the Data
     - This method is recommended when you want to create a copy for offsite storage. It removes the links between the full and incremental backups, and allows you to set a new retention period for the copy. This copy method can only be used for full backups.
     - By default, NetVault: Backup assigns a new saveset name to an independent copy. This name is derived from the job title. To override this default setting and use the original saveset's name for the copy, select Use Saveset Name from Original Backup.
   - Duplicate a Backup – This method is recommended when you want to migrate the saveset to another media. The savesets copied in this manner share the original saveset’s name and reference. This method can be used to copy both full and incremental backups. The copies of incremental backups will require the original full backup during restore. The restore window displays only one saveset for the original and the copy.
     - In conjunction with this option, you can select the Allow Streams to Share Media check box to convert multiple data streams into a sequential data stream during data copy and write it to the same media. It reduces the number of media items required for data copy. Otherwise, each stream is written to a separate media.
9. On **Backup Options** tab, select **Migrate** to migrate the saveset to another media. The Data Copy plugin deletes the saveset information for the original backup when the data copy job completes.

10. To set the retention period for the copy, configure the following parameters under **Backup Life**:
   - To use the original saveset’s retention period, select **Use Originals Life**.
   - To set a different retention period for the copy, select **Use ‘Backup Life’ on ‘Advanced Options’ tab**. Then, set the retention period in the **Advanced Options** tab. For details on configuring these options, refer to Configuring Retention Policy for a Backup on page 82.

11. By default the data copy job runs on the NetVault: Backup Server. To run the job on another Client, select the Client in the **Run Duplication On** list. You can use this feature to run local jobs on SmartClients.
Chapter 20
Using the NetVault: Backup Data Copy Plugin

12. Click the **Schedule** tab and configure the scheduling options. For details on defining a job schedule, refer to *Scheduling Jobs on page 93*. You can omit this step if you want to run the job immediately.

13. The Data Copy Plugin allows you to select the source device where original backup is stored. You can use this option to enforce local data copy on a SmartClient. To specify a source device for the data copy operation, click the **Source** tab and configure the following options:
   - To use only locally attached devices, select the **Local Drives Only** check box under **Device Options**.
   - To use any device added to the NetVault: Backup Server, select **Any Device** under **Device Options**.
   - To use particular device(s), select **Specify Device** under **Device Options**. In the box below, all the devices added to the NetVault: Backup Server are listed. Since NetVault: Backup is configured to automatically select a backup device, all the devices in the list are selected by default. To exclude devices, perform the following:
     - To exclude a particular library, clear the check box for it. All the drives associated with the device are automatically removed when you remove the library.
     - To exclude a particular drive, clear the check box for it.

14. Click the **Target** tab and configure the target device and media options. For details on configuring these options, refer to *Configuring Backup Media Options on page 80*. You can omit this step if you want NetVault: Backup to automatically handle the device and media selection.

15. Click the **Advanced Options** tab and configure the advanced backup options, such as backup retention period, custom events, etc. For details on configuring these options, refer to *Advanced Backup Options on page 81*. You can omit this step if you do not want to set up any advanced options for the job.

16. Enter a title for the job in the **Job Title** box at the top right corner of the **Backup** window.

17. Click **Submit** on the toolbar, or on the **Accept** menu, click **Submit Backup**.

### 20.3 Making a Copy of the Latest Saveset Using a Selection Set

To create a copy of the selected saveset, perform the following steps:

1. Perform steps 1–3 described in the section *Making a Copy of the Selected Saveset on page 244*.

2. On the **Selections** tab, open the **Backup Sets** node.
3. Open the plugin node that was used to generate the selection set.

4. Choose the selection set.

5. Complete steps 7–8 described in the section *Making a Copy of the Selected Saveset* on page 244.

6. Under **Copy Type**, select one of the following saveset types:
   - **Automatically Get a Set’s Last Full Backup Option** – Select this option to copy the last full backup performed using the chosen selected set. This option can be used if your backup strategy only comprises full backups, or you want to make a copy of only full backups.

   **Note:** This *Automatically Get a Set’s Last Full Backup Option* does not work for the backups performed using NetWare Thin Client Plugin. The Data Copy Plugin will target the last backup, whether full or incremental.

   - **Use a Set’s Most Recent Job Regardless of Type Option** – Select this option to copy the last saveset, regardless of whether it was a full or an incremental backup. This option is recommended when your backup strategy comprises full and incremental backups and you want to make copies on a regular basis.

7. Complete steps 9–17 described in the section *Making a Copy of the Selected Saveset* on page 244.

**Note:** The Data Copy plugin cannot distinguish between the NDMP Level 0 Full Backup and Levels 1–9 Incremental Backups. An NDMP backup of any level appears as Full Backup to the Data Copy plugin. So, if you are trying to make a copy of the latest saveset, and you have selected *Copy a Full Backup to*
Produce a New Independent Copy of the Data and Automatically Get a Set’s Last Full Backup options, the Data Copy plugin will still make a copy of the last backup (of any level), and not the Level 0 backup performed using the chosen selection set.

20.4 Restoring Copies of Savesets

NetVault: Backup does not differentiate between the original saveset and its copies. You can use any of them to restore data. The procedure remains the same and depends on the plugin used to create the original saveset. For instructions on restoring the data, refer to the relevant section of this guide or the APM/Plugin User’s Guide.

20.5 Defining a Data Copy Job in a Policy

The following example shows how to set up a policy to run a data copy job on three Clients – Client-1, Client-2 and Client-3. The job creates copies of full and incremental backups performed using the Filesystem Plugin. A Client Group named Group1 containing the three Member Clients Client-1, Client-2 and Client-3 already exists. The backup selection set used for the original full/incremental backup is named TstBackupSelectionSet. The data copy job is scheduled to run every night at 10 p.m.

1. Open the Policy Management window (on the Administration menu, click Policy Management)
2. Click New Policy on the toolbar or on the File menu, click New Policy. This opens the NetVault Policy Editor window.
3. In the Policy box, enter a name for the policy.
4. In the Job Name box, enter a title for the job.
5. Click Manage Sets. This opens the NetVault Set Management window.
6. Perform the following steps to create the required selection sets:
   a. Create a Backup Options set as described in the following steps:
      1. Open the Backup Options tab.
      2. Select the following options:
         - Duplicate a Backup
         - Allow Streams to Share Media
         - Use a Set’s Most Recent Job Regardless of Type
         - Use Original’s Life
      3. Save the Backup Options Set as DatCopyOptionsSet. For details on saving a selection set, refer to Creating a Selection Set on page 104.
b. Click the **Schedule** tab and create a set to run the job every night at 10 p.m. Save this set as DataCopyScheduleSet.

c. Click the **Target** tab and set the target device and media options. Save this set as DataCopyTargetSet.

d. Click the **Advanced Options** tab and set the required options. Save this set as DataCopyAdvOptionsSet.

7. In the **NetVault Policy Editor** window, complete the policy definition as described in the following steps:

   a. In the **Selections** list, select TstBackupSelectionSet.
   
   b. In the **Selection Options** list, select DatCopyOptionsSet.
   
   c. In the **Target** list, select DataCopyTargetSet.
   
   d. In the **Schedule** list, select DataCopyScheduleSet.
   
   e. In the **Advanced Options** list, DataCopyAdvOptionsSet.

   **Note:** Currently NetVault: Backup does not support Source Sets in Policy Jobs.

8. Click **Add Clients** on toolbar, or on the **Policy** menu, click **Add/Remove Clients**. This opens the **NetVault Policy Clients Manager** window.

9. Under **Available**, select Group1 and click the Left Arrow.

10. In the **NetVault Policy Editor** window, click **Save Policy** on the toolbar. Alternatively, on the **File** menu, click **Save Policy**.
Chapter 21: USING THE NETVAULT DATABASES PLUGIN

This chapter describes how to use the NetVault Databases Plugin. The information in this chapter is organized into the following topics:

- The NetVault Databases Plugin – An Overview
- Configuring the NetVault Databases Plugin
  - Accessing the Configure Window from Client Management Window
  - Accessing the Configure Window from NetVault: Backup Configurator
- Backing up the NetVault Databases
- Restoring the NetVault Databases

21.1 The NetVault Databases Plugin – An Overview

The NetVault Databases Plugin enables backup and recovery of the NetVault Database (NVDB), which is the central repository for the NetVault: Backup system. The database stores the system files, configuration files, data related to your backups, job schedules, media and other NetVault: Backup components. To safeguard your Backup Server, you must perform regular backups of the NVDB. It is recommended that you schedule daily backups of the NVDB (e.g., once all jobs have completed) and use specific media or media group for these backups. These backups are required in the disaster recovery process for the NetVault: Backup Server to restore it back to the state it was at the time of backup. You can also use these backups to migrate the settings when upgrading to a new system or a newer version of the software.

Note: The NVDB backups can be performed only when no other jobs are running in the domain.

The NetVault Database Plugin provides two utilities that can be used to detect and repair errors when performing the NVDB backups:

- **Database Integrity Checker** – This utility checks the structural, entity and referential integrity for the Scheduler and Media databases. It logs a warning or error if any inconsistency/error is detected during the process. The Database Integrity Checker also performs a space check for the db, logs and reports directories. It logs a warning if the free space goes below the defined minimum levels on the drive/partition on which these directories reside. The minimum space requirement is set to the following default values:
21.2 Configuring the NetVault Databases Plugin

To change the minimum space requirement settings for the db, logs and reports directories, perform the following steps:

1. Open the Backup window (click Backup on the toolbar or Large Buttons panel, or on the Operations menu, click Backup).
2. Open the NetVault: Backup Server node.
3. Right-click NetVault Databases in the list of plugins and select Configure. This opens the Configure window. You can also use the methods described in the following sections to open the Configure window:
   a. Accessing the Configure Window from Client Management Window
   b. Accessing the Configure Window from NetVault: Backup Configurator
4. Configure the following parameters:

   - **Minimum Free Space on Database Device (as % of Database Size) before Warning is Output** – Enter the minimum free space that must be available on the drive/partition on which the db directory resides. This must be specified as x% of the NVDB size. By default, this parameter is set to 20% of the NVDB size.
   - **Minimum Free Space on Logs Device (as % of Current Logs) before Warning is Output** – Enter the minimum free space that must be available on the drive/partition on which the logs directory resides. This
must be specified as x% of the total size of the log files. By default, this parameter is set to 10% of the total size of the log files.

- **Minimum Free Space on Reports Device (as % of Current Reports) before Warning is Output** – Enter the minimum free space that must be available on the drive/partition on which the reports directory resides. This must be specified as x% of the total size of the reports database. By default, this parameter is set to 10% of the total size of the reports database.

5. Click **Apply** to apply the new settings, and **OK** to close the window.

### 21.2.1 Accessing the Configure Window from Client Management Window

To open the **Configure** window from the **Client Management** window, perform the following steps:

1. Open the **Client Management** window on the NetVault: Backup Server (click **Client Management** on the toolbar or **Large Buttons** panel, or on the **Administration** menu, click **Client Management**).
2. Under **Clients** locate the NetVault: Backup Server. Right-click it, and then select **Configure**. This starts the Remote Configurator.
3. On the Remote Configurator, click the **Plugin Options** tab. Then, click the **NetVault Database Backup** tab.
4. Perform steps 4–5 described in the section **Configuring the NetVault Databases Plugin** on page 251.

### 21.2.2 Accessing the Configure Window from NetVault: Backup Configurator

To open the **Configure** window from the NetVault: Backup Configurator, perform the following steps:

2. Click the **Plugin Options** tab.
3. Click the **NetVault Database Backup** tab.
4. Perform steps 4–5 described in the section **Configuring the NetVault Databases Plugin** on page 251.

### 21.3 Backing up the NetVault Databases

To backup the NetVault Database, perform the following steps:

1. Open the **Backup** window (click **Backup** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Backup**).
2. On the Selections tab, open the NetVault: Backup Server node. To open any node on the Selections tab, you can do either of the following:
   - Double-click the node
   - Right-click the node and select Open
3. Locate NetVault Databases in the list of plugins and open this node.
4. Select the NetVault Database node.
5. Click the Backup Options tab.
6. Select the Check Database Tables before Backup check box to perform database integrity checks.
7. Select the Compact Database Tables after Backup check box to run the Database Compaction utility. This utility reclaims the unused space resulting from routine database updates/deletes. It also removes the corrupt records identified during the integrity checks.
8. Click the Schedule tab and configure the scheduling options. For details on defining a job schedule, refer to Scheduling Jobs on page 93. You can omit this step if you want to run the job immediately.
9. Click the Target tab and configure the target device and media options. For details on configuring these options, refer to Configuring Backup Media Options on page 80. You can omit this step if you want NetVault: Backup to automatically handle the device and media selection.
10. Click the Advanced Options tab and configure the advanced backup options, such as backup retention period, custom events, etc. For details on configuring these options, refer to Advanced Backup Options on page 81. You can omit this step if you do not want to set any advanced options for the job.
11. Enter a title for the job in the Job Title box at the top right corner of the Backup window.
12. Click Submit on the toolbar, or on the Accept menu, click Submit Backup.

21.4 Restoring the NetVault Databases

This section describes the procedure for restoring the NVDB backup to a new NetVault: Backup Server. You can use this procedure for disaster recovery or when upgrading to a new Server.

1. Install the NetVault: Backup Server software on the target system. The software version on the source and target must match, or it must be a later version for the same platform. The NetVault: Backup name for the source and the target must be the same.
2. Add a backup device to the Server using either the automatic device configuration wizard or the manual procedure. For details on adding a device, refer to Managing Backup Devices on page 34.

3. Load the NVDB backup media. In the new NetVault: Backup domain, the media is reported as foreign. Right-click the drive containing the media and select Scan.

4. Open the Restore window.

5. On the Selections tab, open the Server node.

6. Open NetVault Databases in the list of plugins.

7. Select all components under this node.

8. To restore the historic notifications, open the Notification node. Select the Global Notification node to restore notifications generated by the global notification methods. Select Operator Messages node to restore the operator message logs. Omit this step if you do not want to restore the historic notifications.

9. To restore the historic canned/custom reports, open the Reports node. Select the required report types. Omit this step if you do not want to restore any historic reports.
10. To delete the existing data in reports database before restoring the saveset, leave the **Blank Reports Database Tables before Restore** check box on the **Restore Options** tab selected. Clear the check box if you want to retain the existing data in this database.

11. Enter a title for the job in the **Job Title** box at the top right corner of the **Restore** window.

12. Click **Submit** on the toolbar, or on the **Accept** menu, click **Submit Restore**.

13. Close the GUI. Do not try to monitor the job progress while the job is running.

14. The NetVault: Backup services stop when the restore completes. Re-start the services via the Configurator or the CLI.
This chapter describes how to use the NetVault: Backup Raw Device Plugin to backup physical disks and partitions. The information in this chapter is organized into the following topics:

- The NetVault: Backup Raw Device Plugin – An Overview
- Additional Configuration for Large Number of Disks
- Backing up Raw Devices
- Restoring Raw Devices
- Relocating Data to a Different Disk
- Restoring Data to a Different Client

22.1 The NetVault: Backup Raw Device Plugin – An Overview

The NetVault: Backup Raw Device Plugin enables backup and recovery of physical disks. You can use this disk to backup the Master Boot Record (MBR), system partitions and individual user partitions. It supports up to 256 physical disks on Windows. The Raw Device Plugin is built-in and available with a default installation of NetVault: Backup.

22.2 Additional Configuration for Large Number of Disks

By default, the Selections tab displays up to 64 disks. The plugin, however, can support a maximum of 256 physical disks on Windows. To list more than 64 disks in the Backup window, perform the following steps:

1. Open a new text file.
2. Enter the following stanza in this file:
   
   [Browse]
   
   Maximum Disks=256

3. Save this file as `nvraw.cfg` in the `...NetVault/config` directory (where `...` represents the NetVault: Backup installation directory).
22.3 Backing up Raw Devices

To backup raw devices, perform the following steps:

**Important:** On Linux/UNIX platforms, unmount the file system on the target disk before you start this procedure. On Windows, ensure that the target disk is not in use. On Windows 2008 and Vista you must not open the Disk Management utility or any explorer window.

1. Open the **Backup** window (click **Backup** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Backup**).
2. On the **Selections** tab, open the NetVault: Backup Server or Client node. To open any node on the **Selections** tab, you can do either of the following:
   - Double-click the node
   - Right-click the node and select **Open**
3. Locate **Raw Device** in the list of plugins and open this node. The root directory is displayed.
4. Depending on the Client platform, perform the following steps:
   a. **Linux/UNIX Platform** – On a Linux/UNIX Client, the root directory is displayed under the plugin node. To select the partitions for a backup, perform the following:
      1. Open the root directory node.
      2. Open the `/dev` node in the directory tree.
      3. Select the target disk.
      4. Select the target partition device file.
   b. **Windows Platform** – On a Windows Client, the physical disk(s) are displayed under the plugin node. The Raw Device Plugin supports the following backup methods on Windows:
      - **Backup the Entire Physical Disk(s)** – To backup the entire physical disk, select the disk.
      - **Backup Master Boot Record and System Partition, and/or Individual Partitions** – To backup these components, open the physical disk node. The following nodes are displayed:
         - **Master Boot Record & System Partition**
         - **Individual Partitions on the Disk**
         Select the required component(s).
5. On a Windows Client, click the **Backup Options** tab, and configure the following parameters:
   - **Backup Reported Disk Size** – By default, the Raw Device Plugin obtains the disk size from the operating system and backs up that amount of data.
This option allows you to restore data to any physical disk of the same reported size, even if the actual sizes differ.

- **Backup Entire Contents** — Select this option if the actual and reported disk sizes vary, and you want to backup the entire contents regardless of the reported disk size.

6. Click the **Schedule** tab and configure the scheduling options. For details on defining a job schedule, refer to *Scheduling Jobs* on page 93. You can omit this step if you want to run the job immediately.

7. Click the **Target** tab and configure the target device and media options. For details on configuring these options, refer to *Configuring Backup Media Options* on page 80. You can omit this step if you want NetVault: Backup to automatically handle the device and media selection.

8. Click the **Advanced Options** tab and configure the advanced backup options, such as backup retention period, custom events, etc. For details on configuring these options, refer to *Advanced Backup Options* on page 81. You can omit this step if you do not want to set any advanced options for the job.

9. Enter a title for the job in the **Job Title** box at the top right corner of the **Backup** window.

10. Click **Submit** on the toolbar, or on the **Accept** menu, click **Submit Backup**.

### 22.4 Restoring Raw Devices

Consider the following points before starting this procedure on a Windows Client:

- When restoring an entire disk, unmount the target disk. The target disk must be equal to or larger than the source disk.

- When restoring a partition, the target partition must be equal to the source partition. The restore completes with warnings when data is restored to a partition of a different size (the message **Partition to Restore to a Different Size than the Backed Up Partition** appears in the logs). The type of restore might not work, and requires re-installation or re-formatting.

To restore the raw device backup, perform the following steps:

**Warning:** While the restore is in progress, do not access the target drive. If you do so, the restore will fail and the partition data will be corrupted. Instead use the NetVault: Backup **Jobs** or **Status** windows to view the job status.

1. Open the **Restore** window (click **Restore** on the toolbar or **Large Buttons** panel, or on the **Operations** menu, click **Restore**).

2. On the **Selections** tab, open target Client node. To open any node on the **Selections** tab, you can do either of the following:
   - Double-click the node
Right-click the node and select Open.

3. Locate Raw Device in the list of plugins and open it to display the backup savesets created with the plugin. Each saveset is labeled with its job title followed by the saveset ID and the backup timestamp.

4. Open the required backup saveset. The contents of the saveset are displayed under this node.

5. Select the required disks. On Windows, open the nodes further and select the required partitions and/or MBR.

6. Click the Source tab, and configure the following source drive options:
   - To use only locally attached devices, select the Local Drives Only check box under Device Options.
   - To use any device, select Any Device under Device Options.
   - To use particular device(s), select Specify Device under Device Options.

   In the box below, all the devices added to the NetVault: Backup Server are listed. Since NetVault: Backup is configured to automatically select a backup device, all the devices in the list are selected by default. To exclude devices, perform the following:
   - To exclude a particular library, clear the check box for it. All the drives associated with the device are automatically removed when you remove the library.
   - To exclude a particular drive, clear the check box for it.

7. Click the Schedule tab and configure the scheduling options. For details on defining a job schedule, refer to Scheduling Jobs on page 93. You can omit this step if you want to run the job immediately.

8. Click the Advanced Options tab and configure the advanced restore options, such as network compression, pre and post scripts, etc. For details on configuring these options, refer to Configuring Advanced Restore Options on page 122. You can omit this step if you do not want to set any advanced options for the job.

9. Enter a title for the job in the Job Title box at the top right corner of the Backup window.

10. Click Submit on the toolbar, or on the Accept menu, click Submit Restore.

22.5 Relocating Data to a Different Disk

NetVault: Backup supports restoration of a disk backup to another disk on the same machine, which can be used when the original disk is corrupted, or when you want to create a copy of the disk. This section describes the procedure for relocating a raw device saveset. Consider the following before you start this procedure on Windows:
On Windows, you can restore an MBR to a different disk without re-creating the individual partitions.

You can relocate the backup to a designated disk and partition by using the disk and partition numbers on the target.

An MBR can be relocated to any disk but must be copied to partition zero on that disk.

To restore a disk or partition to another disk, perform the following steps:

1. Perform steps 1–5 described in the section Restoring Raw Devices on page 258.
2. Right-click the component and select Rename.
3. In the Restore Rename window, select the Relocate to check box.
4. In the box next to the Relocate To check box, enter the target disk information as described below:
   - **Linux/UNIX Platform** – Enter the full path to the new disk.
   - **Windows Platform** – Depending on what you are restoring, enter the following:
     - **Entire Disk** – Enter the target disk number. For example, Disk 1 or 1.
     - **Individual Partitions** – Enter the disk number and the partition number. For example, Disk 1 Partition 4 or 1 4.
5. Click OK. The target disk/partition information is displayed in parentheses beside the component name on the Selections tab.
6. Perform steps 6–10 described in the section Restoring Raw Devices on page 258.

### 22.6 Restoring Data to a Different Client

NetVault: Backup allows you to restore a raw devices backup to another Client in the event of a disaster. The procedure for performing a disaster recovery using the Raw Devices Plugin is described in this section. Before starting this procedure, ensure that NetVault: Backup is running on the target Client and the Client is added to the Server.

To restore data to another Client, perform the following steps:

1. Perform steps 1–5 described in the section Relocating Data to a Different Disk on page 259.
2. In the Restore window, click the Target Client tab.
3. Select the Client to which you want to restore the data.
4. Perform steps 6–10 described in the section Restoring Raw Devices on page 258.
Appendix
Appendix A:

**NetVault: Backup Pre-defined Events**

This appendix provides a brief description of the pre-defined event classes and events. The information in this appendix is organized into the following topics:

- **Pre-defined Event Description**

### A.1 Pre-defined Event Description

- **Event Class – Audit**
  - **Failed to Update Audit File** – Raised when NetVault: Backup is not able to update the audit trail.
  - **Update Session Map Failed** – Raised when NetVault: Backup is not able to update the session owner mapping file.

- **Event Class – BakBone Time**
  - **No Time Source** – Raised when the BakBone Time Server is not configured for the domain.
  - **Server Time Inconsistency** – Raised when the BakBone Time on the two Servers controlling the Client do not match.
  - **Server Time Unknown** – Raised when the Time Server is not able to fetch BakBone Time from the Source. By default, a **Sysop Operator Message** method is set for this event. You can also set another notification method if required.
  - **Time Server Changed** – Raised when the Time Server changes for a NetVault: Backup domain.
  - **Time Server Not Responding** – Raised when the Time Server does not respond to a time request.
  - **Time Server Removed** – Raised when the Time Server is removed from the NetVault: Backup domain.

- **Event Class – Device**
  - **Check** – Raised for a request to check a device.
  - **Close Door** – Raised for a request to close a library door.
  - **Close EEPort** – Raised for a request to close an Entry/Exit port.
  - **Close EEPort Clean** – Raised for a request to close an Entry/Exit port containing cleaning media.
Appendix A

NetVault: Backup Pre-defined Events

- **Drive Unavailable** – Raised when any drive controlled by the Server goes offline.
- **Library Gone Offline** – Raised when any library controlled by the Server goes offline.
- **Library Scan Completed** – Raised when a media scan request completes.
- **Map** – Raised when an ACSLS drive is mapped.
- **No Suitable Drive** – Raised when NetVault: Backup is not able to find a suitable drive to run a backup or restore job. By default, a **Sysop Operator Message** method is set for this event. You can also set another notification method if required.
- **Open Door** – Raised for a request to open a library door.
- **Open EEPort** – Raised for a request to close an Entry/Exit port.
- **Reconfigure Device** – Raised when the device properties are modified for an added device.
- **Remove** – Raised when a device is removed.
- **Restart Library** – Raised when a library is restarted.
- **Unmap** – Raised when an ACSLS drive is un-mapped.

- **Event Class – Job**
  - **All Job Retries Failed** – Raised when all retry attempts for a job have failed.
  - **Job Aborted** – Raised when a job is aborted.
  - **Job Completed Successfully** – Raised when a job completes successfully.
  - **Job Completed with Warnings** – Raised when a job completes with warnings.
  - **Job Created** – Raised when a new job is created.
  - **Job Deleted** – Raised when a job is deleted.
  - **Job Died** – Raised when a job dies unexpectedly.
  - **Job Failed** – Raised when a job fails.
  - **Job Finished** – Raised when a job execution completes.
  - **Job Hold** – Raised when a running job is put on hold.
  - **Job Modified** – Raised when a job is modified.
  - **Job Phase Starting** – Raised when any phase of a job starts.
  - **Job Resume** – Raised when a job on hold is resumed again.
Job Run Now – Raised when a job is submitted to run immediately.
Job Scheduled – Raised when a job is submitted.
Job Stopped – Raised when a running job is halted.
Scheduled Phase Deleted – Raised when any scheduled phase for a job is deleted.
Set Created – Raised when a new selection set is created.
Set Deleted – Raised when a selection set is deleted.
Set Modified – Raised when a selection set is modified.

Event Class – Licensing
License Exceeded – Raised when usage exceeds the available licenses. By default, a Sysop Operator Message method is set for this event. You can also set another notification method if required.
License Expired – Raised when the NetVault: Backup evaluation license is nearing expiry. By default, a Sysop Operator Message method is set for this event. You can also set another notification method if required.

Event Class – Log Daemon
Home Drive Becoming Full – Raised when the disk space usage reaches warning or critical threshold. By default, a Sysop Operator Message method is set for this event. You can also set another notification method if required.

Event Class – Machines
Client Added – Raised when a new NetVault: Backup Client is added to the domain.
Client Group Created – Raised when a Client Group is created.
Client Group Deleted – Raised when a Client Group is deleted.
Client Group Modified – Raised when a Client Group is modified.
Client Group Renamed – Raised when a Client Group is renamed.
Client Removed – Raised when a Client is removed from the domain.
Virtual Client Added – Raised when a cluster-aware plugin is installed on the Server.
Virtual Client Removed – Raised when a cluster-aware plugin is removed.

Event Class – Media
Blank – Raised for a request to blank a media.
Delete Group – Raised when a media group is deleted.
Delete Job Instance – Raised when a job instance is deleted.
Export – Raised when a media is exported to an Entry/Exit port.
Appendix A
NetVault: Backup Pre-defined Events

- **Import** – Raised when a NetApp VTL’s shadow tape is imported to an Entry/Exit port.
- **Import Clean** – Raised when a cleaning tape is loaded on a drive.
- **Label** – Raised when a media label is assigned.
- **Load** – Raised when a media is loaded on a drive.
- **Media Blanked** – Raised when a media is blanked.
- **Media Deleted** – Raised when a media is removed from the NVDB.
- **Media Full** – Raised when a media becomes full.
- **Media Labelled** – Raised when a media label request completes.
- **Media Loaded** – Raised when a media load request completes.
- **Media Marked Bad** – Raised when a media is marked bad.
- **Media Request Change Priority** – Raised when the media request priority is changed.
- **Media Request Timeout Expired** – Raised when media request has timed out for a backup job; NetVault: Backup could not find suitable media within the specified timeout interval.
- **Media Suspect** – Raised when a media is marked suspect.
- **Media Unloaded** – Raised when a media is unloaded.
- **Media Unusable** – Raised when a media is rejected by a drive.
- **No Suitable Media** – Raised when NetVault: Backup is not able to find a suitable media to complete the backup job. By default, a **Sysop Operator Message** method is set for this event. You can also set another notification method if required.
- **Request Off Hold** – Raised when a media request is taken off hold.
- **Request On Hold** – Raised when a media request is put on hold.
- **Reuse** – Raised when a media is marked for re-use.
- **Scan Request** – Raised for a request to scan a foreign media.
- **Unload** – Raised when a media is unloaded.
- **Update Properties** – Raised when media properties are modified.

**Event Class – Media Database**

- **Backup Retired** – Raised when a saveset is retired and its information is deleted from the NVDB.
- **Index Compressed** – Raised when a backup index is compressed.
- **Index Decompression Failure** – Raised when index de-compression fails due to insufficient disk space.
- **Index Loaded** – Raised when an offline index is temporarily loaded.
- **Index Offline** – Raised when the backup index for a save set is deleted from the NVDB.
- **Index Read Failure** – Raised when NetVault: Backup cannot read the index for a save set.
- **Index Uncompressed** – Raised when a backup index is de-compressed.
- **Media Database Check Failed** – Raised when database integrity or reference check fails for the media database during NVDB backup.
- **Media Database Check Passed** – Raised when the media database check completes successfully during NVDB backup.
- **Media Database Check Passed with Warnings** – Raised when the media database check generates warnings during NVDB backup.
- **Media Database Compacted** – Raised when the media database compaction completes successfully during NVDB backup.
- **Media Database Compaction Failed** – Raised when the media database compaction fails during NVDB backup.
- **Modify Backup Expiry** – Raised when the retention period is modified for an existing save set.

### Event Class – Policy

- **Policy Branch Errors Acknowledged** – Raised when errors/warnings are acknowledged at a policy level.
- **Policy Created** – Raised when a policy is created.
- **Policy Deleted** – Raised when a policy is deleted.
- **Policy Errors Acknowledged** – Raised when errors/warnings are acknowledged for a particular policy job.
- **Policy Modified** – Raised when a policy is modified.
- **Policy Quiesce** – Raised when a quiesce request is raised for a policy.
- **Policy Quiesced** – Raised when a policy placed in a quiesced state.

### Event Class – Scheduled Database

- **Scheduler Database Check Failed** – Raised when database integrity or reference check fails for the scheduler database during NVDB backup.
- **Scheduler Database Check Passed** – Raised when the scheduler database check completes successfully during NVDB backup.
- **Scheduler Database Check Passed with Warnings** – Raised when the scheduler database check generates warnings during NVDB backup.
- **Scheduler Database Compacted** – Raised when the scheduler database compaction completes successfully during NVDB backup.
- **Scheduler Database Compaction Failed** – Raised when the scheduler database compaction fails during NVDB backup.
Event Class – Stats Collection

- **Cache Too Small** – Raised when cache memory for the Statistics Manager process is running low; this would result in the process running slowly.
- **Cannot Accept Records** – Raised when the Statistics Manager process refuses to accept data from other processes.
- **Lost Server** – Raised when the Statistics Manager discards the I/O data collected for a Server on polling timeout.
- **Stats Manager Ready** – Raised when the Statistics Manager process starts.
Appendix B: NetVault: Backup Pre-defined Reports and Components

This appendix provides a brief description of the pre-defined NetVault: Backup reports and components. The information in this appendix is organized into the following topics:

- **Canned Reports**
- **Pre-defined Report Components**

### B.1 Canned Reports

- **Client Groups** – Use this report to obtain a list of Client Groups within the domain.
- **Client Statuses** – Use this report to find out the current status of the clients within the domain.
- **Expired Offline Media** – Use this report to find out the offline media that can be re-used.
- **Failed ULA Requests** – Use this report to find out the user attempts to perform unauthorized tasks during a given period.
- **Full Online Media** – Use this report to obtain a list of online media that have no free space left.
- **Global Notifications** – Use this report to obtain a list of events for which you have set a global notification method.
- **Historic Jobs - By Date** – Use this report for a date-wise list of jobs performed during a given period. In addition to the job ID and other details, the report displays the time taken for the job to complete, the data transfer size and the job completion status.
- **Historic Jobs - By Size** – Use this report for a size-wise list of jobs performed during a given period. In addition to the job ID and other details, the report displays the time taken for the job to complete, the data transfer size and the job completion status.
- **Library Contents** – Use this report to find out the details of the currently online media. The report displays the current location (the drive/slot in a library), and the used and available space on the media.
Appendix B
NetVault: Backup Pre-defined Reports and Components

- **Media General** – Use this report to obtain information about the used media. The report displays the current location of the media, the space used and left, the saveset expiry date, etc.

- **Media Contents Query** – Use this report to view the summary of media contents. With the other details, the report displays the job title, plugin name, and the expiry dates for the saveset. The report can be filtered on the basis of backup target, the media label, media group, job title or the plugin.

- **Media Quotas and Usage** – Use this report to view the media quota assigned vs. used details for each user.

- **Media Segment Contents Query** – Use this report to view the summary of media segments. The report displays the plugin used to write the segment, the job title and the target Client with the other details.

- **Media Utilization** – Use this report to find out the amount of storage space available on each media. The report also lists the number of blank media items available.

- **NDMP Jobs** – Use this report to view the summary of NDMP filer backups. The report displays the job ID, title, start time, run length, the Client name, transfer size and the job completion status.

- **NetVault Error Logs** – Use this report to view the error messages written to the logs during a given period.

- **NetVault Events** – Use this report for a list of all events occurring in the NetVault: Backup domain during a given period.

- **NetVault Logs** – Use this report to view all the NetVault: Backup logs for a given period.

- **Offline Devices** – Use this report for a list of devices that are currently offline.

- **Outstanding Operator Messages** – Use this report for operator messages that have not been acknowledged.

- **Overnight Job Summary** – Use this report for a summary of the jobs scheduled to run at night. The report displays the total amount of data written, the total number of jobs that completed successfully, completed with warnings, and failed to complete.

- **Policies Summary** – Use this report for a summary of policy jobs performed during a given period. The report displays the number of jobs performed for each policy, the number of Clients targeted by each job, the number for failed job and jobs completed with warnings. The report also displays the details of failed jobs.

- **Restore Summary** – Use this report for a summary of restore jobs. In addition to the job ID and the other details, the report displays the target Client and the job completion status.
Server License - Capabilities and Usage – Use this report to view the available and used licenses for the NetVault: Backup components.

Single Job Summary – Use this report to view the job summary for a single job. The Job ID is used as the filter criterion. The report displays the start and end time, the completion status and the plugin used with the other details. It also includes the drive events, the media transfer details, the job logs and the media details for the job.

Single Policy Summary – Use this report to view the summary for a single policy. The policy name is used as the filter criterion. The report displays the status of the jobs, the target Clients, the job title, the selection sets used to define the job, details of the failed jobs and the transfer size and transfer rate for the policy.

Single User's Audit Trail – Use this report to view the auditor logs for a particular user. The report can be further filtered for a particular period.

User Details – Use this report to view the details of the NetVault: Backup users.

User Notifications – Use this report to view the pre-defined and custom events for which any global or user-specific notification methods have been set.

User Privileges – Use this report to view the user permissions.

User-defined Event Types – Use this report for a list of custom events.

B.2 Pre-defined Report Components

Component Class – Advanced Options
- Advanced Options - CLI Default Template – Include this component to view the advanced options for a backup job.

Component Class – Audits
- Audits - CLI Default Template – Include this component to view the auditor logs.
- Failed ULA Requests – Include this component to view the unsuccessful user attempts.
- Single User's Audit Trail – Include this component to view the auditor logs for a particular user.

Component Class – Backup Targets
- Backup Targets - CLI Default Template – Include this component to view the target device and media settings for a backup job.

Component Class – Client Groups
- Client Groups – Include this component to view the Client Group details.
Appendix B
NetVault: Backup Pre-defined Reports and Components

- **Client Groups - CLI Default Template** – Include this component for Client Group details text format.

  - **Component Class – Clients**
    - **Client Machines - CLI Default Template** – Include this component to view the Client details.
    - **Client Statuses** – Include this component to view the current status of the Clients.

- **Component Class – Defined Jobs**
  - **Defined Jobs** – Include this component to view the details for the defined jobs, including the job ID, title, policy name, job type and the selection sets used to define the job.
  - **Defined Jobs - CLI Default Template** – Include this component to view the details for the defined jobs in text format.

- **Component Class – Drive Events**
  - **Drive Events - CLI Default Template** – Include this component to view the drive events that have taken place for all jobs.
  - **Single Job’s Drive Events** – Include this component to view the drive events that have taken place for a particular job.

- **Component Class – Drive Performance Statistics**
  - **Drive Performance Statistics - CLI Default Template** – Include this component to view the performance logs for the drives within the domain.
  - **Single Job’s Data Transfer Rate** – Include this component to view the data transfer rates for a particular job.

- **Component Class – Drives**
  - **All Drives** – Include this component to view the read and write information for the drives within the domain. The information provided includes the total amount of data read/written, number of read/write errors, and the cleaning details for the drive.
  - **Drives - CLI Default Template** – Include this component to view the read and write information for the drives in text format.
  - **Offline Devices** – Include this component to view the devices that are currently offline.

- **Component Class – Entry/Exit Ports**
  - **Entry/Exit Ports - CLI Default Template** – Include this component to view the list of entry/exit ports, and the label and barcode for the media residing in the entry/exit ports.

- **Component Class – Job History**
  - **Count of Data Stored in Overnight Jobs** – Include this component to view the amount of data stored by the overnight backup jobs.
- **Count of Failed Overnight Backup Jobs** – Include this component to view the total number of overnight backup jobs that failed.
- **Count of Overnight Jobs Finished with Warnings** – Include this component to view the total number of overnight backup jobs that completed with warnings.
- **Count of Successful Overnight Backup Jobs** – Include this component to view the total number of overnight backup jobs that completed successfully.
- **Currently Active Jobs** – Include this component to view the list of policy jobs that are running.
- **Executed Job History** – Include this component to view the summary of jobs performed during a given period. The details include the job ID, title, Client name, plugin and the completion status for the job.
- **Executed Job History - CLI Default Template** – Include this component to view the summary of jobs performed during a given period in text format.
- **Failed Jobs within Single Policy** – Include this component to view the summary of jobs that failed for a policy.
- **Failed Overnight Backup Jobs** – Include this component to view the summary of overnight backup jobs that failed.
- **Failed Policy Jobs** – Include this component to view the summary of failed policy jobs.
- **Historic Jobs - By Date** – Include this component for a date-wise list of jobs performed during a given period. In addition to the job ID and other details, the report displays the time taken for the job to complete, the transfer size and the completion status.
- **Historic Jobs - By Size** – Include this component for a size-wise list of jobs performed during a given period. In addition to the other details, the report displays the time taken for the job to complete, the transfer size and the completion status.
- **Policy Totals** – Include this component to view the backup size and transfer rates for the policy jobs performed during a given period. The component computes the total and average backup size and transfer rates for the backup jobs.
- **Restore Summary** – Include this component to view the summary of restore jobs performed during a given period. The report displays the target Client, the run length and the job completion status.
- **Single Job Main Summary** – Include this component to view the details for a particular job. The report displays the plugin name, start and end time, transfer size, transfer rate and the job completion status.
Component Class – Libraries
- **Blank Media Items in Libraries** – Include this component to view the number of blank media items available in the added libraries.
- **Libraries - CLI Default Template** – Include this component to view the details of the added libraries in text format.

Component Class – Drives
- **Library Drives - CLI Default Template** – Include this component to view the details of the added drives in text format.

Component Class – Slots
- **Library Slots - CLI Default Template** – Include this component to view the details of the slots available in the added libraries.

Component Class – License Capabilities
- **Server License Capabilities and Usage** – Include this component to view the number of available and used license information.
- **Server License Flags** – Include this component to view the features available with the license you have installed.
- **This Server’s License Capabilities and Usage - CLI Default Template** – Include this component to view the number of available and used licenses information in text format.

Component Class – Media
- **Expired Offline Media** – Include this component to find out the offline media that can be re-used.
- **Full Online Media** – Include this component to obtain a list of online media that have no free space left.
- **Libraries’ Media Contents** – Include this component to find out the details of the currently online media. The report displays the current location (the drive/slot in a library), and the used and available space on the media.
- **Media - CLI Default Template** – Include this component to view the summary of currently online media in text format.
- **Media - General** – Include this component to obtain information about the used media. The report displays the current location of the media, the space used and left, the saveset expiry date, etc.
- **Media Utilization** – Include this component to find out the amount of storage space available on each media. The report also lists the number of blank media items available.

Component Class – Media Capacities
- **Media Capacities - CLI Default Template** – Include this component to view the capacity of the currently online media.
Component Class – Media Job Contents
- **Media Contents Query** – Include this component to view the summary of the media contents. The report displays the job title, plugin name, and the expiry date set for the saveset. The report can be filtered on the basis of target client for the backup, the media label, media group, job title or the plugin.
- **Media Contents Query - Textual** – Include this component to view the summary of media contents in text format.
- **Media Used by a Single Backup** – Include this component to view the details of the media used for a particular backup job.

Component Class – Media Requests
- **Media Requests - CLI Default Template** – Include this component to view the pending media requests.

Component Class – Media Segment Contents
- **Media Segment Contents Query** – Include this component to view the summary of media segments. The report displays the plugin used to write the segment, the job title, the target Client and other details.
- **Media Segment Contents Query - CLI Default Template** – Include this component to view the summary of media requests in text format.

Component Class – Media Transfer Requests
- **Media Transfer Requests - CLI Default Template** – Include this component to view the summary of media read and write requests.
- **Single Job’s Media Transfers** – Include this component to view the summary of media read/write requests for a particular job.

Component Class – NetVault Event Types
- **NetVault Event Types - CLI Default Template** – Include this component to obtain a list of the pre-defined event types.
- **User-Defined Event Types** – Include this component to obtain list of the custom events.

Component Class – NetVault Events
- **NetVault Events** – Include this component to view the events raised during a given period.
- **NetVault Events - CLI Default Template** – Include this component to view the raised event list in text format.

Component Class – NetVault Logs
- **NetVault Logs** – Include this component to view the logs generated during a given period.
- **NetVault Logs - CLI Default Template** – Include this component to view the logs for a given period in text format.
Appendix B
NetVault: Backup Pre-defined Reports and Components

- Recent Error Logs – Include this component to view the error logs generated during a given period.
- Single Job's Logs – Include this component to view the logs generated for a particular job.

Component Class – Notifications
- Global Notifications – Include this component to view the list of events that are notified by default.
- User's Selected Notifications - CLI Default Template – Include this component to view list of events for which a notification method is set. The list also includes the events that are notified by default. The output generated by this component is in text format.
- User's Selected Notifications – Include this component to view list of events for which a notification method is set. The list also includes the events that are notified by default.

Component Class – Operator Messages
- Operator Messages - CLI Default Template – Include this component to view operator messages logged for the events.
- Outstanding Operator Messages – Include this component to view the operator messages that have not been acknowledged.

Component Class – Policies
- Policies - CLI Default Template – Include this component to view the summary of backup policies. The report displays the number of jobs included in the policy, the number of Clients on which the policy is implemented, and the overall status of the jobs.
- Policy Basics – Include this component to view the summary of backup policies in text format.
- Policy Status Information – Include this component to view the job summary for a particular policy. The report displays the number of jobs included in the policy, the number of Clients on which the policy is implemented, number of failed jobs, number of jobs completed with warnings, and the overall status of the jobs.

Component Class – Policy Clients
- Policy Clients – Include this component to view the list of Clients on which a particular policy is implemented.
- Policy Clients - CLI Default Template – Include this component to view the Client list for a particular policy in text format.

Component Class – Policy Jobs
- Defined Policy Jobs – Include this component to view the list of jobs defined for a particular policy. The report displays the selection sets used to define each job.
Policy Clients - CLI Default Template – Include this component to view the job list for a particular policy in text format.

Component Class – Privileges
- Granted Privileges - CLI Default Template – Include this component to view the user permissions in text format.
- User Privileges – Include this component to view the user permissions.

Component Class – Report Templates
- Report Templates Installed on System – Include this component to view the list of report templates stored in the report database.

Component Class – Schedule Sets
- Schedule Sets - CLI Default Template – Include this component to view the details of the available schedule sets.

Component Class – Segments
- Segments - CLI Default Template – Include this component to view the media segments summary information.

Component Class – Selection Options Sets
- Selection Options Sets - CLI Default Template – Include this component to view the details of available backup options sets.

Component Class – Selection Sets
- Selection Sets - CLI Default Template – Include this component to view the details of the available backup selection sets.

Component Class – Users
- Quotas and Media Usage – Include this component to view the available and used media quota for users.
- User Details – Include this component to view the general details of the users.
- Users - CLI Default Template – Include this component to view the user details in text format.
Appendix C:

**NetVault: Backup User Permissions**

This appendix provides a brief description of the user permissions required to perform NetVault: Backup operations. The information in this appendix is organized into the following topics:

- User Permission Definitions

### C.1 User Permission Definitions

- **Clients – Add/Remove Clients** – Permission to add or remove NetVault: Backup Clients to/from the NetVault: Backup Server.
- **Clients – Add/Remove Virtual Clients** – Permission to add or remove Virtual Clients.
- **Clients – Administer Client Groups** – Permission to create, modify and delete Client Groups.
- **Clients – Configure Client** – Permission to access the Remote Configurator.
- **Clients – Get Client Properties** – Permission to view Client properties.
- **Clients – Set Firewall Relationship** – Permission to establish the inside/outside firewall relationship between the NetVault: Backup Server and Client.
- **Devices – Add Libraries** – Permission to add libraries to the NetVault: Backup Server.
- **Devices – Add Simple Drive** – Permission to add a standalone drive to the NetVault: Backup Server.
- **Devices – Clean Drives** – Permission to run the Clean command for an added drive.
- **Devices – Manage Devices** – Permission to configure device properties and perform device management tasks.
- **Devices – Open and Close Entry/Exit Ports** – Permission to issue open/close entry/exit port commands.
- **Devices – Open and Close Library Doors** – Permission to issue open/close library door commands.
- **Devices – Perform Device Checks** – Permission to run self-test on an off-line device.
- **Devices – Reconfigure Devices** – Permission to re-configure an added device.
- **Devices** – **Remove Devices** – Permission to remove devices from the NetVault: Backup Server.
- **Devices** – **Set Drive Cleaning Properties** – Permission to establish a cleaning routine for the drives.
- **Jobs** – **Abort Jobs** – Permission to abort the running jobs.
- **Jobs** – **Acknowledge Policy Errors** – Permission to acknowledge errors for a policy and remove the error flags.
- **Jobs** – **Administer Backup/Restore Set** – Permission to create, modify, copy and delete backup/restore selection sets.
- **Jobs** – **Administer Policies** – Permission to define and manage backup policies.
- **Jobs** – **Delete Job** – Permission to delete a job.
- **Jobs** – **Delete Scheduled Phase** – Permission to delete a job schedule.
- **Jobs** – **Hold Job** – Permission to put a job on hold.
- **Jobs** – **Jobs Owned by this User may Run** – Permission to submit jobs.
- **Jobs** – **Quiesce Policy** – Permission to quiesce an active policy.
- **Jobs** – **Restart Job** – Permission to resume a stopped File System Plugin job.
- **Jobs** – **Resume Job** – Permission to resume a job that is put on hold.
- **Jobs** – **Run Predefined Job Instantly** – Permission to issue the *Run Now* command for a job.
- **Jobs** – **Stop Job** – Permission to issue the *Stop* command for a restartable File System Plugin job.
- **Jobs** – **Submit/Update Backup Jobs** – Permission to submit/modify backup jobs.
- **Jobs** – **Submit/Update Restore Jobs** – Permission to submit/modify restore jobs.
- **Jobs** – **View Backup Jobs** – Permission to view the job definition for a backup job.
- **Jobs** – **View Policies** – Permission to view the policy definition.
- **Jobs** – **View Restore Jobs** – Permission to view the job definition for a restore job.
- **Media** – **Blank ANSI Media** – Permission to blank a media.
- **Media** – **Blank Bad Media** – Permission to blank a media that is marked as Bad.
- **Media** – **Blank Media** – Permission to blank a media.
- **Media** – **Blank Non-NetVault Media** – Permission to blank a media not used by NetVault: Backup.
Media – Export Media – Permission to export a media to entry/exit port.

Media – Get Media or Device Status Item – Permission to view the status of libraries and drives.

Media – Import Media – Permission to import NetApp VTL’s shadow tapes.

Media – Load/Unload Media from Drives – Permission to load or unload media.

Media – Manage Media Requests – Permission to set the priority for media requests and/or put a media request on hold.

Media – Mark Media for Reuse – Permission to manually mark a media as re-usable.

Media – Modify Backup Expiry Data – Permission to modify the retention period for savesets.

Media – Remove Media – Permission to remove media information from the NVDB.

Media – Scan a Foreign Media – Permission to scan a media that is marked as Foreign.

Media – View and Diagnose Media Requests – Permission to view and diagnose media requests.

Media – View Backup Expiry Data – Permission to view the retention period for a saveset.

Media – View Media Properties – Permission to view the media properties.

Media – Write Media Labels – Permission to perform individual and bulk media labeling operations.

Reports – Modify/Edit Report Jobs and Components – Permission to create/modify custom reports and report components.

Reports – View and Run Reports – Permission to generate and view reports.

System – Change Global Notification Profile – Permission to set up notification methods for pre-defined events.

System – Dump Log Entries – Permission to dump logs in binary or text format.

System – Install/Remove Software Packages – Permission to install and remove the NetVault: Backup plugins.

System – Install License Key – Permission to install license keys for the NetVault: Backup products.

System – Manage Operator Message – Permission to acknowledge and/or delete operator messages that are logged when an event is raised.

System – Permitted to Use CLI Tools – Permission to use the NetVault: Backup CLI Utility.
Appendix C

NetVault: Backup User Permissions

- **System – Purge Log Entries** – Permission to delete logs from the NVDB.
- **System – Administer User Accounts** – Permission to create, modify and delete user accounts.
- **System – Reset Password for User** – Permission to set, change or reset password for a user.
Appendix D: **NetVault: Backup Environment Variables**

This appendix provides a brief description of the NetVault: Backup environment variables that can be used in scripts. The information in this appendix is organized into the following topics:

- Using Environment Variables

## D.1 Using Environment Variables

NetVault: Backup provides the following environment variables that can be used in scripts.

- **NETVAULTCLIACCOUNT** – Use this variable to specify a user account name. The named account must have privileges to use the CLI tools.
  
  ```
  NETVAULTCLIACCOUNT=<Account Name>
  ```

- **NETVAULTCLIPASSWORD** – Use this variable to specify the password for the CLI user account.
  
  ```
  NETVAULTCLIPASSWORD=<Password>
  ```

- **NV_HOME** – Use this variable to refer to the NetVault: Backup installation directory.
  
  ```
  NV_HOME
  ```

- **NV_JOBCLIENT** – Use this variable to refer to the target client for the job.
  
  ```
  NV_JOBCLIENT=<NetVault: Backup Name for the Client>
  ```

- **NV_JOBID** – Use this variable to refer to a particular job using its Job ID.
  
  ```
  NV_JOBID=<Job ID>
  ```

- **NV_JOBTITLE** – Use this variable to refer to a particular job using its title.
  
  ```
  NV_JOBTITLE=<Job title>
  ```

- **NV_SERVERNAME** – Use this variable to refer to a NetVault: Backup Server.
  
  ```
  NV_SERVERNAME=<NetVault: Backup Name of the Server>
  ```

- **NV_SESSIONID** – Use this variable to refer to a particular job using its session ID.
  
  ```
  NV_SESSIONID=<Session ID>
  ```

- **NV_STATUS** – This variable provides the exit status of the previous phase of a job. It returns either SUCCEEDED or FAILED. For example, when a backup job completes successfully, **NV_STATUS** returns SUCCEEDED. You
can use this variable in the script to perform any conditional action based on the job exit status.

This variable can only be used in a post script. The return value for this script is not localized. It is **SUCCEEDED** or **FAILED** in English.

**NV_USER_ARG** – Use this variable to refer to the variables passed with the pre and/or post scripts.
Appendix E: NetVault: Backup Processes

This appendix provides a brief description of the NetVault: Backup processes. The information in this appendix is organized into the following topics:

- NetVault: Backup Processes – An Overview
- Process Description

E.1 NetVault: Backup Processes – An Overview

NetVault: Backup comprises several static and dynamic processes that run on the Server and Clients. The static processes remain active while the NetVault: Backup services are running and have a single digit fixed process ID. These processes generally require the same amount of system resources throughout. The dynamic processes are initiated and destroyed during process execution, and are assigned a changing ID. These processes require a varying amount of system resources.

On Linux/UNIX platforms, you can view these processes using the following command:

`ps -ef | grep nv`

On Windows, these can be viewed from the Task Manager.

E.2 Process Description

The section briefly describes the functions of various NetVault: Backup processes.

- `nvpmgr (NetVault: Backup Process Manager)` – This process manages all other NetVault: Backup processes. It creates and destructs processes as required. The process manager runs on all NetVault: Backup machines. This process is assigned a static process ID. However, it is seen as a Dynamic process due to its need for varying levels of system resources.
  
  **Process Type** – Dynamic; **Process ID** – 1

- `nvcmgr (NetVault: Backup Inter Process Communication Manager)` –
  This process can be seen only on Linux, UNIX and Mac OS X systems. It is responsible for relaying messages, requests and responses. On Windows this function is performed by the nvpmgr.
  
  **Process Type** – Static; **Process ID** – 2
- **nvnmgr (NetVault: Backup Network Manager)** – This process creates network connections between the backup/restore target and the Client to which the device is connected. It also sends and receives network broadcasts to check the availability of Clients. It runs on all NetVault: Backup machines.
  
  **Process Type** – Static; **Process ID** – 3

- **nvmedmgr (NetVault: Backup Media Manager)** – This process handles the media requests submitted by the job manager process. It also manages the media database.
  
  **Process Type** – Static; **Process ID** – 4

- **nvsched (NetVault: Backup Schedule Manager)** – This process manages the job schedules and sends a message to the Job Manager process to launch an instance. It also schedules the next instance for a recurring job. It runs on the NetVault: Backup Server.
  
  **Process Type** – Static; **Process ID** – 5

- **nvllogdaemon (NetVault: Backup Log Daemon Process)** – This process writes the messages to the log files. The logs are then relayed to the `nvgui` and `nvrepdbmgr` processes. It runs on the NetVault: Backup Server.
  
  **Process Type** – Static; **Process ID** – 7

- **nvavp (NetVault: Backup Audit Verification Manager)** – This process is responsible for allowing or denying user requests based on the user permissions. It runs on the NetVault: Backup Server.
  
  **Process Type** – Static; **Process ID** – 8

- **nvsstatsmngr (NetVault: Backup Statistics Manager)** – This process collects the drive performance statistics.
  
  **Process Type** – Static; **Process ID** – 9

- **nvrepdbmgr (NetVault: Backup Report Manager)** – This process handles the report requests. It runs on the NetVault: Backup Server.
  
  **Process Type** – Static; **Process ID** – 10

- **nvdevmgr (NetVault: Backup Device Manager)** – This process performs the media reads and writes and handles loading and unloading of media. It runs only on the SmartClients (and the Server if a device is attached to the Server). For each configured drive, an instance of the process is created. In a SAN environment, an instance runs on each Client that shares the device.
  
  **Process Type** – Dynamic; **Process ID** – Varies

- **nvndmpdevmgr (NetVault: Backup NDMP Device Manager)** – This process performs the media reads and writes and handles loading and unloading of media for NDMP devices. It runs only on NDMP device attached NetVault: Backup machines. An instance of the process is created for each configured drive.
  
  **Process Type** – Dynamic; **Process ID** – Varies
- **nvchgmgr (NetVault: Backup Library Manager)** – This process controls the robotic arm changer. It runs on the machines to which the robotic arm changer is connected. One instance is created for each arm changer.
  
  **Process Type** – Dynamic; **Process ID** – Varies

- **nvndmpchgmgr (NetVault: Backup NDMP Library Manager)** – This process controls the robotic arm changer for NDMP enabled devices. It runs on the machines to which the robotic arm changer for NDMP device is connected. One instance is created for each arm changer.
  
  **Process Type** – Dynamic; **Process ID** – Varies

- **nvjobmgr (NetVault: Backup Job Manager)** – This process is responsible for job execution. It is initiated by the schedule manager. The job manager process continues to run until the completion of a job and reports the completion status. It is also responsible for sending drive and media requests to the media manager process. The job manager process runs on the NetVault: Backup Server.
  
  **Process Type** – Dynamic; **Process ID** – Varies

- **nvgui (NetVault: Backup GUI Process)** – This process manages the GUI for NetVault: Backup and runs on any NetVault: Backup machine on which you start the GUI.
  
  **Process Type** – Dynamic; **Process ID** – None

- **nvguiproxy (NetVault: Backup GUI Proxy Process)** – This process allows a Server to be controlled remotely. It runs on the Controller Server.
  
  **Process Type** – Dynamic; **Process ID** – None

- **nvduplicate (NetVault: Backup Duplicate Process)** – This process makes duplicates of backup savesets and runs only when you select the Duplicate option for a backup job. It runs on the selected NetVault: Backup machine.
  
  **Process Type** – Dynamic; **Process ID** – None

- **nvverify (NetVault: Backup Verification Process)** – This process verifies the stream length written to the media and runs only when you select the Verification option for a backup job. It runs on the selected NetVault: Backup machine.
  
  **Process Type** – Dynamic; **Process ID** – None

- **nvplgscript (NetVault: Backup Plugin Script Process)** – This process executes the pre and post scripts for a job and runs only when this option is selected for a job. It runs on the target client.
  
  **Process Type** – Dynamic; **Process ID** – None